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How do we start AutoCAD?
What is the screen Composition of AutoCAD?
 
In this chapter, 
We will learn how to use the Ribbon menu, 
Pull-down menu, and Icon menu.

Chapter 1 Screen Composition
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Double-click the AutoCAD 2027 icon on the desktop.

② Start from [Start] - Click on AutoCAD 2027.

Launch AutoCAD 2027

2

1

Section 1 Starting and Closing AutoCAD2027

Launch AutoCAD 2027

launch

1

[ Start ] page

①   Open  [Open file], [Open sheet set], [Refer to sample drawing], etc.
 Select a drawing that has already been created.

②   New  Select a template when creating a new drawing.
 You can also use this template wizard to make sheet sets.

③   Recent
 The file you most recently used is displayed. 
  displays drawings,  displays the history in text.

④   File Tab Menu  You can select ① , ② , or ③ above.

［ Open... ][ New ]3

[ Open...] [ Create New ]
①  Open files...  Open an existing drawing (dwg , dxf , dwt).
②  Open a sheet set...  Open the sheet set (dst).
③  Explore sample drawings...  Open the sample drawings (dwg , dxf , dwt) provided by Autodesk.
④  acadiso.dwt  The template file that was most recently used is displayed.
⑤  Browse template...  Open a folder of templates other than those listed above.
⑥  Create sheet sets...  Create a new sheet set (dst).

launch

Initial screen for a new drawing (the red frame is the drawing area)

[ Start ] page

① Start from [ Shortcut ].

The image below shows the start screen of AutoCAD 2027. 

There are four items on this start screen. The first item displayed is [Recently Used Files].

To open another page, click [Learning] in the lower left corner.

 

From the pull-down menu (drop-down list),

you can open existing files (dwg, dxf, dwt) and sheet sets (dst).

You can also use sample drawings provided by Autodesk.

1

2

3

4

5

6

1

2

3

 

The pull-down menu (drop-down list) displays

the template file that was most recently used.

To use a template that is not displayed here,

select another template from [Browse for Template...].

You can also download templates from the Autodesk website 

and use them.

With [Create Sheet Set...], you can create a sheet set

following the wizard.

［Open... ]

[ New ]

4
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Exit from [ Application Menu ]

2

Exit AutoCAD 2027

① Select the bottom right  corner of the [ Application Menu ].　 

1

2

Exit from AutoCAD 2027 [Windows]

② Select [Yes] or [No] on the Save screen.      

 　If you choose [Yes], the [Save As] dialog box will

 　appear.

① Select the “X” mark at the top right corner of AutoCAD.（The same screen as ② above will appear.）

launch end

［Learning] page4
On the [Learning] page, you can learn using video with audio from [Videos].

You can also learn more about AutoCAD using [What’ s New] and [Online Help].

And on [Online Resources], you can get training materials from the website.

1

2

3

4

AutoCAD Exit ButtonExit button for drawing file (AutoCAD does not exit)

[ Learning ] page
①  Autodesk Web site  Browse Autodesk’ s Online Help and Support.

②  Tip  You can learn more in the help section of the Autodesk website.

③  VIDEOS  Learn about the new features with this video with audio.

④  Online Resources  Resources can be obtained from the Autodesk website.

Using [ Online Help ]5
You can view detailed help from the Autodesk’ s website. 

① Select Help from  the top right corner of AutoCAD.
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Change from [ Options ]1 Hide the screen “grid”

3 Changing the Screen Background Color

① Press the right mouse button in the drawing area to open the “Shortcut Menu” .  

　 Select [Options] at the bottom of the menu.

② Open the [Display] tab of the [Options] dialog box. 

　 Directs the user to   in Window Elements. ( Fig.1) 

 

③ Select 2D Model Space under Context, then select Background under Interface Elements.

　 Then select “white” from the <Color> selection on the right and choose .

 　(Fig.2)

 Display drawing grid

1

4

① To switch the display of the grid that appears in the drawing area, 

 　click [ Display drawing grid ] in the [ Status Bar ] at the bottom of the screen.

② Clicking [ Dispaly drawing grid ] in the [ Status Bar ] toggles the display on and off.

Display drawing gridChange Background Color

(Fig.1)

To return the settings to their default values, press    button.

(Fig.2)
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Layout SpaceModel Space

5 Model space and Layout space In [Layout Space], the layout is reduced in size to fit the paper size.2

In [Model Space], draw the model in actual size, and place the frame                                          

in the inverse size of the print size.
1

In the above diagram, the frame is 41000 mm wide and 28700 mm high, so if this drawing is printed at 

1/100 scale, it will be printed with a frame that is 410 mm wide and 287 mm high.

② Place the figure frame in the model space. 

 　When printing at a scale of 1/100 on A3 paper,  

　 place the figure frame at 100 times the size in advance.

In the above diagram, the frame is 410mm wide and 287mm high, so if this drawing is printed at 1:1 scale,    

it will be printed at 410mm wide and 287mm high (the same size). 

When placing the shapes on A3 paper, they will be scaled down to 1:100 or 1:50,  

so the scale of the print will be 1:1.

① In [Model Space], the drawing is made in actual size.

① The drawing created in [Model Space] is placed in [Layout Space] in order to print it. 

　  In [Layout Space], the paper to be printed is placed, and the drawing is reduced in size so that it fits 

　  within it

② Place the frame in the layout space. 

　 If you are printing at a scale of 1:1 on A3 paper, place the frame at the same size as the A3 paper.
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Section 2 AutoCAD Interface

Application Menuinterface

Screen interface

①  Application Menu  Execute major commands such as [ New ] [ Save ] [ Print ] etc.

②  Quick access toolbar  There are frequently used tools (New, Save, Print, etc.).

③  File tab  The name of the currently open drawing is displayed.

④  Ribbon Menu
 A tool palette associated with a command, containing tools
 and controls.

⑤  Command window
 All commands appear on the command line, whether you type then        
 manually on the command line or select them on the ribbon.

⑥  Status bar  Controls the on/off of drafting aids.

⑦  Mouse cursor
 There are several types of cursors.  
 The cursor shape will change depending on the situation.

⑧  UCS Icon  Indicates the current coordinate system within the drawing area.

⑨  Drawing area  This is the area where drawings are created.

⑩  Shortcut menu
 Right-click in the drawing area to display it.  
 Tools and options are available in the menu.

⑪  Navigation Bar
 There are tools for screen manipulation, such as screenovement and 
 zooming.

1 AutoCAD Interface

［ Application ] menu1

①  New
 Create a new drawing.
 You can use a template or use an existing drawing as a new drawing.

②  Open  Opens an existing drawing.

③  Save  Save the drawing you are working on as is.

④  Save As  When saving a new drawing, a dialog appears.

⑤  Import  Loads files other than DWG format. (PDF, DGN, etc.)

⑥  Export  Export to a file other than DWG format. (DWF, PDF, DGN, etc.)

⑦  Publish  Create and archive email attachments and package them.

⑧  Print  Prints the drawing you have created. 

⑨  Drawing Utilities  It has the ability to audit drawings and repair errors.

⑩  Close  Closes the currently opened drawing.

⑪  By Ordered List  Specify four ways to display the drawings.

⑫  Recent Documents  The drawing file most recently used is displayed.

⑬  Options  A dialog box for setting up the drawing appears.

⑭  Exit  Exit AutoCAD. 

1

2

3

4

5

6

7

8

9

10

11

13 14

12

 By Ordered List  Displayed in order of use

 By Accessdate  Display by date

 By Size  Display by file size

 By Type
 Show file names in               

 descending order

4

5 6

7

8

9

10

11

1 2

3
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［ File ］ tab

① When the drawing is opened as a new drawing, it is <Drawing1>.

② When an existing drawing is opened, the drawing name is displayed.

③ When you have multiple drawings open, you can use “View” tab -> “Interface” panel ->  
　 Tile Vertically to view both sides of at the same time.

3

By looking at the file name                  
in the File tab,  
you can see which file is  currently 
open.

File tabQuick Access Toolbar

The drawing with the [crosshair cursor] is the active file.

File TabFile Name File Name

Point!

［ Quick Access ] Toolbar2

Uudo Redo

①  New
 Create a new drawing. You can use a template or  
 use an existing drawing as a new drawing.

②  Open  Opens an existing drawing.

③  Save  Save the drawing you are working on as is.

④  Save As  The first time you save a drawing, a dialog appears.

⑤  Plot
 Plot the created drawing. 
 It is also possible to output to file.

⑥  Undo
 Commands can be traced back to the beginning of  
 the drawing.

⑦  Redo  It can be used immediately after “Uudo” operation.

・The information for “Undo” is saved only in the current drawing.

   If a drawing is closed and reopened, the previously executed steps cannot be undone.

・“Redo” command can only be used immediately after an undo operation.

・“Redo” operation can be performed indefinitely.

・“Undo” option is displayed by typing “Undo” on the command line.

   “Undo”  option can be used to undo multiple operations at once.

・Type “Mredo” on the command line to display the “Redo” option.

   You can enter the number of operations or specify the option [All (A)/Last (L)].

6 7

3 4 5 61 2 7
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［ Ribbon ] Menu4 [ Command Window ] and [ Input Device ]5

① [Tab］

③ Groups in [Panel].

④ [Dialog Box Launcher］

Ribbon menu

①  Tab  Displays control panel titles.

②  Panel  It contains the related groups.

③  Panel Groups
 A group of similar commands will be displayed. 
 Panels with down arrows also have commands.

④  Dialog Box Launcher  The associated settings dialog will appear.

② [Panel］

① The command history is displayed at the top of the command window 1 .  

 　The numbers, letters and options used in the commands you have executed are displayed. 

 

② The bottom part of the command window 2  is the command line.

 　 Input is performed at the cursor position on the command line.

 　 Also, after entering a number or character on the command line, be sure to press the Enter key. 

 

③ The command window is usually displayed at the bottom of the drawing window,  

 　but you can move it anywhere on the screen. 3

Command WindowRibbon menu

Group of circles

Other commands in [Draw]

Keyboard

①  Esc  Cancels all operations and returns to the [Command:] state.

②  Enter  After keyboard input, be sure to press the Enter key.

③  Space  The Space key is the same as the Enter key.

④  Up and down arrows  The commands used before are displayed.

⑤  Tab  Use to move items within the dialog box.

Mouse (pointing device)

⑥  Left button  It is used to select menus and shapes, and to indicate coordinate points.

⑦  Right button  Used for displaying a shortcut menu.

⑧  Wheel button
 Turning the button will zoom in and out, moving it while holding down   
 will move the screen, and double-click will zoom in on the selected area.

3 4

5

1

2

8

6 7

1

2

3

Use the red frame to indicate where you want to move it.

In the command window, you will be prompted to select various options at each stage of the command 

processing, and you will be asked to enter related numbers and letters.。

3 4

1 2
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［ Status ] bar6 7
This controls the current drawing settings (cursor coordinates, mode settings, etc.)

Right-click on the red circle icon and select Settings.

The [ Drawing Settings ] dialog box will appear.

Shape of the [ Mouse Cursor ]

8 ［ UCS ] icon

① The UCS icon indicates the current coordinate system within the drawing area. 

② By default, the UCS icon is displayed at the origin if the origin is within the drawing area,  

 　or at the lower left of the screen if the origin is outside the drawing area. 

③ When the current coordinate system is the world coordinate system, the origin of the UCS icon is    

 　indicated by a square frame, but when it is the user coordinate system, the frame is not displayed.

In the pull-down menu, [View] -> [Display] -> [UCS Icon], 

you can select the display format for the UCS icon.

World Coordinate System User Coordinate System

 Combination of [crosshair] and [pickbox]

　This is the shape when no commands or tools are selected.

 [Crosshair]

　This is the shape used to select commands and indicate coordinate points.

 [Pick Box]

　The shape used when selecting an object.

 [Arrow]

　This is the shape when selecting a command.

 [Palm of the hand]

　This is the shape when the screen is moved.

 [Zoom in/out]

　This is the shape during real-time zoom.

Mouse cursor / UCS iconStatus bar

The role of the [status bar]

①  The cursor coordinates (X, Y) are displayed. 

②  Switches between Model space and Layout space.

③  Switches the Grid on and off.

④  Switches Snap on and off.

⑤  Switches the Dynamic Input on/off.

⑥  Switches the Ortho Mode on and off.

⑦  Switches Polar Tracking on and off.

⑧  Object Snap Tracking ON/OFF toggle.

⑨  Switches the Object Snap on/off.

⑩  Switches Line weight on and off.

⑪  Switches the transparency on/off.

⑫  Switches the Selection Cycling ON/OFF.

⑬  Displays all objects with different scaling.

⑭  When the annotation scale is changed, it will be added automatically.

⑮  Displays the annotation scale for the current view.

⑯  Switches the Quick Properties ON/OFF.

Right-click on the [Status Bar]

 Right-click on Snap, Grid, Orthomode, OSNAP, etc. to open the “Drafring Settings” dialog.

4 5 6 7 8 9 10 11 12 13 14 151 2 3 16
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[Home] Tab1Section 3 AutoCAD Menu

Menu to select a command

 1 Ribbon menu  Related tools are grouped together.

 2 Pull-down menu  This is a tool that is shown in characters.

 3 Shortcut menu  Displayed by right-clicking the mouse.

 4 Grip menu
 This will appear when you press the right button  
 when an object is selected.

 5 Status Bar menu  This is the menu displayed on a status bar.

1 List of Ribbon Menus

[Draw] Panel

[Modify] Panel

[Layers] Panel

[Properties] Panel

[Groups] Panel

[Utilities] Panel

Home tabRibbon menu list

Group and operate as one cohesive entity  
① [GROUP]  
Create a set of objects to be stored  
② [PKFSTGROUP]  
Manage named groups

① Distance・・・Measure the distance 
② Radius・・・Measure the radius 
③ Angle・・・Measure the angle  
④ Area・・Measure the area  
⑤ Volume・・・Measure the volume

1 Home tab

　

2  Insert tab

　

3 Annotate tab

　

4 Parametric tab

　

5 View tab

　

6 Manage tab

　

7 Output tab

　

8 Collaborate tab

　

Create objects such as lines and circles

Modify created objects

Control of Layers

Manage object properties

4

5

1

2

3

1

2
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[Insert] Tab2

Annotation tabInsert tab

[Annotate] Tab3
[Text] Panel

[Dimensions] Panel

[Centerlines / Leaders] Panel

[Table] Panel

[Markup] Panel

[Annotation Scaling] Panel

[Block] Panel

[Block Definition] Panel

[Reference] Panel

[Import] Panel

[Data] Panel

[Linking & Extraction] Panel

① Single 
Edit the values, character of each attribute  
② Multiple 
Specify whether to enter changes  
individually or in multiples

① Set Base Point 
Specify the base point 
② Attribute synchronization 
Apply changes to the attributes of 
block definitions to all block 

Import geometry, fill, raster 
images, and TrueType character 
objects from PDF files

① Field 
Create a multi-text object that includes fields that can be automatically 
updated in response to changes in field values. 
② OLE Object 
Insert a linked object or embedded object.

① Wipeout 
Create wipeout objects and control whether wipeout 
frames are displayed or not. 
② Cloud mark 
Create or modify cloud marks.

Objects that support different 
scales can be made to support 
multiple annotation scales for 
views of different scales

① Data Link 
Links data and table objects in Microsoft Excel 
(.XLS, XLSX, CSV) files 
② Download from Source 
Updates data from external data links

Import external drawings and images,  
and edit them directly.

Linking data in 
Microsoft Excel files 
to table objects

1

2

1

2

1

2

1

2

1 2
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[Geometric] Panel

[View] Tab5[Parametric] Tab4

[Dimensional] Panel

View tab / Manage tabParametric tab

[Manage] Panel

[Viewport Tools]  Panel

[Named Views]  Panel

① UCS Icon 
Control the display/non-display, position, appearance and selectivity of UCS 
Icon 
② Navigation Bar 
Access navigation tools such as the wheel, screen movement and zoom

① Show/Hide : Toggle the display/non-display  
② Show All : Display all geometric constraints 
③ Hide All : Hide all geometric constraints

① Show/Hide : Toggle between showing and hiding 
② Show All : Show all dimension constraints 
③ Hide All : Hide dimension constraints

① Remove Constraints 
Remove all geometric and dimensional constraints from the selected set of 
objects 
② Parameter Management 
Manage all dimensional constraint parameters, reference parameters

Control the display of the restraint bar Restraint bar dimensions Control the restraint settings

When you hover over an object with 
geometric constraints applied,  
all the constraint bars associated with  
that object will be highlighted.

Dimensional constraints maintain  
a specified distance or angle  
between geometry objects.

[Interface]  Panel

① File tab 
Switch between showing and hiding the File tab 
② Layout tab 
Switch between showing and hiding the Model tab 
and Layout tab

[Palettes]  Panel

[Model Viewports]  Panel

Creating Multiple Viewports in Model Space or Paper 
Space 
The commands available will depend on whether you 
are creating the viewport in model space or layout 
(paper) space

[Options] -> [Display] tab settings 
① Window elements 
② Layout elements 
③ Display resolution 
④ Display functions 
⑤ Crosshair cursor size 
⑥ Fade control

If you turn off the File tab, 
the tab will be hidden.

If you turn off the Layout tab, 
the tab will be hidden.

3

1
2

3

1
2

1 2

1 2

1 2

Display the history of the 
prompts and command line 
input during drawing

It is also possible to use  
the [F2] key
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[Output] Tab7

Output tab / Collaborate tab

[Export to DWF/PDF] Panel

[Plot] Panel

[Share / Comapare] Panel

 Share

 Display the [Share Drawing] palette 
 This palette displays a list of shared views that have been temporarily uploaded
 to the cloud, as well as messages and responses posted to shared views. 
 To facilitate online collaboration, it is possible to reference specific locations  
 and areas within drawings from messages.

 Comapare
 Compare and highlight the differences between two revisions  

 of the same drawing or between different drawings.

[Collaborate] Tab8

2 Pull-down menu

You can show or hide the menu bar from the Quick Access Toolbar. 
 
① By default, the [Menu Bar] is not displayed above the ribbon.

Pulldown menu

 [Hide [Menu Bar]

② Click on this icon at the far right of the [Quick Access Toolbar].   
③ Under [Customize Quick Access Toolbar], select [Show Menu Bar] from the second item down.

④ [Menu Bar] appears.

⑤ To hide the Menu Bar, click on the rightmost icon on the Quick Access Toolbar  
　 and select “Hide Menu Bar” from the Menu.   
⑥ Alternatively, in the [Menu Bar] area, click the right mouse button and uncheck “Show Menu Bar” .

Export the created drawing  
to PDF or DWF.

① Share Drawing 
Share models and collaborate 
② DWG Compare 
Compare different drawings and check  
the differences

① Plot 
Output drawings to a plotter, printer, or file 
② Batch Plot 
Publish drawings to DWF, DWFx, PDF files,  
or a printer or plotter

[Manage] Tab6

[Customization / Cleanup] Panel

① Customize the Tool 
Palette 
② Delete objects and 
non-objects

1 2

1 2

1 2

[More Commands...]
You can edit the interface items.
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⑦ Commands with an arrow mark to the right of the Pull-down menu  
　 have a group of commands to the right of them.

⑧ Types of Pull-down menus

Pulldown menuPulldown menu

 Pull-down menu

 Cascade menu

You can customize the menu  

structure from the [CUI] command.
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The menu that appears when you right-click is called the shortcut menu. 
This menu allows you to repeat the previous command or execute other commands.

② Re-execute the previous command 
　 After the command is finished, it can be repeated using the shortcut menu. 
　 (In the case of [Circle], the drawing can be started from the circle command.) 
　 To cancel, select “Cancel” from the shortcut menu.

① Select options while executing a command 
　 While executing a command, right-click to display the shortcut menu. 
　 (Here [Circle<radius>] is being executed.)  
　 Options related to circles are displayed. 
　 You can select [Diameter] from the shortcut menu.

3 Short cut Menu

If an object is selected when Command: is displayed,  
a blue square will appear at the object snap location. This is called Grip.

③ Moving a hot grip changes the radius of the circle and the length and angle of the rectangle.

Grip menuShortcut menu

4 Grip Menu

① (left) When an object is selected, a blue grip appears. 
② (Right) Hover the mouse over the grip and the grip will turn pink. (Floating Grip)  
　 Hover the mouse over the grip on the perimeter of the circle to show the radius of the circle. 

When a grip is selected, the color changes to reddish brown. This is called Hot Grip.

④ Select a hot grip and use right-button shortcut to stretch, move, rotate, scale, mirror, base (specify), 
　 and copy.
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Status Bar Menu5

Status bar menuStatus bar menu

Customizing the Status Bar1
① Click the [Customization] button at the far right of the status bar to display the list. 1  
② If you check the box, it will be displayed in the Status Bar. 2

③ The types of status bar differ between the [ Model Space ] and [ Layout Space ].

Display coordinates on the Status Bar2
① The number on the far left of the Status Bar displays the coordinates (X, Y) of the cursor. 

② The display will differ between when you are waiting to input a command and when you are drawing.

③ When waiting for a command to be input (Figure 1), the X and Y coordinate values of  

 　 the cursor position are displayed.

Change the Settings3
(1) Right-clicking on the status bar icon will display the settings dialog.

(Model Space)

(Layout Space)

Status Bar of the Model Space
①  Model Space  Switching model/layout spaces
②  Display Drawing Grid  Grid display ON/OFF
③  Snap mode  Snap mode ON/OFF
④  Show annotation objects  Display all objects with different scales

⑤  Add scales to annotative  
 objects...

 Automatically handles objects  
 when the annotation scale is changed

⑥  Annotative scale of  
 the current view  Display the current annotation scale

Status Bar of Layout Space
⑦  Layout Space  Switching model/layout spaces
⑧  Maximize Viewport  Maximize the layout viewport
⑨  Show annotation objects  Display all objects with different scales

⑩  Add scales to annotative ...  Automatically handles objects  
 when the annotation scale is changed

(Figure 1)

④ Figure 2 shows the values while the line command is being executed. 

     The values for the straight-line distance and angle are changing.

(Figure 2)

① ② ③ ④ ⑤ ⑥ ⑦ ⑧

(2) Settings Dialog

(3) The red circle icon is used to switch between ON and OFF.

4 5 61 2 3

7 8 9 10

ORTHOMODE TRANSPARENCYDISPLAY

1

2

784 5 61 2 3
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Create new drawing from template1

New Drawing and Save

 Pulldown menu  [ Quick Access ] Toolbar -> New
 Pulldown menu  [ File ] -> New
 Command  New , Qnew

New drawing from template [New][Qnew]1

Types of templatesNew drawing from template

Since acad is in inches and acadltISO is in mil-

limeters, we will use the inch-based acadISO  

and acadISO-Named Plot Styles as templates.

Types of templates2

Template name Unit System Types of Plot Styles
 acad-Named Plot Styles.dwt  Inch  Named Plot Styles
 acadISO-Named Plot Styles.dwt  Metric  Named Plot Styles
 acad.dwt  Inch  color dependent plot styles
 acadiso.dwt  MetricI  color dependent plot styles

① AutoCAD provides many types of template files, but there are usually two types of templates  
　 that are used. 
② <acadISO-Named Plot Styles.dwt> for [named plot styles] and <acadiso.dwt>  
　 for [color dependent plot styles].

Location where template files are saved3
① You can specify a different file as the template file. 
② The template file is saved in [ Options ] -> [ Files ] by default.

③ You can also specify a different folder by clicking the [Browse] button in the top right corner. 
④ When creating a new file from the next time onwards, the file (DWG, DWT) that was last specified will  
　 be loaded as a template file.（If no folder is specified, the default AutoCAD folder will be displayed.）

Section 4
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① Select [ Quick Access ] Toolbar -> [ New ]. 
　 The files you can select when creating a new file are [dwg] or [dwt] files.

Create a new drawing based on an existing drawing1

 Ribbon Menu  [ Quick Access ] Toolbar -> New
 Pulldown menu  [ File ] -> New
 Command  New , Qnew

New drawing from an existing drawing [New][Qnew]2

If you use a previously created drawing as a template, 

the settings for layers, text styles, dimension styles, 

etc. have already been created.

New drawing from an existing drawing

② Load the existing drawing [Archi] (Fig.1), select [Save As], and save it as [Archi-1] (Fig.2).

(Fig.1) (Fig.2)

(Fig.3) (Fig.4)

③ Delete all objects in the newly saved [Archi-1] (Fig.3). 

④ All the objects in the drawing have been deleted (Fig.4), but [Layer], [Text Style], [Dimension Style]  
　 and [Block] are all still there, so you can start drawing immediately.

(Layer)

(Block)

(Text Style)

(Dimension Style)

New drawing from an existing drawing



Sc
re

en
 C

om
po

sit
io

n

Sc
re

en
 C

om
po

sit
io

n

36 37

Chapter 1 【Screen Composition】 Chapter 1 【Screen Composition】

① Select [ Application Menu ] -> [ Close ]. 

② To save the changes, click the [Yes] button. 

　 The drawing will be saved over. 

③ If you are creating a new drawing,  

　 the [Save As] dialog box will appear. 

④ If you do not want to change the settings,  

　 click the [No] button.

Press the X button in the upper right corner of 

the open drawing.

Close the drawing (1)

Close the drawing (2)

① Select [ Quick Access ] Toolbar -> [ Open ]. 

② The [Select file] dialog will appear. 

③ Select the drawing to open. 

④ You can check it in [Preview]. 

⑤ Click the [Open] button to open the drawing.

Open an existing drawing

2

1 1

 Ribbon Menu  [ Quick Access ] Toolbar -> Open
 Pulldown menu  [ File ] -> Open
 Command  Open

[Open]3

 Ribbon Menu  [ Quick Access ] Toolbar -> Close
 Pulldown menu  [ File ] -> Close
 Command  Close

[Close]4

CloseOpen

① Press the right button on the file tab. 

② Select [ Close ] from the shortcut menu.

Close the drawing (3)3

AutoCAD exit buttonFinish button for drawing

You can also use the right-click menu on the File tab 

to create new files or open existing ones.
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① Select [ Quick Access ] Toolbar -> [ Save ]. 

② If the drawing that is currently open is new, the [Save As] dialog box will appear. (Next page) 

③ If the open drawing is an existing drawing, it will be saved over.

Save

◎ Only the newly added data is saved, so it saves time. 

◎ If the drawing you want to save is a new drawing (Drawing1.dwg),  

 　the same dialog box as the [Save As] command will be displayed.

① Select [ Quick Access ] Toolbar -> [ Save As ]. 

② The [ Save Drawing As ] dialog box appears. 

③ [ Save in: ] Specify where to save the files. 

④ [ File name: ] Name the drawing you have created. <Default: Drawing1> 

⑤ [ File of type: ] Select the format to save as. <Default: AutoCAD 2018 (*.dwg)>

You can choose the AutoCAD file 

format (dwg) as the file type. 

There are also ASCS Ⅱ dxf, Binary.

dxf and other file formats, and they 

are backward compatible.

1 1

 Ribbon Menu  [ Quick Access ] Toolbar -> Save
 Pulldown menu  [ File ] -> Save
 Command  Save , Qsave

[Save][Qsave]5

 Ribbon Menu  [ Quick Access ] Toolbar -> Save As
 Pulldown menu  [ File ] -> Save As
 Command  Saveas

[Saveas]6

Save AsSave

Save as

You can also display the X icon on the far right  

of the File tab by right-clicking.
You can also display X icon on the far right 

of the File tab by right-clicking.

4
5

3
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Export drawing1

 Application Menu  [ Application Menu ] -> Export
 Pulldown menu  [ File ] -> Export
 Command  Export

[Export]7

Export

① Select [Application] Menu -> Export 

② When saving in DWG format, you can save existing blocks, specific shapes within the drawing,  

　 or the entire drawing as a separate DWG file. 

③ In addition to DWG format, it is also possible to save in DWF, PDF, BMP, WMF, and DGN formats. 

④ If you select [ Other formats ] (Fig.1), the [Export Data] dialog box will appear (Fig.2).

Type File format Command
 Meta file (*.wmf)  Microsoft Windows Meta file  WMFOUT
 Bitmap (*.bmp)  Bitmap file  BMPOUT
 Block (*.dwg)  Dwg file  WBLOCK]
 V7、V8 DGN (*.dgn)  MicroStation DGN  file  DGNEXPORT

(Fig.1) (Fig.2)

Examples of file formats that can be saved from [ Other Formats ]

Chapter 2  Basic Operations

What methods are there for entering coordinates?
How do we zoom in and out and move the screen?

In this chapter,
we will learn the basic operations of AutoCAD.

Section 1 Basic Operations

Section 2 User coordinate system
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The current coordinate values are displayed on the left side of the status bar  
at the bottom of the screen. 
When you move the mouse cursor within the drawing screen,  
the coordinate values in the status bar change according to the cursor position.

Absolute Coordinate

X coordinate value, Y coordinate value
Always enter the horizontal and vertical distances from the origin (0, 0).

Distance < Angle
Always enter the distance and angle from the origin (0, 0).

Section 1 Basic Operations

Types of coordinate systems

Absolute CoordinateTypes of coordinate systems

1

< first point >   ：    　20,30 (P1)

< next point >  ：　   40,60 (P2)

< next point >  ：　   90,90 (P3)

Right-click

Dynamic Input: [ Off ]

Dynamic Input: [ On ]

< first point >   ：    　  20,30 (P1)

< next point >  ：　  #40,60 (P2)

< next point >  ：　  #90,90 (P3)

Right-click

< first point >   ： 　   0,0

< next point >  ：　   100<45

Right-click

< first point >   ： 　   0,0

< next point >  ：      #100<45

Right-click

Dynamic Input: [ Off ]

Dynamic Input: [ On ]

P1( 20 , 30 )

P2( 40 , 60 )

P3( 90 , 90 )

Start

End

Coordinate Systems

①
 AutoCAD can use two types of coordinate systems:  

  WCS (World Coordinate System) and UCS (User Coordinate System).

②
 By default, the world coordinates are set, and the XY axis icon called the [UCS icon] 

  (red circle) is displayed in the drawing screen.

③
 The horizontal direction is the X-axis, the vertical direction is the Y-axis,  

 and the direction perpendicular to the XY plane is the Z-axis.

④

 The point where the X and Y axes intersect is the origin (0, 0, 0). 

 As you move to the right on the X axis, the X value increases. 

 As you move up on the Y axis, the Y value increases.

Absolute Polar Coordinate
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@ distance < angle
Following @, enter the straight-line distance and angle.

Move the mouse and enter only the distance.

Use with Ortho Mode turned on

< first point >   ： Any point (P1)

< next point >  ： 50 (P2)

< next point >  ： 50 (P3)

< next point >  ： 50 (P4)

< next point >  ： 50 (P1)

Right-click

@ Increment of X, increment of Y

Following @, enter the straight-line distance between X and Y.

The angle is fixed at the angle set in the <Polar Angle Setting> of  

[Polar Tracking] in [Drafting Settings], so just enter the distance.

Enter the coordinate values using the <length> and <angle>

Direct distance Input / Polar TrackingRelative Coordinate

P2P1

P3P4

Relative Coordinate

Relative Polar Coordinate

< first point >   ：    　20,30

< next point >  ：     @50,40

Right-click

Dynamic Input: [ Off ]

Dynamic Input: [ On ]

< first point >   ：    　 20,30 

< next point >  ：　    50,40

Right-click

Start

End

Start

End

< first point >   ：    　20,30

< next point >  ：     @70<60

Right-click

Dynamic Input: [ Off ]

Dynamic Input: [ On ]

< first point >   ：    　 20,30 

< next point >  ：　    70<60

Right-click

Direct Distance Input

Polar Tracking
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Point!

 Status bar  Dynamic Input
 Pulldown menu  [ Tools ] -> Drafting Settings
 System variable  Dynmode

[ Dynmode ]2
① Turn ON [ Dynamic Input ] in the Status Bar. 

② The input from the command line will switch to input into the frame that appears near the mouse.

[Dynamic Input] mode is ON2

Dynamic Input is a method of inputting values at the cursor position instead of entering them  

on the command line. 

There are two types of dynamic input: [Pointer Input] mode and [Dimension Input] mode.

① To draw line shown in the figure below, enter the following from the command line  

　 after specifying the starting point P1:<@100,100> (Fig.1)

P1

P2

[Dynamic Input] mode is OFF1

P1

P1

（Fig.1）

（Fig.2）

③ (Fig.1) 

When you indicate the first point (P1) of the line 

command, the message [Specify next point or] 

will be displayed. 

 

④ (Fig.2) 

The dimension input tooltip is displayed  

when the object grip is selected.

In the [Dynamic Input] tab of the [Drafting Settings] dialog,  

there are <Pointer Input> and <Dimension Input>. 

You can change the settings in this dialog.

DynmodeDynmode

The difference between [Dynamic Input] being [On] and [Off]

Dynamic Input　[On] Dynamic Input　[Off]
 Absolute Coordinate 　#X , Y 　X , Y
 Relative Coordinate 　  X , Y 　@X , Y
 Polar Coordinate 　Distance < Angle 　@Distance < Angle

② If [Dynamic Input] is OFF, enter the value from the command line. 

　 The same applies to Modify command (copy),  

　 where you also enter the value from the command line. (Fig.2)

(Fig.1)

(Fig.2)

[Dimenshon Input]

[Dimenshon Input Fields Simutaneously]

The method of entering coordinates differs depending on whether [Dynamic Input] is on or off.
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 Status bar  Object Snap
 Pulldown menu  [ Tools ] -> Drafting Settings
 Command  Osnap  Function key  F3

⑤ Click the [OK] button to close the dialog box.

① Press the right mouse button on the [Object Snap] in the [Status Bar]. 

② The [Drafting Settings] dialog box will appear. 

③ Select the [Object Snap] tab. 

④ Check the snap to use from [Object Snap].

Object Snap Settings

Unset object snaps

[ Osnap ]3

2

1

Object SnapObject Snap

Click the down arrow (red circle) on the right of [Object Snap] to select another snaps.

Settings from the [Status Bar]3

① Press  button in the [Drawing Assistant Settings] dialog box. 
　 or 

② Click [Status Bar] -> [Object Snap] to turn it off. (See the image below.)

Select using [Shift] + Right button.

Settings from the [Shortcut]4

Midpoint（MID ）

Snap to the midpoint of line, arc, etc.

Endpoint（ENDP）

Snap to the nearest endpoint of line , arc, etc.

Center（CEN）

Snap to the center of circle or arc

Intersection（INT）

Snap to object intersection
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Geometric CenterObject Snap

Perpendicular (PER)

Snap to a point that is perpendicular to  

the object from the indicated point

Tangent  (TAN)

Snap to a point that touches the circle 

from the indicated point.

Quadrant (QUA)

Snap to 0, 90, 180, and 270 degree points of  

circle, arc, ellipse, or ellipse arc
Snap to text, block insert point

Insert (INS）

Node（NOD）

Snap to point object

Extended Apparent Int (APPINT)

Snap to apparent intersection  

Directed over two objects

Extension (EXT)

Snap to a point on the extension

(Fig. 1) (Fig. 2)

(Fig. 3) (Fig. 4)

Create a [closed polyline] or [spline] (Fig. 2) from a shape bounded by lines or arcs (Fig. 1). 

(Use [Boundary] or [Edit Polyline])

Select [Draw] -> [Circle] and use the object snap (Goemetric Center)  

to direct the polyline outline. (Fig. 3) 

You can get Goemetric Center of polyline as the center of the circle. (Fig. 4)

Goemetric Center (GCEN）
Snap to closed polyline and spline Goemetric Center

Nearest（NEA）

Snap to the closest point to  

the indicated position

Select the first line

Select the second line

Extended  
Apparent Int

Indicate end point

Extension

Indicate end point
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[ Zoom ]4

ZoomZoom

 Ribbon Menu  [ View ] tab -> [ Viewport Tools ] panel -> Navigation Bar
 Pulldown menu  [ View ] -> [ Zoom ] -> Real Time
 Command  Zoom

There are the following methods for using [Zoom].

[ Zoom ]1

 [ Navigation bar ]  Pull-down menu [ Zoom ]  [ Shortcut ]

In

The drawing is enlarged (2X) from the center of the drawing.

Out

The drawing is scaled down (2X) from the center of the drawing.

Window

The area surrounded by the mouse will be enlarged.

1

2

Object

All objects will be shown full screen.
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 Ribbon Menu  [ View ] tab -> [ Viewport Tools ] panel -> Navigation Bar
 Pulldown menu  [ View ] -> Pan
 Command  Pan

[ Pan ]5

PanZoom

Previous

Returns to the previous screen.

If you repeatedly select [Zoom Previous],  

you will return to the screen that has been zoomed in  

and panned up to 25 times in a row.

All

Displays the entire range set in the drawing range  
or all of the drawn shapes.

Dynamic

Hold down the left mouse button and move the cursor up and down  
to zoom in and out.

Zoom In

Zoom Out

Pan

Moves the screen in the specified direction without changing 
the magnification.
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Navigation Bar6

 Ribbon Menu  [ View ] tab -> [ Viewport Tools ] panel -> Navigation Bar
 Pulldown menu  [ View ] -> [ Zoom ] -> Real Time
 Command  Zoom、 Pan

① From the [ Navigation Bar ] ->  [ Wheel ], select [Zoom].

[ Navigation Bar ] -> [ Zoom ]1

Navigation BarNavigation Bar

② While holding down [Zoom], moving the mouse up, down, left and right will zoom in and out 　 

　 in real time. This is the same as [Real-time Zoom]. 

① From the [ Navigation Bar ] ->  [ Wheel ], select [Pan].

[ Navigation Bar ] -> [ Pan ]2

② While holding down [Pan], move the mouse up, down, left or right to move the screen up, down,  

　 left or right. This is the same as [Real-time Pan].

③ To exit, click the X mark in the top right corner (left diagram). 

　 Or, click the down arrow in the bottom right corner (right diagram).
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Named View PortViewport Configuration

① Select [ View ] tab -> [ Model Viewport ] panel ->  [ Named Viewports ].

⑤ The [Named Viewports] tab displays the names of 
　 the saved viewports. 

⑥ When you select a viewport name, that viewport 
　 will be displayed.

 Ribbon Menu  [ View ] tab -> [ Model Viewports ] panel -> Named
 Pulldown menu  [ View ] -> [ Viewports ] -> Named Viewport
 Command  +Vports

Named Viewport8

② [ New Name ] tab shows the Standard viewports. 

③ The image on the right is an example of [ Four Equal ]. 
 
④ Save the name under [ New nmae ]. 
　 （Sample：4divide）

Viewport Configuration7

① Select [ View ] tab -> [ Model Viewports ] panel -> [ Viewport Configuration ] 
② Choose a viewport you want to use from the displayed viewport groups.

 Ribbon Menu  [ View ] tab -> [ Model Viewports ] panel -> Viewport Configration
 Pulldown menu  None
 Command  ai_TileDvp (1 ～ 12)

The viewport is not saved in [ Viewport Configuration ]. 
To save the  viewport , use [ Named Viewports ].
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② Select dominant viewport <current viewport>:   (Select the left viewport) 

③ Select viewport to join: Select the right viewport. (Fig. 1) 
④ The left viewport will be merged with the right viewport. (Fig. 2)

 Ribbon Menu  [ View ] tab -> [ Model Viewports ] panel -> Join
 Pulldown menu  [ View ] -> [ Viewports ] -> Join
 Command  -Vports -> J

Viewport (Join)9

 Ribbon Menu  [ View ] tab -> [ Model Viewports ] panel -> Restore
 Pulldown menu  None
 Command  -Vports -> R

Viewport (Restore)

Viewport (Restore)Viewport (Join)

10

(Fig. 1) (Fig. 2)

① Select [ View ] tab -> [ Model Viewports ] panel -> [ Restore ] 
② Only the current viewport is displayed. (The left side of Figure 1 is the current viewport.)

(Fig.1)The left is the current viewport. (Fig.2)Only the left viewport is displayed.

③ To call up the registered viewport, select [ Model Viewport ] panel -> [ Named Viewports ]. 
④ Select the registered [ 4divide ] from [ Named Viewports ]. (Fig. 3) 
⑤ The screen is divided into four sections as shown in Fig.4.

(Fig.3) (Fig.4)
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UCS (Object)UCS (Origin)

Section 2 User coordinate system

Use the selected line as X-axis.

① Select [ Pull-down menu ] -> [ Tools ] -> [ New UCS ] -> [ Object ]. (Fig.1) 

　 Select the line (S1) that you want to use as the new X-axis. (Fig.2-1) 

　 The end of the line will become the origin, and the direction of the other end of the line  

　 will become the positive direction of the X-axis. (Fig.2-2)

(Fig.1)

1

 Ribbon Menu  None　( UCS icon -> right button shortcut -> Object )
 Pulldown menu  [ Tools ] -> [ New UCS ] -> Object
 Command  Ucs -> O

UCS (Object)2

Translate the XYZ axis

① Select [ Pull-down menu ] -> [ Tools ] -> [ New UCS ] -> [ Origin ]. (Fig.1) 

　 The point (P1) indicated by the mouse will become the new origin. (Fig.2-1) (Fig.2-2)

The position relationship of XYZ is not changed. 
Only the position of the origin is translated. 
(This is used when drawing a shape with the center of 
the shape as the base point, etc.) 
 
The initial value of the Z coordinate is <0>.  
If you enter the start point P1 (0, 0, 0)  
and the end point P2 (10, 10, 10) in the Line ommand, 
you can draw in 3D space. 
(If you omit Z, the current Z coordinate will be used  
as the Z value.)

1

 Ribbon Menu  None　( UCS icon -> right button shortcut -> Origin )
 Pulldown menu  [ Tools ] -> [ New UCS ] -> Origin
 Command  Ucs -> N

UCS (Origin)1

(Fig.1) (Fig.2-1)

P1

(Fig.2-2)

S1

(Fig.2-1) (Fig.2-2)

② When using ortho mode, you can draw lines that are parallel  

　 or perpendicular to the new XY coordinate axis. (Fig.3) 

　 You can also easily arrange block so that they follow the XY axis. (Fig.4)

(Fig.3) (Fig.4)

P1(0 , 0)
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UCS (3 point)

 Ribbon Menu  None　( UCS icon -> right button shortcut -> View )
 Pulldown menu  [ Tools ] -> [ New UCS ] -> View
 Command  Ucs -> V

UCS (View)3

UCS (View)

Indicates the origin and the positive directions of the X and Y axes.

① Select [ Pull-down menu ] -> [ Tools ] -> [ New UCS ] -> [ 3 point ]. (Fig.1) 

　 Specify new origin point <0,0,0>: Use the mouse to indicate point P1. (Fig.2)

P1

( 図 1) ( 図 2)

P2

(Fig.3)

P3

(Fig.4)

② Specify point on positive portion of X-axis: Use the mouse to indicate point P2. (Fig.3) 

③ Specify point on positive-Y portion of the UCS XY plane:  Use the mouse to indicate point P3. (Fig.4)

④ The origin was moved and the XYZ axis rotated simultaneously. (Fig.5) 

⑤ Circle and text are also drawn accurately (Fig.6)

1

 Ribbon Menu  None　( UCS icon -> right button shortcut -> 3 Point )
 Pulldown menu  [ Tools ] -> [ New UCS ] -> 3 Point
 Command  Ucs -> 3

UCS (3 point)4

(Fig.5) (Fig.6)

The shapes are drawn parallel  

to the XY plane. 

The initial value of the Z coordinate is <0>. 

(Set the plane you want to draw on  

to the XY plane.)

① Select [ Pull-down menu ] -> [ Tools ] -> [ New UCS ] -> [ View ]. (Fig.1) 

② The direction the user is looking in becomes the view (positive Z-axis direction). (Fig.2)

Set the viewpoint direction to the positive direction of the Z-axis.

(Fig.1) (Fig.2)

1

[Right-Hand Rule]
When you hold your right hand with the palm facing up, the direction in which 

your thumb is stretched is the positive direction of the X-axis, 

and the direction in which your index finger is stretched is the positive direction 

of the Y-axis. 

Then, stretch your middle finger towards yourself. This is the positive direction of 

the Z-axis. 

These three fingers each indicate the positive directions of the X, Y and Z axes.

X

Y

Z X

Y

Z

-X

-Y

-Z

(0 , 0 , 0)
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UCS (World)

① Select [ Pull-down menu ] -> [ Tools ] -> [ New UCS ] -> [ World ]. 

　 It returns from the user coordinate system (Fig.1) to the world coordinate system (Fig.2).

Converting UCS (User Coordinate System) back to WCS (World Coordinate System)

The initial value for new drawings is [World Coordinate System]. 
You can see the current coordinate system in the form of the [UCS icon]  
in the left corner of the screen.

1

 Ribbon Menu  None　( UCS icon -> right button shortcut -> World )
 Pulldown menu  [ Tools ] -> [ New UCS ] -> World
 Command  Ucs -> W

UCS (World)5

(Fig.2)(Fig.1)

(Fig.2)(Fig.1)

In drawings, we may need to make various settings.
Settings such as text, dimensions, line types and layers 
are important items.

In this chapter,
we will learn how to set up drawings in AutoCAD 2025.

Chapter 3  Drawing Settings

Section 1 Drawing Settings
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[ Application Menu ] -> [ Options ] -> [ File ]1

 Application Menu  [ Application Menu ] -> Options
 Pulldown menu  [ Tools ] -> Options
 Command  Option

[Options]（Files）1

Options (Files)Options (Files)

[Specify a location to save files]

1  Support File Search Path

 Specify the location where files such as programs, fonts, and hatching are saved. 

 When using these files, they will be searched for in the folders specified here in order. 

 If the file is not in the [Support File Search Path], an error message will be displayed.

 

 To add a search path, click the [Add] button and specify the path using the [Browse] button. 

　　　　　　　　　　　 　

2  Automatic Save File Location

 When you specify auto-save in [Options] -> [Open and Save], it will be saved in this location.
 By default, the drawing will be automatically saved after 10 minutes have elapsed  

 since the last time it was saved.  

 When the drawing is saved, this temporarily saved file will be deleted.  

3  Template Settings

 Specify the path where the drawing templates used in the Startup Wizard  

 and the [Select Template] dialog box are searched. 

 If you want to change the location of the template files created by the user, specify it here.

 

The location where AutoCAD uses programs and files. 

① Hatch Patterns, LISP, and other programs are specified here. 

② The folder for backup and automatically saved files is specified. 

③ This is the location where template files are saved. 

④ This is the temporary location where drawings are saved while they are being created.

4  Temporary Drawing File Location

 While the drawing is being created, it is temporarily saved under the name “[Drawing name].ac$” .

 

2

3

4

1

Section 1 Drawing Settings
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[ Application Menu ] -> [ Options ] -> [ Display ]1

 Application Menu  [ Application Menu ] -> Options
 Pulldown menu  [ Tools ] -> Options
 Command  Option

[Options]（Display）2

Options (Display)Options (Display)

[Screen display settings]

1  Dispaly File Tabs

 You can specify the background color of the drawing window. The default is <black (33, 40, 48)>.

 

1

2

3

2  Layout elements

 This is the setting for placing printed drawings in the layout space.

 

A

B

C

3  Crosshair size

You can specify the size of the cross cursor. 

Specify it as a percentage of the screen size. 

If you set it to <100>, the cursor will extend  

to the top, bottom, left and right edges of the screen.

Set the color scheme and resolution of the AutoCAD screen. 

①   From this button, you can specify the screen color, etc. 

② Set the method for placing the drawing created in the model space in the layout space. 

③ You can specify the size of the mouse cursor. (The default is 5% of the screen size.) 

　  This data is saved in the drawing.  

　Any data that is not present is saved in the AutoCAD system.

To return the settings to their 

default lues, 

 

press this button.

A  Display printable area  Displays the area that can be printed on the specified printer.
B  Display paper back ground  Displays the size of the specified paper.
C  Display paper shadow  The paper’ s shadow is displayed thinly around the paper.
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[ Application Menu ] -> [ Options ] -> [ Open and Save ]1

 Application Menu  [ Application Menu ] -> Options
 Pulldown menu  [ Tools ] -> Options
 Command  Option

[Options]（Open and Save）3

Options (Open and Save)Options (Open and Save)

　
[Specify the file saving format, etc.]

1

2

3

1  File Save 

 Specify the version of dwg to save as. The default is <AutoCAD 2018 Drawing>. 

 The formats that can be specified are dwg, dws, dwt, and dxf.

 

2  File Safety Precautions

 Automatic save

 This is a selection for whether or not to automatically save the diagram in the middle of the process.    

 The default extension is <sv$>. 

 If you select automatic saving, the default is <every 10 minutes>.

 Create backup copy with each save

 This is a choice as to whether or not to create a backup file when saving a file. 

 The backup file extension is <bak>. 

 If you change the extension of the bak file to dwg, it will return to the original drawing.

 File extension for temporary files

 A temporary file is created during drawing, and you can specify the file extension. 

 The default extension is <ac$>. 

 The log file is automatically deleted when the drawing is saved normally.  

 This file contains information used by various AutoCAD commands, such as UNDO.

3  Application Menu

 Specify the number of files to display under [Recently Documents] (0-50).

 

You can specify detailed settings for AutoCAD file formats and backups. 

① Specify the version in which to save drawings created in AutoCAD.  

　 (Default value: <2018 dwg format>) 

② To keep your drawings safe, you can specify the time interval for creating backup files  

　 and automatic saving. 

③ Specify the number of files to be displayed in the file list in the [Application Menu].  

　 (Default value <9>)
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[ Application Menu ] -> [ Options ] -> [ Plot and Publish ]1

 Application Menu  [ Application Menu ] -> Options
 Pulldown menu  [ Tools ] -> Options
 Command  Option

[Options]（Plot and Publish）4

Options (Plot and Publish)Options (Plot and Publish)

[Print and Publish Settings]

1  Default plot settings for new drawings

 Specify the default output device (printer, PDF, etc.) when printing the drawing.

 

2  Plot to file

 Specify the default folder for saving files instead of printing to a printer.

 

3  Specify plot offset relative to

 Specify the [plot offset] area.

 

You can make detailed settings for printing. 

① Specify the initial value for [Output Device]. 

② Specify the location to save the file to when saving as a PDF or other file. 

③ Specify the distance from the drawing border. 

④ You can create your own printing style. This printing style can be saved. 

　  This data is saved in the drawing.  

　Any data that is not present is saved in the AutoCAD system.

1

2

3

4

Specify the distance from the boundary of  

the specified print range. 

Select either the [Printable Area] restricted by  

the printer or the [Edge of paper] restricted  

by the paper size 

. 

If you specify [Center the plot], it will be 

automatically set to the center of the print range.

The default value can be changed  

when printing. 

You can specify not only printers  

and plotters, but also PDF.

4  Plot Style Table Settings

 Set the default print style for new drawings and the print style for the current drawing.

 

By pressing this button , you can specify the folder to be used by the user.

①
 [Use color dependent plot styles] 
 You can create a new plot style.

②
 Specifies the default print style for layer 0   

 when a new drawing is created from scratch 
 without using a drawing template.

③
 Specifies the default plot style for new   
 objects when creating a new drawing from 
 scratch without using a drawing template.

④
 Creates a new default print style for new   
 drawings and the current drawing’ s print   
 style.

1

2

3

4

Specify in the plot dialog box
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[ Application Menu ] -> [ Options ] -> [ User Preferences ]1

 Application Menu  [ Application Menu ] -> Option
 Pulldown menu  [ Tools ] -> Options
 Command  Options

[Options]（User Preferences）5

Options (User Preferences)Options (User Preferences)

[Optimize basic operation settings]

1

2 3

2  Fields

 （Displays background of fields）

 

 （Field Update Settings）

3  Lineweight Settings

 （[Lineweight Settings] Dialog）

 
Basic settings such as the role of the mouse, [line thickness], and default values for [scale list]. 

① Specify the display format (panel, ribbon, etc.) when a shape is double-clicked. 

② Specify the background color of the field and the timing to update when the field is changed. 

③ Specify the initial value of [Line Thickness]. The default value is <0.25>. 

　  This data is saved in the drawing.  

　Any data that is not present is saved in the AutoCAD system.

1  Windows Standard Behavior

 （Double click editing）

 You can check the double-click behavior in [Customize User Interface (CUI)].

 （Shortcut menus for drawing area） 

 When [On] is selected, a shortcut menu will be displayed by right-clicking. 

 When [Off] is selected, right-clicking is the same as pressing [Enter].

    From this button, you can customize the right-click action.

① Updated when opening a drawing.  
② Updated when saving a drawing. 
③ Updated when printing a drawing. 
④ Updated when creating an e-transmit. 
⑤ Updated when redrawing.

Field background<ON> Field background<OFF>

Sets the background color of the field characters. (The default is<gray>.)

Specify when the drawing is updated when the field is changed.

Specify the thickness of the line. The default value is <0.25>. 
The same dialog can also be displayed by clicking [Home] -> [Properties] -> [Lineweight].

Use the [Show/Hide Lineweight] in the [Status bar] to switch between the two.
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[ Application Menu ] -> [ Options ] -> [ Drafting ]1

 Application Menu  [ Application Menu ] -> Options
 Pulldown menu  [ Tools ] -> Options
 Command  Option

[Options]（Drafting）6

Options (Drafting)Options (Drafting)

[Set editing functions such as AutoSnap and AutoTrack]

1

2 3

1  AutoSnap Settings

 Controls the settings for the display called AutoSnap that is displayed when using Object Snap.

 

　  　This button allows you to change the color of the [AutoSnap Marker].  

　　　　　　　　　　　(Default value is <greenish>)

2  Auto Snap Marker Size

 Specify the display size of the marker with the slider.

 

3  Aperture Size

 Specify the display size of the target box with the slider.

 

[AutoSnap setting]

The target box is the box that appears in the center of the crosshair cursor  

when snapping to an object. 

 

[AutoTrack setting] 

To enable AutoTrack setting, turn on either Polar Tracking or Object Snap Tracking.
The size of the target box determines how close the target box can be to the snap point 

before it is attracted to the snap point.

marker

aperture box
tool tip

You can disable hatching and dimension aid line snapping from Object Snap.

 Marker <Default color: Green>

 Controls the display of the AutoSnap marker.  
 The marker is displayed when the crosshair cursor is moved onto the object’ s snap point.

 Magnet

 When you get close to a snap point, the crosshair cursor will snap to the nearest snap point.

 Diapaly AutoSnap Tool tip

 Controls the display of AutoSnap tooltips. 
 The tooltip is a label that indicates which part of the object is being snapped to.

 Dispaly AutoSnap aperture box

 When on, the AutoSnap target box is displayed. 
 When you snap to an object, it will appear as a dashed line in the center of the crosshair cursor.
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[ Application Menu ] -> [ Options ] -> [ Selection ]1

 Application Menu  [ Application Menu ] -> Options
 Pulldown menu  [ Tools ] -> Options
 Command  Option

[Options]（Selection）7

Options (Selection)Options (Selection)

[Settings for selecting shapes]

1

2

3

1  Pickbox size

 Use the slider to specify the size of the pickbox used to select objects.

 

3  Grip size

 Use the slider to specify the display size of the grip.

 

You can set the method for selecting shapes, the color of the grip when a shape is selected, and 

the behavior of the grip. 

① Specify the size of the pick box when selecting a shape. 

② You can select the method for selecting shapes. 

③ Set the size of the grip that is displayed when a shape is selected. 

　  You can specify the color of the grip from this button.

2  Selection modes

 （Noun/verb selection)

 If you check this box, you can select an object before calling a command,  

 or after calling a command.

 （Use Shift to add selection） 

 When on, hold down the [Shift] key and use the mouse to select objects when adding them.

 （Implied windowing）

 When you click on a point other than an object, a selection window will appear.  

 If you surround the object from left to right in the selection window, the object that is completely  

 contained within the window frame will be selected. If you surround the object from right to left,  

 the object that intersects with the object contained within the window frame will be selected.

 （Window selection method:）

pickbox

grip

Value selection method

 0
 Use two points to specify the selection window. 

 Click on the two corners of the selection window in turn.

 1
 Use click and drag to select a window. 

 Release the mouse button to select.

 2  Use one of the above methods to specify the selection window.

Set the system variable <PickDrag>. 

① [PickDrag = 0] : Click and click 

② [PickDrag = 1] : Press & drag 

③ [PickDrag = 2] : Both - Automatic detection

When you select [Both - Automatic detection], the [Automatic detection] will be turned on. 

The default value is [PickDrag = 2] : Both - Automatic detection.
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 Ribbon Menu  None
 Pulldown menu  [ Format ] -> Drawing Limits
 Command  Limits

Set with the mouse

① Type ‘limits’ from the keyboard.

② Specify lower left corner or [ON/OFF] <0.0000,0.0000>：      
　 Use the mouse to point to P1 (an appropriate position).

③ Specify upper right corner <297,210>:  Type ‘@420,297’ on the keyboard. P2

This is a two-point designation of  
the lower left corner and the upper 
right corner.

The @ symbol is used to indicate the distance from the last dot.

① Type ‘limits’ from the keyboard. 
② Enter the drawing size on the command line (e.g. A3 size)

③ Reset Model space limits:

　 Specify lower left corner or [ON/OFF] <0.0000,0.0000>:    （Accept as is.） 
 

④ Specify upper right corner <594.0000,420.0000>:  Type <420,297> from the keyboard, and  
 
⑤ The entire drawing area is displayed using [ZOOM] command.

Set from the keyboard

[Limits]8

1

2

Drawing Area SettingDrawing Area Setting

[LIMITS] command sets the range of the grid display in the viewport of the current Model 
 or Layout tab.

④ The entire drawing area is displayed using [zoom] command. 

　 ZOOM 
　 Specify corner of window, enter a scale factor (nX or nXP), or

　 [All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>:  a 

The role of [LIMITS]

The role of [LIMITS]

◎ You can display the grid only within  

the [Drawing Area]. 

◎ You can prohibit drawing outside  

the [Drawing Area].　 （Outside limits ）

◎ When printing from [Model 

Space], you can select [LIMITS].

P1

297

420

P2

(0,0)

(420,297)

P1 P2

Hor:420

Ver:297

P1

P2

You can prevent drawing outside the drawing range. 
① Type ‘limits’ from the keyboard. 

② Specify lower left corner or [ON/OFF] <0.0000,0.0000>：  ON 
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① Select [Status bar] -> [Snap mode] -> [Snap settings].

② [Drafting Settings] dialog box will appear. 

③ Check [Snap On]. (Fig.1- 1 )

④ The cursor will be fixed at the <X spacing> and <Y spacing> of [Snap spacing]. (Fig.1- 2 ) 

⑤ Press [OK] button. 

⑥ In the figure below, the Snap is set to ON in the [Drating Settings] dialog box.

A rectangle was drawn along snap spacing.

 Status bar  Snap mode
 Pulldown menu  [ Tools ]  -> Drafing Settings
 System variable  SnapMode   Function key  F9

Drafting Settings [ SnapMode ]

(Fig.1)

Drafting Settings (Snap Settings)Drafting Settings (Grid Settings)

① Select [Status bar] -> [Display drawing grid] -> [Grid settings]. 

② [Drafting Settings] dialog box will appear. 

③ If you check the box for [Grid On], you can specify the (X, Y) values for [Grid spacing]  

　 and [Grid behavior] (Fig.1). 

④ Press [OK] button.

⑤ The grid set in the [Drafting Settings] dialog box is displayed on the screen. (Fig.2)

（Fig.1) Check the [Grid On] and activate [Interval] and [Grid].

To switch the grid display, 
click [Grid] on the status bar. 
You can also change it by 
pressing the F7 function key.

（Fig.2) Grid is displayed in the drawing area.

(Fig.2)

(Fig.1)

 Status bar  Display drawing grid
 Pulldown menu  [ Tools ]  -> Drafing Settings
 システム変数  GridMode  Function key  F7

Drafting Settings [ GridMode ]9 10

1

2

To switch the snap display, 
click [Snap] on the status bar. 
You can also change it by 
pressing the F9 function key.
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 Status bar  Dynamic Input
 Pulldown menu  [ Tools ]  -> Drafing Settings
 System variable  DynMode

Drafting Settings [ DynMode ]11

① Display [Drafting Settings] from [Dynamic Input] in the status bar. 

② Press the [Settings] button to open the [Pointer Input Settings].

③ The left diagram is in [polar format], and the right diagram is in [Cartesian format]. 

　 [polar format] is displayed as [distance < angle] and  

　 [Cartesian format] is displayed as [distance of X, distance of Y].

P1

P2 P3-1

P1

P2

P3-2

Drafting Settings (Dynamic Input) Drafting Settings (Dynamic Input)

When [ Pointer Input A ] is ON.1

When [Dimension Input B ] is ON.2

① [Show only 1 dimension input at a time.] 

　 When stretching an object using the grip editing,  

　 only [Length] input tooltip is displayed.

② [Show 2 dimension input fields at a time.] 

　 When stretching an object using the grip editing,  

　 [Length and Angle] input tooltip will be displayed.

③ [Show the following dimension input fields simultaneously.] 

　 While stretching an object using the  grip editing,  

　 the input tooltip with the following options turned on will be displayed.

Show the following dimension input fields simultaneously.
 Dimension  Displays updated length dimension when the grip is moved.

 Lenbth  Displays updated length change when the grip is moved.

 Absolute Angle  Displays updated angle dimension when the grip is moved.

 Angle Change  Displays updated angle change when the grip is moved.

 Arc Radius  Displays updated arc radius when the grip is moved.

（Fig.1）

（Fig.2）

④ [Relative coordinates] and [Absolute coordinates] 

　 (Fig.1) is [relative coordinates] and (Fig.2) is [absolute coordinates]. 

⑤ If you draw a line from the origin (P1) to (P2) and enter <100,0>  

　 in [relative coordinates], the result is P3-1 in (Fig.1). 

　 Inputting in relative coordinates is the distance from the last point. 

⑥ If you draw a line segment from the origin (P1) to (P2) and enter 　　 

　 <100,0> in [Absolute coordinates], the result is P3-2 in (Fig.2). 

　 Inputting in absolute coordinates is the distance from the origin (0, 0).

1

3

2

A B

A B

 If both A and B  are on, B  has priority.
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Drafting Settings (Polar Tracking)

① Select [Status Bar] -> [Polar Tracking] -> [Tracking Settings]. 

② Select [Polar Tracking] tab in [Drawing Settings] dialog box. 

③ Check the [Polar Tracking ON] box.（Fig.1- 1 ）

④ Check [Additional angles] and enter <30>.（Fig.1- 2 ）

⑤ Press [OK] button. 

⑥ A tracking line is displayed every <30 degrees> of cursor angle.（Fig.2）

（Fig.1）

（Fig.2）

 Status bar  Polar Traking
 Pulldown menu  [ Tools ]  -> Drafing Settings
 System variable  PolarAng  Function key  F10

Drafting Settings  [ PolarAng ]

To switch the polar tracking display,  
click [Tracking Settings] on the status bar. 
You can also change it by  
pressing the F10 function key.

12

 Status bar  Object Snap Traking
 Pulldown menu  [ Tools ]  -> Drafing Settings
 System variable  AutoSnap  Function key  F11

Drafting Settings [ AutoSnap ]13

Drafting Settings (Object Snap Tracking)

[Object Snap Tracking] is used in conjunction with object snaps,  

so you need to set object snap you want to use in advance. 

It cannot be used at the same time as <ORTHOMODE> On.

The combination of [Polar Tracking] and [Object Snap Tracking] is called AutoTrack.

① As shown in the diagram below, a circle (red) is drawn in the center of a rectangle  

　 using object snap tracking.

② From the [Object Snap] in the status bar, check <Center>. 

③ Select [Circle - Center, Radius] and move the mouse to the center of the bottom of the rectangle,  

　 as shown in the diagram on the left. A triangle symbol will appear.(P1)

④ Next, if you move the mouse to the middle of the left side of the rectangle,  

　 a triangle will appear in the same way.(P2)

P1

P2

⑤ When you move the mouse to the center of the rectangle (right diagram),  

　 the text [Midpoint: <0° , Midpoint: <90° ] will appear. 

　 In other words, this point is the center of the circle.

⑦ You can also specify the tracking angle by selecting the default 　

　 value combination displayed above [Tracking Settings].

1

2
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Drafting Settings (Line Weight)Drafting Settings (Ortho Mode)

 Status bar  LWDISPLAY
 Pulldown menu  [ Format ] -> Lineweight
 Command  LWeight

Drafting Settings [ LWeight ]15

① Select a circle as shown in the figure below and display the [Properties] palette. 

② In the [Properties] menu, select Lineweight of <0.3>.

③ When [Lineweight] is set to <Off>, the circle’ s line thickness is not displayed (as shown on the left),  

　 but if you set [Lineweight] in the status bar to <On>,  

　 the circle’ s  line will be displayed thicker (as shown on the right).

 Status bar  ORTHOMODE
 Pulldown menu  None
 System variable  OrthoMode  Function key  F8

Drafting Settings [ OrthoMode ]14

① Set [Status Bar] -> [ORTHOMODEl] to <ON>. 

② Select [Line] from [Draw] panel. 

③ Specify first point:Specify the starting point. (Fig.1) 

④ Specify next point:  Move the mouse horizontally or vertically. (Fig.2) 

⑤ Enter the distance from the keyboard. (Fig.3)　No need to specify the angle. 

⑥ Horizontal and vertical lines are created. (Fig.4)

Create horizontal and vertical line segments1

(Fig.1) (Fig.2)

(Fig.3) (Fig.4)

Create a vertical line perpendicular to a diagonal line2
① Select [Tools] -> [New UCS] -> [Object]. (Fig.1) 

② Set [Status Bar] -> [ORTHOMODE] to <ON>. 

③ Select [Draw] panel-> Line. 

④ Specify first point:  Specify on line (P1). 

⑤ Specify next point:  Move the mouse to a right angle. 

⑥ A line perpendicular to the oblique line is created.(Fig.2)

⑦ Go to [Tools] -> [New UCS] -> [World] to return to WCS.

(Fig.1)

(Fig.2)

P1
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Drafting Settings [ TransparencyDisplay ]16

Drafting Settings (Transparency)Drafting Settings (Transparency)

 Status bar  TRANSPARENCYDISPLAY
 Pulldown menu  [ Format ] -> Transparency
 System variable  TransparencyDisplay

① [Status bar] -> [Transparency] to <ON>. 

② Select the filled-in floor pattern for the floor. (Fig.1) 

③ Set the value of [Hatch Transparency] in [Properties] tab to <80>. (Fig.2) 

④ The color of the filled-in floor pattern has faded. (Fig.3)

Set transparency for an object1

① In [Layer Properties], create new layer names [hatch1] and [hatch2]. 

② Set  [transparency] of [hatch1] to <0> and [transparency] of [hatch2] to <80>. 

③ Apply a gradient to the left floor using [hatch1] layer. (Fig. 1) 

④ Apply a gradient to the right floor using the [hatch2] layer. (Fig.2) 

⑤ Both of these images have the same gradient color, but the transparency of the color is different.

Set transparency for a layer2

(Fig.1)

(Fig.3)

(Fig.2) (Fig.1) (Fig.2)

⑥ Even if you apply a gradient to a layer with transparency, you can change it later.

　 The right of the image below, the transparency of [hatch2] layer was changed to <20>.

You can also change the transparency  
by selecting the gradient shape  
from [Properties] panel.
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Drafting Settings [ SelectionCycling ]17

Drafting Settings（Quick Properties）Drafting Settings（SelectionCycling）

 Status bar  SELECTIONCYCLING
 Pulldown menu  [ Tools ]  -> Drafing Settings
 System variable  SelectionCycling

 Status bar  Quick Properties
 Pulldown menu  [ Tools ]  -> Drafing Settings
 System variable  Qpmode

Drafting Settings [ Qpmode ]18

[Quick Properties] settings2
① [Quick Properties] settings can be made from [Status Bar] -> [Quick Properties]. 

　  Press the right button in [Quick Properties] and select [Quick Properties Settings].

[Quick Properties] settings

1
 [Display the Quick Properties Pallette]
 Select whether or not to display the palette 
 when an object is selected.

2
 [Palette Display]
 Specify whether or not to display the palette 
 for all objects.

3
 [Palette Location]
 Specify whether the palette to be displayed   
 is [cursor position] or [fixed].

4
 [Palette behavior]
 Specify the number of properties to display 
 on the palette (the default is 3 lines).

Enable [Quick Properties]1
① [Status bar] -> [Quick Properties] to <ON>. 

② When you select an object, the shape information is displayed in [Quick Properties] palette.
① [Modify] panel-> [Erase]

② Erase the red line (base line). (Fig.1)

Retrieve the object you want to select from the overlapping objects1
(Fig.1)

(Fig.2)

(Fig.3)

(Fig.4)

③ When you move the mouse closer,  

　 a picture with multiple objects ( ) will be displayed. 

　 (Fig.2)

④ Clicking on the mouse will display the overlapping 

　 objects. (Fig.3)

⑤ Select the object you want to erase with mouse. 

　 (Select the base line <red line>.)

⑥ Only the selected line was erased.(Fig.4)

If the objects are not overlapping, 

this picture ( )will not be displayed.

3

4

1

2



96 97

Chapter 3 【Drawing Settings】 Chapter 3 【Drawing Settings】

D
ra

w
in

g 
Se

tt
in

gs

D
ra

w
in

g 
Se

tt
in

gs

④ To change the color, click on the color box to display the [Select Color] panel.

⑤ Select <red> from [Index Color] and press the OK button. 

⑥ Set the line type of [Layer<Layer 1>] to <dotted line>. 

　 If there is no line type in [Loaded linetypes],  

　 click the [Load] button to import the required line type.

⑦ From the [Load or Reload linetypes] panel, select <CENTER> and click the [OK] button. 

　 Then, from the [Select Linetypes] panel that appears, select the <CENTER> you just loaded.

① If you select [Layers] Panel -> [Layer Properties ], the [Layer Properties Manager] dialog box  

　 will appear. (There is only one layer named <0>.)

Create a new layer

② Pressing the [New Layer] button in the dialog box will create <Layer1>.

③ You can change the [name], [color], [line thickness], [line type], etc. of the layer. 

　 To change an item, click on the item you want to change.

1

 Ribbon Menu  [ Home ] tab -> [ Layers ] panel -> Layer Properties
 Pulldown menu  [ Format ] -> Layer
 Command  Layer

Layer Properties [Layer]

Layer PropertiesLayer Properties

19
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Change the layer name (e.g. change <Layer1> to <Center>)

① Right-click on the text for the layer name <Layer1>. 

　 Select [Rename Layer] from the shortcut menu and change it to <Center>.

Delete layer name (e.g. delete <Center>)

① Right-click on the name of the layer <Center> and select [Delete Layer] from the shortcut menu. 

　 (If there are objects in that layer, they cannot be deleted.)

3

2

Layer PropertiesLayer Properties

Layer [ON] and [OFF]

Layer [Lock] and [Unlock]5

4
① In the left image, the [Dim] layer is displayed, but in the right image, it is not displayed.    

　 Layers that are not displayed cannot be manipulated with mouse, and will not be printed.

① In the left image, the [Dim] layer is unlocked, but in the right image, it is locked. 

　 The locked layer is displayed, but it cannot be operated with mouse. However, it can be printed.

Layer [printable] and [not printable]6
① If you set [Plot] in [Layer Properties Manager] to <OFF>,  

　 the image will not be printed even if it is displayed on the screen.

The color of the rock layer is displayed in light colors.

There are two ways to delete a layer with objects.

1  Merge  Combines the selected layer with another layer.
2  Delete  Deletes all objects in the selected layer and deletes the layer itself.

1 2
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Setting [Current object scale]

Setting [Global scale factor]
① In [Properties] panel, select [Linetype]. 
② [Linetype Manager] dialog box will appear. 

③ Set [Global scale factor] value to <100> (normally, specify the reciprocal of the print scale.  1  2 ) 
　 The distance between all linetypes is displayed as <100> times the initial value.

① Set [Current object scale] value to<2>. From now on, the distance between the selected linetypes 　

　 will be<2> times the current value. (If [Global scale factor] is<100>, it will be 200 times.)

2

Linetype Manager [Linetype]

Linetype

 Ribbon Menu  [ Home ] tab -> [ Properties ] panel -> Linetype
 Pulldown menu  [ Format ] -> Linetype
 Command  Linetype

Linetype Manager

③ Press [Load] button in the upper right of the [Linetype Manager] dialog box.　  
　 Select the line type name <CENTER> and press [OK] button.

Set Linetype

④ To delete a line type that has been imported 
　 into a drawing,  
　 you will need to press [Delete] button,  
　 but if that line type is being used,  
　 it cannot be deleted.

① In [Properties] panel, select [Linetype]. 
② [Linetype Manager] dialog box will appear.

1

[Linetype]

⑤ You can also delete linetype using [delete name<purge>] command.

20

 Ribbon Menu  [ Home ] tab -> [ Properties ] panel -> Linetype
 Pulldown menu  [ Format ] -> Linetype
 Command  Linetype

21

1

1
2

When printing in model 
space at 1/100 scale. 
1  Set [Global scale factor] 
to around 100.  
Uncheck 2 .

When printing in layout 
space. 
1  Set [Global linetype 
scale] to 1. 
2  Check the box.

1
2
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① Select [Application Menu] -> [Drawing Utilities] -> [Units]. 

② [Drawing Units] dialog box appears. 

③ From [Type] section, select <Decimal>.

Set the Angle of [Drawing Units]Set the length of [Drawing Units]

① Select [Application Menu] -> [Drawing Utilities] -> [Units]. 

② [Drawing Units] dialog box appears. 

③ From [Type] section, select <Decimal Degrees>.

1 1

Drawing Units (Angle)

Drawing Units (Angle)

[Insertion scale]

23

Drawing Units (Length)

Drawing Units (Length)22

 Application Menu  [ Application Menu ] -> [ Drawing Utilities ] -> Units
 Pulldown menu  [ Format ] -> Units
 Command  Units

1 Application Menu  [ Application Menu ] -> [ Drawing Utilities ] -> Units
 Pulldown menu  [ Format ] -> Units
 Command  Units

[Precision]

[Type]

⑤ Confirm that [Insertion scale] is in <Millimeters>.

④ Select <0.00> for [Precision]  

　 (up to two decimal places are displayed).　  

　 Set the number of decimal places to display the length.

④ Select <0.00> for [Precision]  

　 (up to two decimal places are displayed).　  

　 Set the number of decimal places to display the angle.　

⑤ Make sure that there is no check in [Clockwise] box.

[Type]

[Precision]

[Clockwise]

In CAD, [counterclockwise] is a positive angle.

Length unit setting　                  　　         Sample

　1 = Architectural  　　　　　　　　　3.25E + 01 

　2 = Decimal   　　　　　　　　　　　 25.80 

　3 = Engineering      　　　　　　　      2' - 2.50" 

　4 = Fractional                                               2' - 2  1/2" 

　5 = Scientific    　　　　　　　               2   1/2

Controls the scale of the block to be inserted into the current 

drawing and the scale of the drawing. 

When a block or drawing is inserted that has been created  

using a different unit of measurement to that used  

in the current drawing,  

the discrepancy is corrected using the insertion scale value.

When you set the display precision for a unit, the displayed value 

will be rounded to the specified precision level. 

However, the actual precision of coordinates and distances  

will be retained, regardless of the display precision.

Length unit setting　                  　　         Sample

　　0 = Decimal Degrees    　　　　　　　35.00 

    　1 = Deg/Min/Sec    　　　　　　　　 45d0'0" 

    　2 = Grads               　　　　　　　　　60.00g 

    　3 = Radians   　　　　　　　　　　　0.785398r 

    　4 = Surveyor’ s Units　　　　　　　　N 45d0'0" 

No = Angle is measured counterclockwise. <Default> 

Yes = Angle is measured clockwise.

When you set the display precision for a unit, the displayed 

value will be rounded to the specified precision level. 

However, the actual precision of coordinates and distances  

will be retained, regardless of the display precision.
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① Select the arrow in the lower right corner of the [Text] panel in the [Annotate] tab. 

② [Text Style] dialog box will appear. （Fig.1）

③ The default value for [Current text style] is <Standard>. 

④ To create a new font style, press [New].（Fig.1）

⑤ Select a font with a height of<0> and a big font<extfont2.shx>. （Fig.2）

　 If you set the character height to <0>, you can change the size of the characters as you type. 

　 If you specify <extfont2.shx> for [Big Font], you will be able to input Japanese.　　

Text Style [Style]

Text Style

Setting Text Style (Bigfont <Japanese font>)1

 Ribbon Menu  [ Annotation ] Tab -> [ Text ] Panel -> Text Style
 Pulldown menu  [ Format ] -> Text Style
 Command  Style

24

If you set the text height to 
<0> in text style, you can 
specify the character height 
for each input. 
Otherwise, the text height of 
the current style will be given 
priority.

（Fig.1）

（Fig.2）

To delete a character style, 
select the text style you want 
to delete and click [Delete] 
button. 
However, you cannot delete  
a character style if it is in use.

⑦ If text you enter is displayed as <?> as shown in the figure on the left,  

 　it is because the text style is not in Japanese format.

⑧ If you change [Text Style] in [Properties] of [Home] Tab, Japanese will be displayed. 

　 (Change the text style from < ⑤ to ⑥ >.)

⑥ If you select <Gothic> or <Mincho> for [Font Name], you can use TrueType text.  （Fig.3）

（Fig.3）

SHX Font(alphanumeric) SHX Font(Kanji) TrueType Font

5 6

Text Style
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① Select the arrow in the lower right corner of [Dimensions] panel in [Annotation] tab. 

② [Dimension Style Manager] dialog box will appear.（Fig.1）

 　 The default dimension style names are [Annotative], [ISO-25], and [Standard]. 

③ Press [New] button to create a new dimension style.（<Archi>）

Create a new [Dimension Style]

（Fig.1）

Setting dimension lines

① Select [Lines] tab.（Fig.2） 

② Set [Baseline spacing] to<5>.（Fig.2-1<A>）（Specifies the print size.）

③ Set [Extend beyond dim lines] to<1>.（Fig.2-1<B>）（Specifies the print size.）

④ Set [Offset from Origin] to<1>.（Fig.2-1 の <C>）（Specifies the print size.）

（Fig.2）

A
B

C

（Fig.2-1）

1

2

 Ribbon Menu  [ Annotation ] Tab -> [ Dimensions ] Panel -> Dimension Style
 Pulldown menu  [ Format ] -> Dimension Style
 Command  DimStyle

Dimension Style Manager [DimStyle]

Dimension Style ManagerDimension Style Manager

① Select [Symbols and Arrows] tab.（Fig.3）

② From [Arrowheads], select <Open 30>. 

③ Specify [Arrow size] (specify the size when printing).

Setting Symbols and Arrows325

（Fig.3）

[Dimension Break] 

When dimension auxiliary lines intersect, 

cut a portion of one of auxiliary lines. 

Specify the width of the cut.

Setting Dimension Text

① Select [Text] tab. （Fig.4）

② Set [Text appearance] <Default value>：ISO-25（Changed to <Archi>.）

③ Set [Text Height]. <Default value>：2.5（Specifies the print size.）

4

（Fig.4）

1

2

3

3

1 2

(Text alignment <Aligned>)

(Text alignment <Radius>)

1 2
3

A

B
C
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① Select [Tolerances] tab.（Fig.7） 

② Add a tolerance in [Tolerance] tab. 

③ From [Tolerance format] section,  

　 enter [Method],[Precision], [Upper value] 

　 and  [Lower value].

Setting dimension values and arrows

① Select [Fit] tab.（Fig.5） 

Check [Scale for dimension features]. 

② Decide [Fit options] and [Text placement].

③ In [Scale of dimension figures], if you are 　

　 not using Annotative, enter the reciprocal  

　 of the scale you want to print. 

　 If you want to print at 1/100 in model 　   

　 space, set the scale to <100>. 

　 If you want to print at 1/1 in layout space, 

　 set the scale to <1>.　

Setting Primary Units

① Select [Primary Units] tab.（Fig.6） 

　 Decide how to display [length] and [angle].

② Enter<0> for the accuracy of the [linear 　

　 dimensions]. 

③ In [Zero suppression], check <Trailing>. 

④ In [Angular dimensions], set [Units format] 

to <Decrimal Degrees> and Precision to <0>. 

⑤ If you set the [Linear dimensions] to 　　　

　 [Windows Desktop], the decimal point will 

　 be displayed as <.>.

Setting Tolerances

5

6

7

Multileader Style ManagerDimension Style Manager

Setting Multileader1

 Ribbon Menu  [ Annotation ] Tab -> [ Leaders ] Panel -> Multileader Style Manager
 Pulldown menu  [ Format ] -> Multileader Style
 Command  Mleaderstyle

Multileader Style Manager [Mleaderstyle]26

When the precision of [Linear dimensions] is set to <0>, the first decimal place is rounded off.

When the [Upper value] and [Lower 

value] are the same value, the ± symbol 

is displayed before the dimensional 

tolerance value.

（Fig.5）

（Fig.6）

（Fig.7）

① Select the arrow in the lower right corner  

　 of the panel. 

　（Dialog Box Launcher）

② [Multileader Style Manager] dialog box will 

　 appear. 

③ To create a new multileader style,  

　 click this button.   

④ Enter the name of new multileader style 

　 in the “New style name” box and click this 

　 button.   

⑤ To edit an existing leader style, 

　 click the [Modify] button and edit items  

　 in the [Modify Multileader Style] dialog.

Check when making it [Annotative].

[Modify Multileader Style] Settings 

1  Leader format 
2  Leader Structure 
3  Content

1 2 3
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(Structure)

1

2 3

(Format)

(Content)

Setting Color

① Select [Home] tab -> [Properties] panel -> [Object Color]. 

② If you select [More Colors] at the bottom, [Select Color] panel will appear.（Fig.1） 

③ In [AutoCAD Color Index], 1 you can select Index Color numbered 10 to 249. 

④ If you select color numbers 1 to 9 in [second palette] 2 , the color name or color number  

　 will be displayed in the [Color] box. 

⑤ [third palette] 3  Gray colors are color numbers 250 to 255. 

⑥ [ByLayer] or [ByBlock] 4  

　 [ByLayer] assigns the color of the layer on which the object is drawn. 

　 [ByBlock] draws new objects in the default color until they are grouped as a block.  

　 When the block is inserted into a drawing, it is drawn in the specified color. 

⑦ In [Select Color] tab (Fig. 2), you can specify colors other than the 255 colors.

　 Select [HSL] or [RGB] from [True Color], and either select a color from the screen  

　 or enter a color number in the [RGB Color] box at the bottom. 

⑧ [Color Books] tab (Fig. 3) allows you to use [.acb format] color book files.

1

Object Color [Color]

Object ColorMultileader Style Manager

27

1 Ribbon Menu  [ Home ] tab -> [ Properties ] panel -> Object Color
 Pulldown menu  [ Format ] -> Color
 Command  Color

⑥ There are three properties for multileader.

①
 [Leader format]
 Specify the type and size of the arrow or multileader.

②
 [Leader Structure]
 Set the angle of multileader and Leader Structure.

③
 [Content]
 Specify the type to attach to multileader.

⑦ There are three types of content.

①

[Block]
Specify default blocks such as circles, slot, and triangle. 

You can also specify blocks with attributes.

②
[Mtext]
[Text Editor] will appear. (see below)

③
[None]
Only the Leader Structure is displayed.

（Fig.1）

3
4

1

2

1

2

3

（Fig.2）

（Fig.3）

(Structure)

(Format)
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 Ribbon Menu  [ Output ] tab -> [ Plot ] panel -> Page Setup Management
 Pulldown menu  [ File ]  -> Page Setup Manager
 Command  PageSetup

[PageSetup]

① If you select [Page Setup Manager] from [Model] tab, you can set the page settings for [Model Space].

② If you select [Page Setup Manager] from the [Layout] tab,  

　 you can set the page settings for [Layout Space]. 

③ Both are the same screen, but they are saved separately for [Model Space] and [Layout Space].

[Page Setup Manager]1

① From [Page Setup Manager] dialog, select [New]. (See the image on the left.) 

② In the [New Page Setup] dialog, enter [A3PDF] as the new setup name and click the [OK] button.

Page setup for [Layout Space] (the same for [Model Space])2

From [Page Setup Manager] you can set the printer, paper size, scale, etc. 

These settings are saved in [Page setups]. 

 

[Layout] and [Model] tab page settings are managed separately. 

When printing in Model space, use [Page setups] for Model space, and when printing in Layout space,  

use  [Page setups] for Layout space. The creation method for both is the same.

Page Setup for [Model space] Page Setup for [Layout Space]

③ Make the same settings as in [Plot] on the next page and save them. 

（ 1 ~ 5  correspond to the numbers on the next page.）

④ [Plot] panel -> [Plot] displays [Plot] dialog box. 

　 If you select <A3PDF> from [Name] in [Page setup], the pre-set print settings will be displayed.

Page SetupPage Setup

28

3

4

5

1

2
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Setting Plot

① [Printer/Plotter] - Select the printer to use and the paper size. 

　 Select the printer and PDF to output. 

　 In the figure below, AutoCAD PDF is selected from the list of [Name].　

Decide the size of the paper. 
Select the size of the paper from the list of [Paper size] .

The other items determine the layout (portrait or landscape) and number of copies to be printed.

② [Plot area] - Set the print range. 

　 Select <Display>, <Extents>, <Limits>, or <Window> from [Plot area].

Use the mouse to select P1-P2.

Select <Display> in [Plot area].

Select <Window> to enclose the print range.

1

 Ribbon Menu  [ Output ] tab -> [ Plot ] panel -> Plot
 Pulldown menu  [ File ]  -> Plot
 Command  Plot

[Plot]

PlotPlot

29

P1

P2

×

×

Only the area enclosed by the mouse will be printed.
P1

P2

 Display  The area displayed on the screen will be printed.
 Extents  Prints the entire drawing .

 Limits
 The drawing range set in [Format] -> [Drawing Limits] 
 will be printed.

 Window  The area enclosed by mouse will be printed.

The displayed area will be printed.

4

1

2

3
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③ [Plot offset] - Set the print position of the drawing 

　 If you check <Center the plot>, the drawing will be printed so that it is centered on the paper.

④ [Plot scale]・・Setting the scale for printing drawings

[1/1]・・Printed at actual size.[1/100]・・Printed on a 1:100 scale.

Print in layout space<1:1>Print in model space<1:100>.

Plot

Plot area
 [Model] and [Layout] are the same
 Extens  Prints the entire drawing .
 Window  The area enclosed by mouse will be printed.
 Display  The area displayed on the screen will be printed.
 [Model]
 Limits  Print the range set in LIMITS．
 [Layout]
 Layout  Print the area placed in the layout．

 Check [Fit to paper].
 Prints to fit the specified paper size without considering  
 the scale. The scale is set automatically.

 Uncheck [Fit to paper].
 Specify the scale. Select a scale from the list of scales,  
 or enter a scale using keyboard.

What are the ways to find out information         
about the shapes you have created, such as their area?
How do you search for and register shapes?

In this chapter,
we will learn how to obtain information about drawings 
and shapes.

Chapter 4  Drawing Management

Section 1 Drawing Management

Section 2 Figure Information

Section 3 DWG Compare



118 119

Chapter 4 【Drawing Management】 Chapter 4 【Drawing Management】

D
ra

w
in

g 
M

an
ag

em
en

t

D
ra

w
in

g 
M

an
ag

em
en

t

（Sample)Select circles with the specified radius

Select [Utility] panel -> [Quick Select]. 
You can easily obtain the desired objects.

① Select an object by specifying it from [Entire drawing] or by clicking this button (red circle).

② If you select [Entire drawing], you can choose from the [Object type].

　 Press the button to select a object from the drawing. 

　 In the figure on the right, [Text] is selected from  

     the [Object type]

③ Select the object’ s attributes from the [Properties]menu  

     to narrow down the search.

④ Choose condition such as (= Equals), (<> Not Equal), (Select All) from [Operator].

⑤ Select from the [Value] options or enter a numerical value.

⑥ Decide whether to include the selected objects in the selection set or create a new one.

① Select circles with a radius of<7> or less. 
　 For [Object type], select (circle), for [Properties], select (radius), for [Operator], select (< less than), 
     and for [Value], select (7).

② As shown in the figure on the right,  
     the <R6> and <R3> circles have been selected.

2

 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> Quick Select
 Pulldown menu  [ Tools ] -> Quick Select
 Command  Qselect

Quick Select [Qselect]1

Quick SelectQuick Select

1

The combination of ②③④⑤ will narrow down  

[Text] with [layer] of <0>.

Choose whether to include it in an existing 

selection set or create a new selection set.Use [Quick Select]

Items for extracting the target objects
1  Apply to [Entire drawing]

2  Select the Object type

3  Select the object’ s properties

4  Select the operator ( = , <> , > ,< , all)

5  Select a value

6  Whether to make it a new selection set

This is a specification for whether the item in 

question is [Equals], [Not Equal], [Greater than], or 

[Less than] the item in question.

Only the objects in the drawing 

will be displayed.

You cannot select multiple options.

4
5

6

1
2

3

Section 1 Figure Management
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Point!

Quick Properties [Qpmode]2

Quick PropertiesQuick Properties

 Status bar  Quick Properties
 Pulldown menu  None
 System variable  Qpmode

[Status bar] -> [Quick Properties] is OFF

① Select the object and choose [Quick Properties] from the right-button shortcut. 

　 The information for the selected object is displayed in [Quick Properties] palette.

1

② Double-clicking on an object will also display the [Quick Properties] palette. 

　With one click, only the basic information is displayed. (See the figure below.)

[Status bar] -> [Quick Properties] is ON2

Customize [Quick Properties]3

① Simply select an object and [Quick Properties] palette will automatically appear.

① You can customize [Quick Properties] palette by clicking [CUI] button  

      in the top right corner.

Customize [Quick Properties]
1 Select [Quick Properties] from [All Customization Files]. 

2 Select the object type (e.g. circle) whose properties you want to change. 

3 Choose the items to display in the [Properties] palette.

It will also be displayed when 

you simply hover the mouse 

over the object.

3

1 2
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Similar Objects [SelectSimilar]3

 Ribbon Menu  None
 Pulldown menu  None
 Command  SelectSimilar

Display / Hide Selections [IsolateObjects][HideObjects]4

 Ribbon Menu  None
 Pulldown menu  [ Tools ] -> Isolate
 Command  IsolateObjects、HideObjects

Display / Hide SelectionsSimilar Objects

Creates a selection set of [Similar Objects] for the selected shape

① Type [selectsimilar] on the keyboard. 

② Select objects or [SEttings]:  Select one dimension (S1). (Fig.1) 

③ All dimensions in the drawing will be selected. (Fig.2)

1

(Fig.1) (Fig.2)

Setting of [Similar Objects]

① Type [selectsimilar] on the keyboard. 

② Select objects or [SEttings]:  Type <SE> on the keyboard. 

　 Alternatively, press the right mouse button and select [SEttings] from the shortcut menu. 

③ [Select Similar Settings] panel will appear. 

　 In [Similar Based On], you can specify [Color], [Layer], [Linetype], [Linetype scale], [Lineweight], 

     [Plot style], [Object style], and [Name], in addition to objects of the same type.

2

If you select no properties in [Select Similar Settings] section, 

objects of the same type will be selected.

S1

Hide the shapes in [Similar Objects] selection set

① Select [Tools] -> [Isolate] -> [Hide Objects] from the pull-down menu. 

　 Alternatively, you can use the shortcut [Isolate] -> [Hide Objects] with the right mouse button. 

1

Re-display hidden objects

① Select [Tools] -> [Isolate] -> [End Object Isolation] from the pull-down menu. 

　 Alternatively, you can select [End Object Isolation] from the right-click shortcut menu. 

② The dimension objects that was hidden (Fig. 3) will be redisplayed. (Fig.4)

2

② The selected objects (dimensions in Fig. 1) will be hidden. (Fig.2)

(Fig.1) (Fig.2)

(Fig.3) (Fig.4)
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The information displayed will differ depending on the selected shape

① Select [Palettes] panel -> [Properties]. 

　 The panel in (Fig. 1) will be displayed, but if no shape is selected, it will say “No selection” .

② When only one shape is selected, the information for that single shape is displayed.(Fig.2)

　 When multiple shapes are selected, the number of selected shapes and common information  

     will be displayed.(Fig.3)

1

 Ribbon Menu  [ View ] tab -> [ Palettes ] panel -> Properties
 Pulldown menu  [ Tools ] -> [ Palettes ] -> Properties
 Command  Properties

Properties Palette [Properties]5

Properties PaletteProperties Palette

(Fig.1)

(Fig.2) (Fig.3)

① Using [Properties] panel, select circles with radius <10> and radius <8>. (Fig.1) 
② In [Properties] panel, change the Radius to <5>. 
　 As shown in (Fig. 2), the two circles have been modified.  
     (Dimension values are changed at the same time.)

Change selected shapes

(Fig.3) (Fig.4)

③ Press [Quick Select] button in [Properties] panel (Fig. 3)  
     to display the [Quick Select] dialog. (Fig.4) 
　 Multiple conditions can be specified, making it easy to obtain the desired objects.

2

(Fig.2)(Fig.1)

In the example above,  
select all the objects in [Entire drawing] with 
[Color] as [Bylayer].
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Use blocks and commands in [Tool Palette]

① Select [Palettes] panel -> [Tool Palettes]. 
　 A list of group names and icons will be displayed in [Tool Palettes]. 
② Select the icon on [Tool Palettes] using the left mouse button. 
③ Select the car block as shown in the figure below,  
　 and drag it within the drawing while holding down the left mouse button.

① In [Tool Palettes] area, press the right mouse button. 
　 Next, select [New Palette] from the shortcut menu. (Fig.1)
② Enter the name for a new palette as <BLOCK>. (Fig.2)

Register blocks in [Tool Palettes]

③ Select the block you want to register,  
　 and then select [Clipboard] -> [Copy] from the right-click menu.　 
　 Next, in the tool palette, select [Paste] from the right-click menu. (Fig.3) 
④ The block will be registered in the block palette. (Fig.4) 
　 (The block shape and name will be registered in the [Blocks] tab of [Tool Palettes].)

(Fig.1)

(Fig.2)

(Fig.3) (Fig.4)

1

3

 Ribbon Menu  [ View ] tab -> [ Palettes] panel -> Tool Palettes
 Pulldown menu  [ Tools ] -> [ Palettes ] -> Tool Palettes
 Command  Toolparettes

Tool Palettes [Toolparettes]6

Tool PalettesTool Palettes

① You can set the properties of blocks and other items you have added to the palettes.
　 Right-clicking on the block diagram will display [Tool Properties].

In the [Tool Palettes], 
you can register objects such as 
blocks, hatching,tables, dimension, 
etc. as well as non-objects such as 
commands.

Set the contents properties2

Block (Car) Properties Table Properties Hatching Properties
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Point!

Register blocks from other drawings in [Tool Palettes] from [DesignCenter]1
① A new palette is created in [Tool Palettes]  
　 for registering from other drawings. (Block) 
 
② [Pallets] panel -> [DesignCenter] is opened.

③ Open another drawing and select the Blocks item. 
　 A list of the blocks registered in that drawing will be 　
　 displayed.

④ Select the block you want to add to [Tool Palettes],  
　 and drag and drop it into [Tool Palettes].

⑤ In this way, you can use [DesignCenter] to 
　 create a library of blocks.

 Ribbon Menu  [ View ] tab -> [ Palettes ] panel -> DesignCenter
 Pulldown menu  [ Tools ] -> [ Palettes ] -> DesignCenter
 Command  Adcenter

Design Center [Adcenter]7

Inserting blocks from other drawings into the current drawing from [DesignCenter]2

① Just like [Tool Palettes], you can also insert 　 
　 blocks from other drawings directly into  
　 the current drawing from [DesignCenter]. 
 
② Select a block in another drawing and drag 
　 and drop it into the current drawing.

Inserting the dimension style of another drawing from [DesignCenter]3
① Even if the current drawing does not have a [dimension style] registered,  
　 you can copy the dimension style from another drawing in [Design Center]. 
 
② There are three types of dimension styles in the current drawing. The dimension style<archi> of 　
　 another drawing from [ DesignCenter] will be inserted into the current drawing.

③ If you look at [Dimension Style Manager] of the current drawing,  
　 you will see that the dimension style for <archi> has been added.

Design CenterDesign Center

You can also insert non-objects  
such as [dimension styles] and 
[text styles] in addition to [blocks].

In addition to objects such as blocks from other drawings, you can also insert and use  
non-objects such as layers and text styles in the current drawing from [DesignCenter].

Inserting layers Inserting text styles



130 131

Chapter 4 【Drawing Management】 Chapter 4 【Drawing Management】

D
ra

w
in

g 
M

an
ag

em
en

t

D
ra

w
in

g 
M

an
ag

em
en

t

 Ribbon Menu  [ View ] tab -> [ Palettes ] panel -> External References Palette
 Pulldown menu  [ Tools ] -> [ Palettes ] -> External References
 Command  ExternalReferences

External References palette [ExternalReferences]8

Show [External References Palette]

① Select [External References Palette] to insert the drawing by reference.

1

Attaches a reference drawing

① Select the type to [attach].

2

1

 [Attach DWG]
 [Attach Image] 
 [Attach DWF] 
 [Attach DGN] 
 [Attach PDF]

 Choose the file type to insert as a reference．

2  Reference  The attached file name is displayed.
3  Status  The status of the attachment is displayed.（Attach, Load, etc.)
4  Size  Shows the size of the attached file.
5  Type  This indicates [Attach] or [Overlay].
6  Date  Displays the date the attached file was created.
7  Found At  The folder that contains the reference drawing is displayed.
8  Saved Path  This describes the path to the folder containing the imported drawing.

1  Name  Specify the drawing to attach.
2  Pathtype  Specify whether to use an absolute or relative path.
3  Reference Type  Select [Attachment] or [Overlay].
4  Scale  Specify the scale. Default is (1:1)
5  Insertion point  Specify the insertion position. Default is (0,0)
6  Rotation  Specify the rotation angle. Default is (0° ).

② An external drawing file has been inserted as a <reference drawing> within the current drawing. 

　 You can check this by the text <loaded> in the command line.

④ [Attach] does not become part of the inserted drawing.  
　 In addition, only the text information <drawing name and path information> is saved for [Overlay].

③ Attached drawing is displayed in light colors.

External References paletteExternal References palette

3

4

5

6

1

2

1
3
4
5
6

2

7
8
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CountCount

 Ribbon Menu  [ View ] tab -> [ Palettes ] panel -> Count
 Pulldown menu  None
 Command  Count

[Count]

Count the number of blocks in the drawing1

9

[Count] toolbar2

When you add or delete blocks, the numbers in the table will also change.4

① In [Pallettes] panel, choose [Count]. 

② A list of the names and quantities of the blocks in the drawing is displayed in [Count] palette.  1

③ When you select one of the blocks, it will be highlighted.  2  
④ [Count] toolbar will appear at the top of the drawing area.  3

3

1  Number of counts  Displays the number of selected objects.
2  Details of the count  Displays the count information for selected object.
3  [Previous] or [Next]  The objects are zoomed in on in order.
4  Specify Area  Counts the number of objects in the specified area.
5  Select Counted  Select the objects to be included in the count.
6  Insert Count Field  The current count value is inserted as a field object in the drawing.
7  End Count  Close [Count] toolbar to end the count.

1 3 6 72

2

3

1

① We will erase one [aw1].  1  

② The values in [Count] palette will change.  2

③ When <regen> is executed, the numbers in the table are also changed. 3

2

2

1

4 5

Insert a table the number of blocks selected3

2

3

1

① When you click the [Insert] button, a table is created for the object selected in [Count] palette. 

② Select the blocks you want to include in the table.  1

③ Press [Insert] button to insert a table into the drawing.  2  
④ A table of block names and quantities will be inserted at the position specified by the mouse.  3

1
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Grouping multiple objects into one group1

 Ribbon Menu  [ Home ] tab -> [ Groups ] panel -> Group
 Pulldown menu  [ Tools ] -> Group
 Command  Group

Group [Group]

① Select [Groups] Panel ->[Group]. 

② Select objects or [Name/Description]:   

　 Select P1-P2 by surrounding them with the mouse. 

③ Unnamed group has been created. 

　 The selected shapes have been grouped together.

P2

P1

Selecting a group shape with [move] command2
① Select [Modify] -> [Move]. 

② Select objects:  Select a set of furniture. 

③ Select objects:    

　 Like the diagram on the right, you can select a group<furniture>  

　 at a time.

Ungroup from group3

① Select [Groups] Panel -> [Ungroup].  

② Select group or [Name]:  Select the group<furniture>. 

③ Group exploded. 

　 The group <furniture> has now been ungrouped.

 Ribbon Menu  [ Home ] tab -> [ Groups ] panel -> Group Manager
 Pulldown menu  [ Tools ] -> Group
 Command  ClassicGroup

Group Manager [ClassicGroup]

Group ManagerGroup

Point!

If you do not give a name in the above ② ,  
AutoCAD will automatically give a name.  
(*A1, *A2, *A3, etc.)

Name multiple objects to make a group1

11

Set [Group Selection On/Off] to [On].

① Select [Groups] Panel ->[Group]. 

② Select objects or [Name/Description]:    

　 Type <N> on the keyboard. 

③ Enter a group name or [?]:  Type <table>. 

④ Select objects or [Name/Description]: 

　 Type <D> on the keyboard. 

⑤ Enter a group description: Type <office use>. 

⑥ Select objects or [Name/Description]:    

　 Select P1-P2 by surrounding them with the mouse.

P2

P1

① Select [Groups] Panel -> [Group Manager].  

② When creating a new group, enter a name in [Group Name:] field. (e.g. table) 2

⑤ To ungroup the group, click the [Explode] button. 5

Use [Group Manager]2

10

1

3

2

③ When you select the object you want to group  

　  by clicking [New<] button, 3  

　  it will appear in  [Group Name] box. 1  

④ You can remove or add groups by clicking [Remove<] 

　  or [Add<] buttons. 4

4
5
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DrawOrder [DrawOrder] [TextToFront][HatchToBack]

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> DRAWORDER
 Pulldown menu  [ Tools ] -> DrawOrder
 Command  DrawOrder、TextToFront、HatchToBack

Controls the draw order of overlapping objects1
 Bring to the front DrawOrder

 The selected object will be bringed to  
 the front of all other objects in the drawing. 

 Send to Back DrawOrder

 The selected object will be sended to  
 the back of all other objects in the drawing. 

 Bring Above Objects DrawOrder

 The object will bring to the above of the specified object.

 Send Under Objects DrawOrder

 The object will send to the under of the specified object.

DrawOrder

12

 Bring Text to Front TextToFront

 Moves all characters to the front of all objects  
 in the drawing. 

 Bring Dimensions to Front TextToFront

 Moves all dimensions to the front of all other objects  
 in the drawing.

 Bring Leaders to Front TextToFront

 Moves all the leaders to the front of all other objects  
 in the drawing.

 Bring All Annotations to Front TextToFront

 Moves all annotations to the front of all other objects  
 in the drawing.

 Send Hatches to Back HatchToBack

 Move all hatches to the back of all other objects  
 in the drawing.

① Select [Modify] Panel -> [Bring Text to Front]. 
　 All text in the drawing will be displayed in front of other objects. 
　 (There is no need to select text.)

Move all text to the front3

① Select [Modify] Panel -> [Bring Dimensions to Front]. 
　 All dimensions in the drawing will be displayed in front of other objects. 
　 (There is no need to select dimensions.)

Move all dimensions to the front4

① Select [Modify] Panel -> [Bring Above Objects]. 
　 The <red circle> is hidden under the <blue square>. (Fig.1) 
 
② Select objects: 

　 Select <red circle>, then   (Fig.2)

③ Select reference objects: 

　 Select <blue square>, then   (Fig.3)

④ <red circle> is now on top of <blue square>. (Fig.4)

Move to the front of the specified object2

(Fig.1)

(Fig.2)

(Fig.3) (Fig.4)

DrawOrder



138 139

Chapter 4 【Drawing Management】 Chapter 4 【Drawing Management】

D
ra

w
in

g 
M

an
ag

em
en

t

D
ra

w
in

g 
M

an
ag

em
en

t

 Ribbon Menu  [ Home ] tab -> [ Clipboard ] panel -> Paste
 Pulldown menu  [ Edit ] -> Paste
 Command  PaseteClip

Paste [PasteClip]

Copy a block into another drawing

① Select [Clipboard] panel -> [Copy clip].   
② Select the chair (circled in red). 

③ Move to the right-hand diagram, and paste the chair using [Clipboard] panel -> [Paste] (A) 

④ Similarly, paste the chair using [Paste as Block]. (B)

1

(A)<Paste>

(B)<Paste as Block>

⑤ The chair pasted in with [Paste] also copies the information for the block name [CHAIR_1]. 

　 The chair pasted using [Paste as Block] is named <A$C4aeb4c6b>.

Paste PasteSpecial

 Ribbon Menu  [ Home ] tab -> [ Clipboard ] panel -> Paste Special
 Pulldown menu  [ Edit ] -> Paste Special
 Command  PasteSpec

PasteSpecial [PasteSpec]

Paste object from other drawing as <AutoCAD Entities>1

14

① Select [Clipboard] panel -> [Paste Special]. 

② Select [AutoCAD Entities] in [Paste Special] dialog box and click [OK] button.  

③ It is inserted into the drawing as a normal block shape.  

　 The insertion point is the lower left of the object.

Paste object from other drawing as <image>2
① Select [Clipboard] panel -> [Paste Special]. 

② Select [Picture] in [Paste Special] dialog box and click [OK] button.  

③ Not only the selected shape, but the entire screen range is inserted as an image  

　 in the drawing together with the outer frame.

13

(A)<Paste>

(B)<Paste as Block>
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Point!

 Ribbon Menu  None
 Pulldown menu  [ Format ] -> Rename
 Command  Rename

[Rename]15

Rename an object or non-object1
① Type <rename> from the keyboard. 

② [Rename] dialog box will appear. 

③ Select [Blocks] item. 

④ [Step1]・・Select <A$C4aeb4c6b>. 

⑤ [Step2]・・Enter <CHAIR_2> in the bottom box,  

　　　　　　  and click [Rename to] button. 

⑥ [Step3]・・<A$C4aeb4c6b> was changed to<CHAIR_2>.

Step1 Step2 Step3

⑦ If you check [Properties], it has been changed to <CHAIR_2>.

(A)<Paste> (B)<Paste as Block> (A)The insertion point of the shape pasted 

using  <Paste> command is the insertion 

point of the original block.

(B)The insertion point for the shape pasted 

using <Paste as Block> command is the lower 

left of the block.

[Purge]16

PurgeRename

 Application Menu  [ Manage ] Tab -> [ Cleanup ] Panel -> Purge
 Pulldown menu  [ File ] -> [ Drawing Utilities ] -> Purge
 Command  Purge

Delete the name of an object or a non-object1
① Select [Cleanup] Panel -> [Purge]. 

② [Purge] dialog box will appear. 

　Unused layers, line types, blocks, etc. in the current drawing will be displayed.

　 (Fig.1) 

③ In this figure, the block <ABT_10> 

　 is checked. 3  

④ Press [Purge Checked Items] button  

　 at the bottom of the dialog box. 4  

⑤ Block<ABT_10> will be deleted from 

　 the drawing.

(Fig.1)

(Fig.2)(Fig.2) 
⑥ If you click on [Purge All] at the 　　 

　 bottom of the dialog box, all unused 

　 layers, line types, blocks, etc. will be 　

　 deleted. 6  

⑦ If you open the [Find Non-Purgeable 
　 Items] box on the right of the [Purge] 
　 dialog, 7  
　 you will see a list of items that cannot 
　 be deleted, such as currently used 　
　 layers, line types, and blocks.

Please be careful, as it will be displayed 
even if you are not using the necessary 
layer or line type.

(A)<Paste>

(B)<Paste as Block>

4

6

7

3
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 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> Distance
 Pulldown menu  [ Tools ] -> [ Inquiry ] -> Distance
 Command  Measuregeom -> D

① Select [Distance] from the [Utilities] panel. 

② Enter an option [Distance/Radius/Angle/ARea/Volume/Quick/Mode/eXit] <Distance>:_distance 

　 Specify first point:  P1 is indicated. 

③ Specify second point or [Multiple points]:  P2 is indicated.（From P1 to P2 of the runway）

④ The length and X, Y, and Z increments will be displayed in the text window.

Shows the distance between two points

Distance [Measuregeom(D)]1

1

Distance Radius

① Select [Radius] from the [Utilities] panel. 

② Enter an option [Distance/Radius/Angle/ARea/Volume/Quick/Mode/eXit] <Distance>:_radius 

　 Select arc or circle:  Select Arc S1 (Arc of the balcony). 

③ The radius and diameter will be displayed in the text window.

Shows the radius and diameter of circles and arcs1

 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> Radius
 Pulldown menu  [ Tools ] -> [ Inquiry ] -> Radius
 Command  Measuregeom -> R

Radius [Measuregeom(R)]2

S1

P1 P2

Section 2 Figure Information
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 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> Angle
 Pulldown menu  [ Tools ] -> [ Inquiry ] -> Angle
 Command  Measuregeom -> A

Angle [Measuregeom(A)]3

Angle

① Select [Volume] from the [Utilities] panel. 

② Press the right mouse button and select [Object] from the shortcut menu.

Display the volume of a solid object

S1

1

 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> Volume
 Pulldown menu  [ Tools ] -> [ Inquiry ] -> Volume
 Command  Measuregeom -> V

Volume [Measuregeom(V)]4

Volume

③ Select objects:  Select the solid shape (S1) with the mouse.

④ The volume will be displayed in the shortcut.

① Select [Angle] from the [Utilities] panel. 

② Enter an option [Distance/Radius/Angle/ARea/Volume/Quick/Mode/eXit] <Distance>: _angle 

　 Select arc, circle, line, or <Specify vertex>:  Select the left-hand roof (S1).

③ Select second line:  Select the right-hand roof (S2).

④ The angle will be displayed in the text window.

Displays the angles of the indicated arcs, circles, and line1

S1

S2
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Indicate the edges of the shapes in order
① Select [Area] from the [Utilities] panel. 

② Enter an option [Distance/Radius/Angle/ARea/Volume/Quick/Mode/eXit] <Distance>: _area  

③ Specify first corner point or [Object/Add area/Subtract area/eXit] <Object>:

 　Indicate the endpoints in order: P1, P2, P3, P4. 

④ The area and perimeter are displayed in the text window.

2

Area

P3

P2

P1

P4

Area

 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> Area
 Pulldown menu  [ Tools ] -> [ Inquiry ] -> Area
 Command  Measuregeom -> AR

Area [Measuregeom(AR)]5

① Select [Area] from the [Utilities] panel. 

② Press the right mouse button and select [Object] from the shortcut menu.

Obtaining the area of a closed shape

S1

1

③ Select objects:  Select the closed shape (S1) with the mouse.

④ The area and perimeter will be displayed in the shortcut.

④ The area is also displayed in the shortcut.

Closed shapes are [circle], [ellipse], 

[donut], [rectangle], [polygon], 

[closed polyline], and [region].
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Object Properties

① Select [ID Point] from the [Utilities] panel. 

② Specify point:  This indicates P1. 

③ Specify point:  This indicates P2. 

④ Specify point:  This indicates P3. 

⑤ Specify point:  This indicates P4.

⑥ The X, Y, and Z coordinates 

　 will be displayed in the text window.

Displays the (X, Y, Z) coordinates of the indicated point1

 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> ID Point
 Pulldown menu  [ Tools ] -> [ Inquiry ] -> ID Point
 Command  Id

ID Point [Id]6

ID Point

① Select [List] from the [Properties] panel. 

② Select objects: 

 　Select the object (S1).

③ The object information for the selected shape is displayed in the text window.

Display properties for the selected shape1

 Ribbon Menu  [ Home ] tab -> [ Utilities ] panel -> List
 Pulldown menu  [ Tools ] -> [ Inquiry ] -> List
 Command  List

Object Properties [List]7

S1

P1 P2

P3

P4
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Combining two drawings to compare

 Ribbon Menu  [ Collaborate ] tab -> [ Compare ] panel -> DWG Compare
 Application Menu  [ Application Menu ] -> [ Drawing Utilities ] -> DWG Compare
 Command  Compare

Drawing Comparison Settings [Compare]1

Drawing Comparison SettingsDrawing Comparison Settings

Using [DWG Compare] , you can highlight the differences between two revisions of the same drawing  

or between different drawings.

② Next, [Select a drawing to compare] dialog box will appear, so specify the drawing to compare (DWG2). 

　 The drawing to compare (DWG2) is <Central Airport2.dwg>. 

③ [DWG Compare] toolbar will be displayed. 

　 Select [Export Snapshot] from [DWG Compare] toolbar.

1

Drawing name of comparison results

① The default name of the comparison result file is  

　 <Comparison_First Drawing Name vs Second Drawing Name>. 
② Therefore, this comparison drawing name is <Compare_Central Airport1 vs Central Airport2>.

2

① To change the default color settings for objects that only exist in the first drawing (DWG1),  

　 click on the color icon. 

② To change the default color settings for objects that only exist in the second drawing (DWG2),  

　 click on the color icon. 

Specifying the colors of differences3

① Display the basic drawing to be compared (DWG1) and use [DWG Compare] command. 

　 The basic drawing (DWG1) is <Central Airport1.dwg>.

Section 3 DWG Compare
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 Ribbon Menu  [ Collaborate ] tab -> [ DWG Compare ] panel -> Difference
 Pulldown menu  None
 System variable  COMPARESHOWCOMMON 

Results of drawing comparison [CompareShowCommon] 2

Results of drawing comparisonResults of drawing comparison

Switch between display and non-display

① You can switch between showing and hiding by pressing this button.  

　 In the image below, the object at the bottom, <No Differences>, is hidden.

1

 Sets the color of objects that only exist in the comparison drawing. (Airport2)

 Sets the color of objects that only exist in the original drawing to be compared. (Airport1)

 Sets the color of objects that are common to both drawings. (Airport1 & Airport2)

 Ribbon Menu  [ Collaborate ] tab -> [ DWG Compare ] panel -> Filter
 Pulldown menu  None
 System variable  COMPARETEXT , COMPAREHATCH

Filter for comparison drawing [CompareText][CompareHatch]3

Use a filter

① You can use the filter to hide [text] and [hatchings] from the comparison drawing. 

　 Figures (Fig.1) to (Fig.3) show the <ON> and <OFF> switching of [text] and [hatching] objects.

1

(Fig.1)

(Fig.2)

(Fig.3)

object System variable Value
 Text  COMPARETEXT ON
 Hatch  COMPAREHATCH ON

object System variable Value
 Text  COMPARETEXT OFF
 Hatch  COMPAREHATCH ON

object System variable Value
 Text  COMPARETEXT OFF
 Hatch  COMPAREHATCH OFF
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 Ribbon Menu  [ Collaborate ] tab -> [ DWG Compare ] panel -> Draw Order
 Pulldown menu  None
 System variable  COMPAREFRONT

Check the layers

① The figure below shows the drawing of <Central Airport1.dwg> and a list of its layer names. 

　 The layer names in <Central Airport2.dwg> are the same.

1

Draw Order of comparison drawing [CompareFront]4 Change [Draw Order]

① With [Draw Order], you can control <Draw Order> of objects that overlap in the comparison drawing． 
② By default, the overlapping objects in Drawing 1 will be displayed in the foreground,  
　 and the overlapping objects in Drawing 2 will be displayed in the background,  
　 as shown in the figure below.

2

2 Layer <0-Markups> is a layer 

dedicated to Cloud Display.

② In the comparison drawing, the layers of the first drawing (Drawing 1) and the second drawing  

　(Drawing 2) are named using the following format (<layer name>_DWG1 and <layer name>_DWG2).

　The layers created according to these rules is shown below. 

　For example, there are two <Outline> files, <Outline_DWG1> and <Outline_DWG2>. 1

③ Clicking on [Draw Order] will swap the top and bottom. 
　 The image below shows <Drawing 2> displayed on the top. 

1

2

Draw Order of comparison drawingDraw Order of comparison drawing
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CompareRcShape

Specify the shape of the Revision Cloud (System variable<COMPARERCSHAPE>)

① You can control whether the differences are surrounded by a rectangle or a polygon  

　 in the comparison result drawing. [COMPARERCSHAPE  <rectangle = 0 >、<polygon = 1 >]

1

 Ribbon Menu  [ Collaborate ] tab -> [ DWG Compare ] panel -> Cloud Display
 Pulldown menu  None
 System variable  COMPARERCSHAPE , COMPARESHOWRC

Revision Clouds [CompareRcShape][CompareShowRc]5

The Revision Clouds highlights the parts that have been changed in the two compared drawings.

Specify the margin from the border to the Revision Cloud

① In [Size] box in [Revision Clouds] panel, you can use the slider to specify the margin  

　 from the bounding box to the Revision Clouds. 

② The left diagram shows an example with a narrow margin,  

　 and the right diagram shows an example with a wide margin.

2

How do we create 2D shapes?
How do we create dimensions?

In this chapter, 
we will learn how to create 2D shapes.

Chapter 5  Draw Functions

Section 1 2D shapes



158 159

Chapter 5 【Draw Functions】 Chapter 5 【Draw Functions】

Cr
ea

tio
n 

Fu
nc

tio
ns

Cr
ea

tio
n 

Fu
nc

tio
ns

P2

P1

P3

If the last shape you draw is an arc,  
you can draw a tangent line from the end of the arc.

① Select [Draw] Panel -> [Line].

② Specify the first point: Click P1.

③ Specify the next point: Click P2.

　 Select Enter from the shortcut  

　 to exit the command.

① Select [Draw] Panel -> [Line].

② Specify the first point: Click P1.

③ Specify the next point: Click P2.

④ Specify the next point: Click P3.

⑤ Specify next point or [Close/Undo]: Click P4.

　 Press the right button to use the shortcut,  

　 select Enter to exit line command. 

Immediately after drawing the arc from P1 to P2, 

① Select [Draw] Panel -> [Line].

② Specify the first point: Right-click. 

③ Specify the next point:  Click P3. 

　 Use the shortcut to select Enter to exit the command.

A single line

A continuous line

P2

P1  Starting point (P1)     

 Ending point  (P2)

Line connected to the end point of the arc

 Starting point (P1) and next point (P2), (P3) 

 and Ending point (P4)

P2 P1

P3

P4

1

2

3

[Line]1

 Ribbon Menu  [ Home ] tab -> [ Draw]  panel ->  Line
 Pulldown menu  [ Draw ] -> Line
 Command  Line

Line Xline

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Xline
 Pulldown menu  [ Draw ] -> Xline
 Command  Xline

① Select [Draw] Panel -> [Xline].

② Specify a point or [Hor/Ver/Ang/Bisect/Offset]: 

　 Click P1.

③ Specify through point:  Click P2.

④ Next, specify the points to pass through.

⑤ Finally, right-click to finish.

Passing point (P1)

Base Point (P1) and Orientation (P2)

① Select [Draw] Panel -> [Xline]. 

② From the shortcut, select “Hor” .

③ Specify through point:  Click P1.

　 Next, specify the point to pass through. 

④ Finally, right-click to finish.

P1

① Select [Draw] Panel -> [Xline]. 

② From the shortcut, select “Ang” .

③ Enter angle of xline (0) or [Reference]:  R 

④ Select a line object: 

　 Click line S1. 

⑤ Enter angle of xline <0>:  30  

　 Enter the angle for the selected shape. 

⑥ Specify through point: Click P1.

⑦ Finally, right-click to finish.

Draw a Construction Line by specifying a point

Draw a horizontal Construction Line

Draw a Construction Line in a specified angle

Reference shape (S1) and angle specification

S1P1 30°

Construction Line [Xline]2

1

2

3

P1

P2

Section 1 2D shapes
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Ray

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Ray
 Pulldown menu  [ Draw ] -> Ray
 Command  Ray

P2

P1
 Starting point (P1) and Passing point (P2)

① Select [Draw] Panel -> [Ray]. 

② Specify start point:  Click P1.

③ Specify through point:  Click P2. 

④ To end the command, press .  

     （Or right-click to finish.）

Draw an infinite line in one direction from the starting point

[Ray]3

1

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Spline
 Pulldown menu  [ Draw ] -> Spline
 Command  Spline

① Select [Draw] Panel -> [Spline Fit].

② Specify first point or [Method/Knots/Object]: 

　 Click P1.

Draw a spline with fit points

③ Enter next point or [start Tangency/toLerance]:　

　 Click P2. 

④ Enter next point or [end Tangency/toLerance/ 

　 Undo]: 

　Click P3. 

⑤ Then, point to P4 and P5 

　 and end with the right mouse button.

[Spline]4

1

Spline

P1

P2

P3

P4

P5

① Select [Draw] Panel -> [Spline CV]. 

② Specify first point or [Method/Degree/Object]: 

　 Click P1.

③ Enter next point or [Undo]: 

　 Click P2. 

④ Enter next point or [Close/Undo]: 

　 Click P3.

⑤ Then, point to P4 and P5 

　 and end with the right mouse button.

Draw a spline with control vertices2
P1

P2

P3

P4

P5

 Example of using [Ray] command 

[Ray] command is used when drawing a [sun shadow diagram] ,  

as shown in the figure below.

P1(Starting point)

P2(Passing point )

P1

P2

 [Spline Fit] specifies the curvature that passes through the fit points with the fit tolerance. 

[Spline CV] specifies the degree of the number of peaks and troughs.

Tolerance (allowable distance from the fit point)

　　( 1  = 0) ( 2  =10) ( 3  = 20)

1

2

3

1
2

3

Degree (degree of polynomial<1-10>)

　　( 1  = 1) ( 2  = 3) ( 3  = 5)
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① Select [Draw] Panel -> [Polyline].

② Specify start point: Current line-width is 0.0000

　 Specify next point or [Arc/Halfwidth/Length/Undo/　　 

　 Width]:  Click P1.

③ Select [Arc] of the shortcut. 

④ Select [Width] of the shortcut.

　 Specify starting width <0>:  

　 Specify ending width 〈0〉：  5  

⑤ Specify endpoint of arc:  Click P2.

⑥ Select [Enter] as the shortcut.

Draw a polyline with a wide arc3

Pline

P2P1

Pline

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Polyline
 Pulldown menu  [ Draw ] -> Polyline
 Command  Pline

① Select [Draw] Panel -> [Polyline].

② Specify start point: Current line-width is 0.0000

　 Specify next point or [Arc/Halfwidth/Length/Undo/　

　 Width]:  Click P1.

③ Specify next point ： Click P2.

④ Specify next point ：Click P3.

⑤ Specify next point ： Click P4.

⑥ Use the shortcut to select [Close].

① Select [Draw] Panel -> [Polyline].

② Specify start point: Current line-width is 0.0000

　 Specify next point or [Arc/Halfwidth/Length/Undo/　　 

　 Width]:  Click P1.

③ Select [Width] of the shortcut. 

　 Specify starting width <0>:  

　 Specify ending width 〈0〉：  5  

④ Specify next point:  Click P2.

⑤ Specify next point:  Click P3.

⑥ Specify next point  W  

　 Specify starting width〈5〉：  

　 Specify ending width〈5〉：0  

⑦ Specify next point:  Click P4.

⑧ Select [Enter] as the shortcut.

Draw a closed polyline

Draw a polyline with a wide width

[Pline]5

1

2

P1

P2

P 2 P3

P4P1
Ｃ

P2

P3

P4

P1

（Fig.1） （Fig.2）

【Example of using [Polyline] command】 
The land area map in (Fig. 1) shows contour lines, 
but as in (Fig. 2), these contour lines use [Polyline].
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 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Circle
 Pulldown menu  [ Draw ] -> Circle
 Command  Circle

[Circle]
① Select [Draw] panel -> [Circle] -> [3-Point]. 

② Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 

　 3p Specify first point on circle: 

     Click P1.

③ Specify second point on circle: 

     Click P2.

④ Specify third point on circle: 

     Click P3.

① Select [Draw] panel -> [Circle] -> [Center, Radius].

② Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 

     Click P1.

③ Specify radius of circle or [Diameter]: 

     Enter the number from the keyboard or 

　 point to P2 with the mouse.

P2

P1

Circle with center and radius specified

P1

P2P1

P3

Circle with three specified points on its circumference

① Select [Draw] panel -> [Circle] -> [Tan,Tan,Radius].

② Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: _

　 ttr 

③ Specify point on object for first tangent of circle:  

     Select line S1. 

④ Specify point on object for second tangent of circle: 

     Select line S2. 

⑤ Specify radius of circle:  20  

① Select [Draw] panel -> [Circle] -> [Tan,Tan,Tan].

② Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: _3p 

　 Specify first point on circle:  Indicates line S1.

③ Specify second point on circle: _tan to  Indicates line S2.

④ Specify third point on circle: _tan to  Indicates line S3.

Circle touching two circles, input radius

Circle touching three objects

S1

S2

S3

Options of Circle command
 [Specify center point]  Specify the center point of the circle using  mouse or numerical values.
 [Specify Diameter]  Specify the center point and diameter of the circle.
 [Specify 3point]  Three points of a circle are specified.
 [Specify 2point]  Create a circle with the two points as its diameter.
 [Specify tan,tan,radius]  Creates a circle that touches other shapes within a specified radius.

① Select [Draw] panel -> [Circle] -> [2-Point].

② Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 　

　 2p Specify first end point of circle’ s diameter: 

　 Click P1.

③ Specify second end point of circle’ s diameter: 

     Click P2.

P2

P1

Circle with two points specified as its center

6

1

2

3

4

5

CircleCircle

S2

S1
20
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 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Arc
 Pulldown menu  [ Draw ] -> Arc
 Command  Arc

① Select [Draw] panel -> [Arc] -> [3-Point].

② Specify start point of arc or [Center]: 

     Click P1.

③ Specify second point of arc or [Center/End]: 

     Click P2. 

④ Specify end point of arc: 

     Click P3.  Starting point (P1), passing point (P2), 

and ending point (P3)

Draw an arc passing through the three points

[Arc]7

1

3

ArcArc

 Start point (P1), end point (P2), 

and direction (P3)

P2 P1

P3

① Select [Draw] panel -> [Arc] -> [Start,End,Direction].

② Specify start point of arc or [Center]: 

     Click P1.

③ Specify second point of arc or [Center/End]: _e

　 Specify end point of arc:  Click P2.

④ Specify center point of arc (hold Ctrl to switch direction)  

　 or [Angle/Direction/Radius]: _d

　 Specify tangent direction for the start point of arc  

　 (hold Ctrl to switch direction):   Click P3.

① Select [Draw] panel -> [Arc] -> [Continue].

② Specify start point of arc or [Center]:

　 Specify end point of arc  

　 (hold Ctrl to switch direction): Click P1. P1

 End point of the arc (P1)

Draw an arc with a specified start point, end point, and direction

Draw a continuous arc from the previous arc

5

7

 Starting point (P1), center (P2) 

and ending point (P3)

P2（中心）

P1

P3

① Select [Draw] panel -> [Arc] -> [Start,Center,End].

② Specify start point of arc or [Center]: 

     Click P1.

③ Specify second point of arc or [Center/End]: _c

　 Specify center point of arc:  

     Click P2.

④ Specify end point of arc (hold Ctrl to switch direction)  

　 or [Angle/chord Length]:

     Click P3.

Draw an arc with a specified start point, center, and end point2

Draws an arc with a specified start point, center, and angle

① Select [Draw] panel -> [Arc] -> [Start,Center,Angle].

② Specify start point of arc or [Center]: 

     Click P1.

③ Specify second point of arc or [Center/End]: _c

　 Specify center point of arc: Click P2.

④ Specify end point of arc (hold Ctrl to switch direction)  

　 or [Angle/chord Length]: _a

　 Specify included angle (hold Ctrl to switch direction):  Click P3.

P1

P2

P3

 Start Point (P1), Center (P2), Angle (P3)

 Start Point (P1), Center (P2)  

and Length (P3)

P2

P1

P3

① Select [Draw] panel -> [Arc] -> [Start,Center,Length].

② Specify start point of arc or [Center]: 

     Click P1.

③ Specify second point of arc or [Center/End]: _c

　 Specify center point of arc:  Click P2. 

④ Specify end point of arc (hold Ctrl to switch direction)  

　 or [Angle/chord Length]: _l

　 Specify length of chord (hold Ctrl to switch direction):  Click P3.

Draw an arc with a specified starting point, center, and length4

 Center (P1), Start (P2), End (P3)

P2P1

P3

① Select [Draw] panel -> [Arc] -> [Center,Start,End]. 

② Specify center point of arc: 

     Click P1. 

③ Specify start point of arc: 

     Click P2.

④ Specify end point of arc (hold Ctrl to switch direction)  

　 or [Angle/chord Length]:  Click P3.

Draw an arc with a specified center, start, and end6

P1 P2

P3

Creates a circle tangent to the previous arc.

Line P1-P3 is tangent at the starting point P1.
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 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Elliptical Arc
 Pulldown menu  [ Draw ] -> Ellipse -> Arc
 Command   Ellipse -> A

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Ellipse
 Pulldown menu  [ Draw ] -> Ellipse
 Command  Ellipse

① Select [Draw] panel -> [Ellipse] -> [Elliptical Arc].

② Specify axis endpoint of ellipse or [Arc/Center]: _a

　 Specify axis endpoint of elliptical arc or [Center]: 

     Click P1. 

③ Specify other endpoint of axis: 

     Click P2. 

④ Specify distance to other axis or [Rotation]: 

     Click P3.

Draw an elliptical arc with the main axis, short axis, and angle

First, define the ellipse, and then specify the start and end points of the Elliptical Arc.

Start angle point (P4) and  
end angle point (P5) of the Elliptical Arc]

P5
P4

① Select [Draw] panel -> [Ellipse] -> [Axis,End].

② Specify axis endpoint of ellipse or [Arc/Center]: 

     Click P1.

③ Specify other endpoint of axis:  

     Click P2.

④ Specify distance to other axis or [Rotation]: 

     Click P3.
Specify the first point on the axis (P1),  
the second point on the axis (P2),  
and the other axis (P3)

P1 P2

P3

Draw an ellipse on both axes (specify the radius for one axis and the other)

① Select [Draw] panel -> [Ellipse] -> [Center].

② Specify axis endpoint of ellipse or [Arc/Center]: _c

　 Specify center of ellipse: 

     Click P1.

③ Specify endpoint of axis:

     Click P2. 

④ Specify distance to other axis or [Rotation]: 

     Click P3.

Specify the center of the ellipse (P1),  
the end of the axis (P2),  
and the end of the other axis (P3)

P1 P2

P3

Draw an ellipse with a center and axis (specify center and two radius values)

Specify the first point on the axis (P1),  
the second point on the axis (P2),  
and the other axis (P3)

P1 P2

P3

[Ellipse] [EllipseArc]

Options of Ellipse command
 [Center]  Click on the dot or enter the coordinates to specify the center point of the ellipse.
 [Axis,End]  After specifying one axis, specify the radius of the other axis.

8 9

2

1

1

Elliptical ArcEllipse

⑤ Specify start angle or [Parameter]: 

 　Either enter the angle as a numerical value  

　 using the keyboard, or click P4.

⑥ Specify end angle or [Parameter/Included angle]:

     Either enter the angle as a numerical value  

　 using the keyboard, or click P5.

The area is also displayed for an elliptical arc.
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 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Polygon
 Pulldown menu  [ Draw ] -> Polygon
 Command   Polygon

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Rectangle
 Pulldown menu  [ Draw ] -> Rectangle
 Command  Rectang

① Draw a [polygon] with [center-edge midpoint]. 

② polygon Enter number of sides <4>:  

　 From the keyboard, <5> 

③ Specify center of polygon or [Edge]:   Click P1. 

④ Enter an option [Inscribed in circle/Circumscribed about circle]  

　 <I>:  C

⑤ Specify radius of circle:  Click P2.

Specify the distance from the center point to the edge (circumscribed circle)

P2

P1

Center point (P1) and  

midpoint of the side (P2)

P2

P1

Center point (P1) and vertex (P2)

Specify the center point and vertex (inscribed in a circle)

① Draw a polygon using [center - vertex]. 

② polygon Enter number of sides <4>:  

　 From the keyboard, <5>  

③ Specify center of polygon or [Edge]:   Click P1. 

④ Enter an option [Inscribed in circle/Circumscribed about circle]  

　 <I>:  I

⑤ Specify radius of circle:  Click P2.

P2P1

One endpoint (P1) and  

the other endpoint (P2)

① Draw a [polygon] with [side length]. 

② polygon Enter number of sides <4>:  

　 From the keyboard, <5>

③ Specify center of polygon or [Edge]: 

     Select [Edge] from the shortcut menu. 

④ Specify first endpoint of edge:   Click P1.

⑤ Specify second endpoint of edge:    Click P2.

Specify the length of one side (side length specification)

[Polygon]

① Select [Draw] panel -> [Rectangle].

② Specify first corner point or [Chamfer/Elevation/Fillet/

　 Thickness/Width]:

　 Click P1.

③ Specify other corner point or [Area/Dimensions/ 

　 Rotation]: 

     Click P2.

Create a rectangle with filleted corners. 

① Select [Draw] panel -> [Rectangle].

② elect [fillet] from the shortcut menu. 

③ Enter a fillet radius.

④ Specify first corner point:

     Click P1. 

⑤ Specify other corner point:

     Click P2.

Create a rectangle with chamfered corners. 

① Select [Draw] panel -> [Rectangle].

② Select [chamfer] from the shortcut menu. 

③ Enter the chamfer distance for the first and second sides.

④ Specify first corner point: 

     Click P1.

⑤ Specify other corner point: 

     Click P2.

Draw a rectangle

Chamfer

Fillet

[Rectang]

1

2

3

1

2

3

PolygonRectangle

1110

Opposite corners (P1) and (P2)

P2

P1

P2

P1

P2

P1

Opposite corners (P1) and (P2)

Opposite corners (P1) and (P2)



172 173

Chapter 5 【Draw Functions】 Chapter 5 【Draw Functions】

Cr
ea

tio
n 

Fu
nc

tio
ns

Cr
ea

tio
n 

Fu
nc

tio
ns

WipeOutRegion

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Wipeout
 Pulldown menu  [ Draw ] -> Wipeout
 Command  Wipeout

[Wipeout]13

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Region
 Pulldown menu  [ Draw ] -> Region
 Command  Region

[Region]

① Select [Draw] panel -> [Region].

② Select objects: 

     Select a rectangle (closed polyline). 

③ 1 loop extracted. 

 　1 Region created.

Converting closed shapes (circles, squares, etc.) into region shapes (surfaces)1

Confirm with [Properties]2

① The object type has changed from [Polyline] to [Region]. 1

② [Geometry] item has changed from <Length> to <Perimeter>. 2

　 This indicates that it is a surface.

12

1

2

1

2

Create a wipeout external line1
① <Floor plan> in <Floor plan S=1:100> will be wiped out. 

② Select [Draw] panel -> [Wipeout].

③ Specify first point or [Frames/Polyline] <Polyline>: 

　 Click P1.

　 Specify next point:  Click P2,P3,P4. 

④ Select [Close] button. 

⑤ <Floor plan> is now hidden.

Use the existing object as the outline (the frame can be turned on/off)2
① <S=1:100> in <Floor plan S=1:100> will be wiped out. 

② Select [Draw] panel -> [Wipeout].

③ Select [Polyline] from the right-hand button shortcut. 

④ Specify first point or [Frames/Polyline] <Polyline>: P

　 Select a closed polyline:   

　 Select the rectangle (S1). 

⑤ Erase polyline? [Yes/No] <No>:   

⑥ <S=1:100> is now hidden.

P1

P2 P3

P4

S1

If you select <Y> in ⑤ , the selected polyline will be deleted.
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 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Revision Cloud
 Pulldown menu  [ Draw ] -> Revision Cloud
 Command  RevCloud

Drawing revision cloud

[RevCloud]14

1

RevCloud

① Select [Draw] panel -> [revcloud].

② Specify first corner point or [Arc length/Object/ 

　 Rectangular/Polygonal/Freehand/Style/Modify]  

　 <Object>:    F 

③ Guide crosshairs along cloud path...      

④ Move the mouse P2 and when it gets close to  

　 the starting point P3, it will automatically connect to P1.

P1
P2

P3

Convert existing closed shapes into revcloud.2

You can specify the 
length of the arc of 
the cloud from the 
shortcut.

There are two styles of Revision Cloud: [Standard] and [Calligraphic].

Standard] Calligraphic

① Select [Draw] panel -> [Revcloud].

② Select object: 

　 Select a rectangle and a pentagon.

Rectangle Pentagon

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Multiple Points
 Pulldown menu  [ Draw ] ->  Multiple Points
 Command  Point

② The dialog box below will appear. 

　  Check the box for <X> in [Point Style] dialog.

① Select [Home] tab -> [Utilities] panel -> [Point Style].

Set the type of display for [Multiple Points]

③ Select [Draw] panel -> [Multiple Points].

④ Specify a point:  The line is indicated by <Midpoint> of [Object snap].

[Point Style] is also used in <divid> and <measure>.

The points will be printed,  
so erase them if you don’ t need them.

Multiple Points [Point]

1

15

 Set Size Relative to screen
 Specify the size of the point on the screen.
 Set Size in Absolute Unite
 Displays in the specified size.

Point
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MeasureDevide

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Measure
 Pulldown menu  [ Draw ] -> [ Point ] -> Measure
 Command   Measure

Marks appear every 50 mm  
from the edge of the selected line.

Marks appear every 50 mm  
from the edge of the selected arc.

In the case of a circle, marks appear  
counterclockwise from the 3 o’ clock posi-

Draw points equally spaced on the indicated shape

[Measure]

1

17

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Devide
 Pulldown menu  [ Draw ] -> [ Point ] -> Devide
 Command  Devide

Display marks at three equal positions.

Display marks at five equal positions.

Draw points that divide the indicated shape into equal parts

[Devide]

1

16

S1

S1

S1

S1

S1

In the case of a circle, marks are displayed  
counterclockwise from the 3 o’ clock position.

(Line divided equally)
① Select [Draw] panel -> [Devide].

② Select object to divide:　

　 Select the line S1.

③ Enter the number of segments or [Block]: 3  

(Arc divided equally)

① Select [Draw] panel -> [Devide].

② Select object to divide:　

　 Select the arc S1.

③ Enter the number of segments or [Block]: 5  

① Select [Draw] panel -> [Devide].

② Select object to divide:　

　 Select the circle S1.

③ Enter the number of segments or [Block]: 7  

(Circle divided equally)

Points are created from the end of  

the selected line closer to the end of the line.

Points are created from the end of  

the selected arc closer to the end of the arc.

(Measure a line)

① Select [Draw] panel -> [Measure].

② Select object to measure:

　 Select the line S1.

③ Specify length of segment or [Block]: 

　 50  

(Measure a arc)
① Select [Draw] panel -> [Measure].

② Select object to measure:

　 Select the line S1.

③ Specify length of segment or [Block]: 

　 50  

① Select [Draw] panel -> [Measure].

② Select object to measure:

　 Select the line S1.

③ Specify length of segment or [Block]:　

　 50  

(Measure a circle)

S1

With the option “Block” , a block is placed instead of points. With the option “Block” , a block is placed instead of points.
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 Ribbon Menu  [ Insert] tab -> [ Block Definition ] panel -> Create Block
 Pulldown menu  [ Draw ] -> [ Block ] -> Make
 Command  Block

The blocks you create here will be saved  
in this drawing.

Combine multiple shapes and name them

③ Press [Pick point] button, 

　 and indicate the midpoint of the front side of the chair  

　 at the midpoint of the O-snap.

④ Press [Select objects] button  

　 and select the entire chair. (S1 - S2)

② Enter <chair> in [Name] field.

[Block]

1

BlockDonut

① Select [Block Definition] panel -> [Create Block]. 

　 [Block Definition] dialog box will appear.

19

 Retain  The shapes are left as it is.
 Convert to block  The selected shapes are saved as a block.
 Delete  The selected shapes will be deleted. (The block has been created.)

⑤

S2

S1×

×

(A chair drawn using lines and arcs)

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Donut
 Pulldown menu  [ Draw ] -> Donut
 Command  Donut

① Select [Draw] panel -> [Donut].

② Specify inside diameter of donut <0.5>: 2  

③ Specify outside diameter of donut <1.0>: 4  

④ Specify center of donut or <exit>: 

     Specify the center (P1) of the donut.

⑤ Right click to exit.

If you set the inner diameter of the donut to zero, it will become a filled-in circle.

Draw a donut

① Select [Draw] panel -> [Donut].

② Specify inside diameter of donut:   0  

③ Specify outside diameter of donut:  4  

④ Specify center of donut or <exit>: 

     Specify the center of the donut.

⑤ Right click to exit.

Draw a filled-in donut

[Donut]18

1

2

P1

【Example of using [Donut] command】

Reinforcement plan of a concrete structureFluorescent light/switches

3 4

5

2
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 Ribbon Menu  [ Insert ] tab -> [ Block Definition ] panel -> Define Attributes
 Pulldown menu  [ Draw ] -> [ Block ] -> Define Attributes
 Command  AttDef

After [Define Attributes], register the block together with the shape

① Draw a shape.

② Enter the attribute value using [Define Attributes] command. (attribute name<LIGHT>)

③ Press [OK] button to register the block, including the text along with the shape.

In this example, the insertion point for the block is 

set to the center of the circle.

Select [Insert] tab -> [Block Definition] panel -> [Define Attributes]

[AttDef]

1 2

AttDefAttDef

20

P1

1

 Invisible
 When inserting a block, the attribute values will not be displayed. 

 The text will be hidden.

 Constant
 The attribute values of the inserted block are all displayed as fixed values. 

 The values cannot be changed.

 Verify
 You can check the attribute values displayed in the prompt  

 when inserting a block.

 Preset
 When you insert a block with preset attributes,  

 the default values will be set automatically.

2  Insert Point
 Specify the position of the attribute character.  

 Enter coordinates or select [Specify on-screen] and specify it on the screen.

3

 Tag  Name the block attribute.

 Prompt  Specify the prompt that is displayed when inserting a block.

 Default  Enter the default value (initial value) for the attribute.

4

 Text style  Sets the style of the definition text.

 Text height  Use the keyboard or mouse to specify the text size.

 Rotation  Use the keyboard or mouse to specify the text rotation angle．

5
 OK  Save the attribute definition and exit the dialog.

 Cancel  Exit without saving.

4

5

1

2

3

Adds character information (attributes) to block shapes. 

This attribute information can be displayed or hidden on the screen. 

It is also possible to output character information to external files (Excel, etc.).
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 Ribbon Menu  [ Insert ] tab -> [ Block Definition ] panel -> Manage Attributes
 Pulldown menu  [ Modify ] -> [ Object ] -> [ Attribute ] -> Block Attribute Manager
 Command   BAttMan

[BAttMan]21

① The following diagram shows the placement of the columns [Column A] and [ColumnB],  

　 have already been defined.

Manage the defined attributes1

Column A

Column B

② Select [Insert] tab -> [Block Definition] panel -> [Manage Attributes]. 

　 This [Block Attribute Manager] dialog box displays all the block names  

　 that have been defined in the drawing. There are [Column A] and [Column B].

BAttManBAttMan

① The figure on the previous page shows the [Column A] and [Column B] with their attributes defined. 

　 In addition to [Name], [Unit Price] is defined as an attribute of [Column A]. 

　 Click the [Edit] button to move to the editing page.

Edit the defined attributes2

② On the [Attribute] page, you can modify  

　 the attributes defined in [Define Attributes]. 

　 The items are the same as those in [Define Attributes]. 

　 Any changes you make here will be reflected in  

　 the attributes of blocks inserted from this point 　 

 　onwards.

③ On the [Text Options] page, you can modify  

　 [Text] attributes. 

　 You can change [Text Style], [Justification], [Height], 

　 [Width Factor], [Rotation], and [Oblique Angle]. 

　 The changes you make here will be reflected in  

　 the attributes of the blocks inserted after this point.

④ On the [Properties] page, you can modify properties 

　 such as [Text] color and [Line] type. 

　 You can change the [Layer], [Linetype], [Color], 　 

　 [Lineweight], and [Plot style]. 

　 Changes made here will be reflected in the attributes 

　 of blocks inserted from this point onwards.

⑤ [Manage Attributes] is a function that allows you to edit the character attributes of 　 

　 blocks with attributes in the drawing from a list. 

 

⑥ Changing the [value] of an attribute will affect the attribute values of blocks inserted  

 　after this point. 

　 It will not affect the attribute values of existing blocks. 
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BoundaryBoundary

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Boundary
 Pulldown menu  [ Draw ] -> Boundary
 Command   Boundary

Create a closed polyline or region in the overlapping common area

[Boundary]

1

22

① Select [Draw] Panel -> [Boundary]. 

 

② The [Boundary Creation] dialog box will appear. 

　 Select <Polyline> for [Object type]. 

 

③ Click the [Pick Points] button and then click the inner raea.

　 (P1) 

 

④ A closed polyline is created in the intersection of  

　 the rectangle and the circle. (Red)

P1

⑤ If you check [Properties], you can see that the object type is <Polyline>. (Left) 

　 You can also check the area and length. (Right: When indicated by region)

Delete the closed figure inside the outer closed figure (to find the area)2
① Select [Draw] Panel -> [Boundary]. 

 

② The [Boundary Creation] dialog box will appear. 

     Select <Region> for [Object type]. 

 

③ Click the [Pick Points] button and then click the inner raea.

　 (P1) 

 

④ Two regions are created in the intersection of the rectangle 

　 and the circle.( 赤色 )

P1

⑤ The area of the inner region minus the area of  

　 the outer region is calculated. (The shaded area) 

⑥ Select [Modify] -> [Solid Editing] -> [Subtract] from  

　 the Pull-down menu. 

⑦ Remove the inner region (Fig. 2) from the outer region (Fig. 1).

(Fig.1) (Fig.2)

⑧ The left figure shows the outer region before the inner region is removed,  

　 and the right figure shows the region after the inner region is removed. 

　 You can find the area of the inner circle by subtracting the area of the inner circle  

　 from the total area in the [Properties] .

Region

Area ＋ Perimeter

Polyline

Area ＋ Length
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HatchHatch

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Hatch
 Pulldown menu  [ Draw ] -> Hatch
 Command  Hatch

[Hatch]23
There are two ways to display a list of hatch patterns. 

① Open [Pattern] Panel. (Fig.1)

② Open [Hatch Pattern Palette] in [Properties] or [Quick Properties]. (Fig.2)

Selection of Hatch pattern

P1

1

[Hatch] Ribbon tab
1 Boundaries  Hatching is created within the specified boundary.
2 Pattern  You can specify a user-defined hatching pattern.
3 Properties  There is no unit for the hatching interval. Adjust the interval using the scale.
4 Origin  You can change the starting point for hatching. 
5 Options  Select whether or not to apply [Auto Adjust] and [Annotative].
6 Close  Close the hatching ribbon tab.

① If you click on the dialog box launcher (red circle) in  option 5 ,  

　 the traditional [Hatch] dialog will be displayed.

(Fig.1) (Fig.2)

① Select [Hatch] from the [Draw] panel.

② [Hatch Creation] ribbon tab will appear. 

③ Select a hatch pattern from [Pattern]. (e.g. ANSI31) 

④ From [Properties], specify the [Angle], [Scale], and other settings. 

⑤ Click inside the hatch area with the mouse. (Fig.1<P1>) 

⑥ Clicking the right button will create the hatch. (Fig.2)

Creating a hatch2

(Fig.1) (Fig.2)

You can try out various hatch 
patterns until you find the one 
you like.

3 4 5 61 2

[ANSI] 

All ANSI patterns provided by AutoCAD are 

displayed. 

[ISO] 

All ISO patterns provided by AutoCAD are 

displayed. 

[Other Predefined] 

Patterns other than the ANSI and ISO patterns 

provided by AutoCAD are displayed.

3

4

5

6

1
2



188 189

Chapter 5 【Draw Functions】 Chapter 5 【Draw Functions】

Cr
ea

tio
n 

Fu
nc

tio
ns

Cr
ea

tio
n 

Fu
nc

tio
ns

HatchHatch

The starting point of the hatch pattern is the origin (0,0) of the drawing by default. 

For this reason, the starting position of the hatch may not fit well within the area. (Fig.1<red circle>)

Changing the origin of the hatch pattern3

① Select [Hatch] from the [Draw] panel.

② [Hatch Creation] ribbon tab will appear. 

③ Select a hatch pattern from [Pattern]. (e.g. AR-B816) 

④ From [Properties], specify the [Angle], [Scale], and other settings. 

⑤ Select the starting point for the hatch from [Origin],  

　 and indicate the lower left (P1) of the hatch area in (Fig.2). 

⑥ Click inside the hatch area with the mouse.  

⑦ Clicking the right button will create the hatch. (Fig.2)

P1×

[Origin] panel
1  [Set Origin]  Use the mouse to specify the origin of the new hatch.
2  [LL][LR][UL][UR][Center]  The origin of the new hatching is specified by a picture.
3  [Use Current Origin]  The current origin is used as the origin of the hatch.
4  [Store as Default Origin]  The origin of the hatch is saved in the system variable [HPORIGIN].

The origin of the hatch pattern is different from the UCS origin.

Hatching Copy a pattern into the area of another shape4
Copy the hatching pattern in the shape to another shape. 

① Select [Hatch] from the [Draw] panel.

② [Hatch Creation] ribbon tab will appear. 

③ Select [Match Properties] from the [Options] panel. 

④ Choose either [Use current origin] or [Use source hatch origin].

⑤ Select hatch object: (Fig.1)Select the hatch on the roof of the house on the left. 

⑥ Pick internal point: (Fig.2)This indicates the inside of the roof of the house on the right.

⑦ The same hatch as on the left was also created on the roof of the house on the right.

You can also create hatch and gradient from the [Tool Palettes].

From the [Tool Palettes], 

select the hatch pattern, 

and drag & drop it onto 

the roof area.

4

1 2 3

(Fig.1)

(Fig.1)

(Fig.2)

(Fig.2)
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GradientGradient

 Ribbon Menu  [ Home ] tab -> [ Draw ] panel -> Gradient
 Pulldown menu  [ Draw ] -> Gradient
 Command  Gradient

[Gradient]24
There are two ways to display gradient color combinations. 

① Open [Pattern] Panel. (Fig.1)

② Display [Color 1][Color 2] in [Properties] or [Quick Properties]. (Fig.2)

Select Gradient

P1

1

① Select [Gradient] from the [Draw] panel. 

② [Hatch Creation] ribbon tab will appear. 

③ Select a  Gradient] from [Pattern]. (e.g. GR_LINEAR) 

④ From [Properties], specify [Color] for the two colors and others. 

⑤ Click inside the gradient area with the mouse.  (Fig.1<P1>) 

⑥ Clicking the right button will create the gradient. (Fig.2)

Creating a gradation2

3 4 5 61 2

3

4

5

6

51
2

① If you click on the dialog box launcher (red circle) in  option 5 ,  

　 the traditional [Gradient] dialog will be displayed.

[Hatch] Ribbon tab
1 Boundaries  Hatching is created within the specified boundary.
2 Pattern  You can specify a user-defined hatching pattern.
3 Properties  There is no unit for the hatching interval. Adjust the interval using the scale.
4 Origin  You can change the starting point for hatching. 
5 Options  Select whether or not to apply [Auto Adjust] and [Annotative].
6 Close  Close the hatching ribbon tab.

(Fig.1) (Fig.2)

You can try out various gradient 

patterns until you find the one 
you like.

(Fig.1) (Fig.2)
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Use one color to fill in a blank3

Combination of hatch and gradation5

GradientGradient

For a single gradient, choose Solid. (Select SOLID in the [Pattern] palette)

① Select <Solid> from [Properties]. 

② Select a color from the [Color] below it. 

③ Indicates within the area to be filled (P1).

P1

① With the fill selected, slide the [Hatch Transparency] bar. 

② Transparency is <60> in the figure below.  

　 The maximum transparency is <90>.

Change the color shade4
Change [Transparency] to change the color depth or lightness.

③ The figure below is an example of the fill expressed in the concrete of the foundation. 

　 The left [Transparency] is <0> and the right [Transparency] is <70>.

You can combine [Hatch] and [Gradient]. 

① The hatch (Fig.1) is created by a green double line. 

② Select this hatch. (Fig.2)

③ Select a color from “Background Color” in [Properties]. (Example:<221,179,212>)(Fig.3) 

④ The background color is now placed behind the hatch. (Fig.4)

(Fig.1) (Fig.2)

(Fig.3) (Fig.4)
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TextText

 Ribbon Menu  [ Annotate ] tab -> [ Text ] panel -> Single Line
 Pulldown menu  [ Draw ] -> [ Text ] -> Single Line Text
 Command  Text

① Select [Text] panel -> [Single Line]. 

② Specify start point of text or [Justify/Style]: 

　 Click P1.

③ Specify height <2.5>:  3  

④ Specify rotation angle of text <0>:  

⑤ Input text from the keyboard. 123  

⑥ Press enter twice to exit. 

　 The first enter is a new line. 

　 The second enter is the end.

TL= top left / TC= top center / TR= top right / ML= middle left / MC= middle center /　

MR= middle right / BL= bottom left / BC= bottom center / BR= bottom right

Ｊ＝ Justify options

Create text object

P1

If you have already created text on the drawing, when you create new text, 
it will inherit the same height and rotation angle as the previous text.

[Text]

1

25

MC TC
TR

MR

BR
BC

BL

ML

TL

① Select [Text] panel -> [Single Line].

② Specify start point of text or [Justify/Style]:   Click P1.

③ Specify height <2.5>:   3  

④ Specify rotation angle of text <0>:    

⑤ When you are in the text input state ① , press the right mouse button  

　 and select [Insert Field] from the shortcut menu.

Inserting field text2

⑥ Select the type from [Field names] in [Field] and <Date> from [Examples],  

　 and then press the [OK] button.

⑦ The date has been inserted. 

　 You can modify it by selecting the text, right-clicking  

　 and selecting “Edit Field” .

P1

1

You can either type < J > on the keyboard at the timing indicated 
in ② , or select [Justify] from the right-button shortcut.
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MtextMtext

 Ribbon Menu  [ Annotate ] tab -> [ Text ] panel -> Multiline Text
 Pulldown menu  [ Draw ] -> [ Text ] -> Multiline Text
 Command  Mtext

① Select [Text] panel -> [Multiline Text].

② Current text style:  “Standard”  Text height:  2.5  Specify first corner: 

　 This indicates the first corner. (P1)

③ Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width/Columns]: 

　 This indicates the diagonal corner. (P2)

      A [Multiline Text] box appears.

Creating a multiline text

P1

P2

[Mtext] 326

[Text Editor] Ribbon Tab
1  Style  Specify the text style and height.

2  Formatting  Set the format for the text, such as bold, italic, underline, and overline. 
 You can also change the font and color.

3  Paragraph  You can set text alignment, line spacing, numbering and bullet points.
4  Insert  Insert symbols, columns, and fields.
5  Spell Check  Checking spelling.
6  Tools  You can search and replace, convert between upper and lower case, etc.

7  Options  Controls the display of the editor’ s ruler. 
 Allows you to set the character set (language selection) and editor settings.

8  Close  Close [Text Editor].

[Text Editor] Ribbon Tab1

[Column Settings] panel2

Column Settings

1  Dynamic columns  This is set according to the length of the text string. 
 You can adjust the height automatically or manually.

2  Static columns  Specify the overall width and height, as well as the number of columns. 

3  No columns  Specifies that the current [Multiline Text] should not be set in columns.

④ Type in the text.  

　 The size and style of the text will be displayed according to the format settings.

⑤ You can change the size of the [Multiline Text] box using your mouse. 

　 Move your mouse left and right to change the width of the box. (Red circle)

⑥ If you move the mouse up and down, you can change the height of the box. (Red circle)

3 4 5 61 2 7 8

3

1

2
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 Ribbon Menu  [ Annotate ] tab -> [ Tables ] panel -> Table
 Pulldown menu  [ Draw ] -> Table
 Command  Table

① Select [Tables] panel -> [Table]. 

     The [Insert Table] dialog box will appear. 

　 Enter <5> for [Columns] and <3> for [Data rows], then click the [OK] button.

Create a table

Set the table style

② The table will be inserted into the drawing. 

     Change the text style, text size, etc. from [Text Editor].

③ Insert text and pictures into the table.  

　 You can change the number of rows and columns later.

[Table]

1

2

TableTable

27
① Set the table style from the [Insert Table] dialog box. 

      The default for Table style is <Standard>. 

② Press the button on the right of the [Table style] (red circle) and modify the items in the dialog box 

　 that appears, or press  button to create a new table style.

Title

Header

Data

③ Select , enter the new style name as <Furniture list>, and click  .

④ Set the style in the [New Table Style] dialog box.

[New Table Style] dialog
1  This is used as a new table style. You can also select the default table style.
2  Specify whether the table should be oriented Up or Down. (The default is “Down” )
3  You can check the appearance of the table in a preview.
4  Select the items you want to edit from [Title], [Header], and [Data].
5  Edit the properties of [Title], [Header], and [Data] cells.
6  Specify the margins for [Title], [Header], and [Data] cells.

3

4

5

6

1

2
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[General]
 Fill color  Specify a background color for the cell
 Alignment  Set the alignment of the text in the cell.
 Format  Select a data type.

[Text]
 Text style  Set the text style.
 Text height  Set the height of the text.
 Text color  Set the color of the text.
 Text angle  Set the angle of the text.

[Borders]
 Lineweight  Set the Lineweight of the border line.
 Linetype  Set the Linetype of the border line.
 Color  Set the Color of the border line.
 Double line  When checked, it becomes a double line.

⑤ Select [Data] from [Cell Styles]. The same settings apply to the other [Title] and [Header].

⑥ Set the [General] tab.

⑦ Set the [Text] tab.

⑧ Set the [Borders] tab.

・You can create multiple table styles, but only one can be set as the current table style. 

・A table style named “Standard” already exists in a new drawing. 

・Changing the table style updates the style of any tables that use it. 

・Table styles are saved in the drawing file, just like text styles and dimension styles. 

・You can set the table style to be used in a drawing template in advance. 

・You can copy table styles from [Design Center] or [Tool Palette].

Change the height and width of the table3
① When you select a table, blue marks will appear as shown in the image below. 

　 You can change the size of the rows and columns, and expand or shrink the width of each cell.

1  Move the entire table.
2  The height of each cell is expanded or contracted in the downward direction.
3  The width of each cell is expanded or contracted in the right direction.
4  The height and width of each cell will expand and contract to the same size.
5  The width of each column is expanded or contracted individually.
6  When the blue triangle is facing up, you can split the table.

② Click on the lower right corner of the table ( 4 ) with your mouse to expand and contract it.

③ If you select the blue square in the cell, you can individually expand or shrink the width of the cell.

④ Click on the blue mark in the rightmost cell with your mouse to expand or contract it.

⑤ Only the rightmost column of cells has expanded horizontally.

TableTable

4

3

4

1

2

5

6

5 55

Point!
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Edit each cell in the table individually4
① Clicking the mouse in the table displays the [Table Cells] ribbon tab. 

　 (Double-click to display the [Text Editor] ribbon tab.)

Enter text in each cell in the table5
① Double-clicking in the table displays the [Text Editor] ribbon tab.

[Table Cell] Ribbon Tab
1  Insert Above  Adds a new row above the selected cell.
2  Insert Below  Adds a new row below the selected cell.
3  Delete Row(s)  Delete a row of selected cell.
4  Insert Left  Adds a column to the left of the selected cell.
5  Insert Right  Adds a column to the right of the selected cell.
6  Delete Column(s)  Delete a column of selected cell.
7  Merge Cells  Merge selected cells.
8  Unmerge Cells  Restore merged cells to their original state.

9  Match Cell  Copy cell properties.
10  Middle Center  Determines the position of text in a cell.
11  Cell Locking  The contents of the cell are not changeable.
12  Data Format  Specifies the data format of the cell.
13  Block  Insert a block in a cell.
14  Field  Insert a field in a cell.
15  Formula  Insert a formula in a cell.

② Change the background color of table title. 

　 Click on the title cell, select [Background Fill] from the right mouse button,  

　 and select color “9” from the [Select Color] dialog box.

③ Combines multiple cells. 

　 Select the cells you want to combine using the cross selection. (P1 - P2)

P1

P2

④ If you select [Merge] -> [All] from the right-click menu, the selected cells will be merged into one cell.

⑤ Press the right button and then the [Unmerge] to break the link and return to the original cell.

② You can enter text and numbers in the same way as when entering Multiline Text.

TableTable

3 4 5 61 2 7 8 9 10 11 12 13 14 15
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[Field] Dialog Box
① Select [Data] panel -> [Field]. 

　 The [Field] dialog box will appear. 

　 Select <CreateDate> from the [Field names] list. 

　 Select the topmost format from the [Sample] list.

1

 Ribbon Menu  [ Insert ] tab -> [ Data ] panel -> Field
 Pulldown menu  [ Insert ] -> Field
 Command  Field

[Field]

② Specify start point or [Height/Justify]: 

     Decide where to insert the date and the text height. 

     The date of creation will be inserted. 

 

③ Field text is automatically updated on the day when the drawing is saved after being changed.

Field

28

3 Enter the date in the [Date of creation] box in the title column

The [FIELD] command creates <text> and <multiline text> objects that can be automatically updated  

in response to changes in the field values. 

Fields can be inserted into all types of annotation objects except geometric tolerancing.

① Updated when the drawing is opened.  

② Updated when the drawing is saved. 

③ Updated when printing. 

④ Updated when creating e-Transmit. 

⑤ Updated when the [Regen] command is executed.

2 Timing of field updating

Field

[Options] -> [User Preferences] -> [Fields] 

-> [Field Update Settings] to set.

[Field] Dialog Box
①  Field category  The field names that can be included are displayed.

②  Object type
 A list of objects that can be used in drawings is displayed. 

 If there are no applicable objects, they will not be displayed.

③  Preview  The format for displaying <text> and <multiline text> is displayed.

1 2 3

<Object type> in [Field category]



206 207

Chapter 5 【Draw Functions】 Chapter 5 【Draw Functions】

Cr
ea

tio
n 

Fu
nc

tio
ns

Cr
ea

tio
n 

Fu
nc

tio
ns

Field Field

When the scale of the layout placed in the layout space is changed, field text is inserted so that the scale 

text is also automatically changed. 

① The scale of the layout diagram below is <1:100> 1 ,  

　 but [field text] will be inserted at the bottom of this layout. (Position 2  in the red frame)

4 Inserting field text into the layout scale.

② Select [Text] panel -> [Single Line]. 

　 After entering the <height> and  

　 <rotation angle>, display the shortcut  

　 when entering text, and select [Insert Field].

③ Select <Object> from the [Field category]. 

④ Press the [Select object] button<(Fig.1) red circle> next to [Object type]  

　 to select the layout frame.<(Fig.2) red circle>

(Fig.1) (Fig.2)

⑤ Select <Custom scale> for [Object type] and <Use scale name> for [Format]. (Fig.3) 

　 <1:100> is displayed in [Preview]. Press the [OK] button. 

⑥ The field text <1:100> has been created at the bottom of the layout. (Fig.4)

(Fig.3) (Fig.4)

⑦ Select the layout frame to display the properties. <Red circle in Fig.5> 

⑧ Change the [Annotation scale] of the property to <1:50>. (Fig.6)

(Fig.5) (Fig.6)

⑨ Immediately after the change, the field text <1:100> has not yet been changed. (Fig.7)

⑩ When you [Save] or [Regen], the field text will change to <1:50>. (Fig.8)

12

(Fig.7) (Fig.8)
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Field

The [Title] in the drawing properties is linked to the title column. 

① Select [Application Menu] -> [Drawing Utilities] -> 

　 [Drawing Properties].

② In the [Summary] tab, enter <Autodesk> in the [Title] box  

　 and click the [OK] button.

5 Insert the title of the drawing in the title column

③ The text in the [Title] box is inserted as field text in the title column.

④ When entering text, select [Insert Field] from the shortcut menu. 

⑤ Choose <Title> from [Field names] and <Lowercase> from [format]. (Fig.1)

⑥ The field text <autodesk> has been inserted into the title column. (Fig.2)

(Fig.1) (Fig.2)

⑦ Change the [Title] on the [Summary] tab of the [Drawing Properties] to <AutoCAD>. (Fig.3) 

⑧ When you [Save] or [Regen], the field text will change from <autodesk> to <autocad>. (Fig.4)
(Fig.4)(Fig.3)

These are the commands we need to modify shapes.
How do we use the modification functions?

In this chapter,
we will learn how to modify shapes.

Chapter 6  Modify Functions

Section 1 2D shapes
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 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Erase
 Pulldown menu  [ Modify ] -> Erase
 Command  Erase

① Select [Modify] Panel -> [Erase]. 

 

② Select objects:

　 Select line S1. (Fig. 1) 

　 (The object will be displayed in a light color.) 

③ Select objects:

　 Select line S2. (Fig. 2) 

　 (The object will be displayed in a light color.) 

④ Select objects:  

⑤ The two shapes will be deleted.

S2

Modify commands options
U   Undo  Cancels object selection.
P   Previous  Reselects the last object selected.
L   Last  Select the object you created last.
R   Remove  Removes the already selected object from the selection set.
A   Add  After removing the object, select the object again.

When selecting a shape using a modification command such as the erase command, 

you can use the options in the table below. 

Even if the shortcut menu does not appear when you press the right button, 

you can enter it from the keyboard.

P1

P2

P1

P2

[Point] selection

[Window] Selection

[Cross] Selection

[Point] selection is a method of selecting shapes one by one  

using the mouse. 

The selected shapes are displayed in a lighter color and  

marked with an X, so you can check that they have been selected.

The [Window] is a method of selecting multiple shapes by surrounding them with the mouse. 

If you surround them from left to right, it will become a window selection. 

Only shapes that are completely contained within this window will be selected. 

In the image below, neither shape is completely contained within the box,  

so neither shape is selected.

The [Cross] selection is a method of selecting multiple shapes by surrounding them with the mouse. 

If you surround them from right to left, it will become a cross selection. 

All shapes that are partially included in this window will be selected. 

In the image below, both shapes are partially included, so both will be selected.

[Erase]1

2

3

4

EraseErase

Delete object1
(Original shapes)

(Fig.1) (Fig.2)

S1

You can also delete using the [Grip] function.

S1

Section 1 2D shapes
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 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Copy
 Pulldown menu  [ Modify ] -> Copy
 Command  Copy

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Move
 Pulldown menu  [ Modify ] -> Move
 Command  Move

① Select [Modify] Panel -> [Copy]. 

 

② Select objects:

　 Select line S1.  

③ Select objects: 

　 Right-click or   

④ Specify base point or [Displacement/mOde] :

　 Click P1.

⑤ Specify second point or [Array] <use first point as  

 　displacement>: Click  P2. 

 

⑥ Specify second point or [Array/Exit/Undo] <Exit>:　

Line S1 copys from point P1 to point P2.

The original line will also remain.

① Select [Modify] Panel -> [Move]. 

 

② Select objects:

　 Select line S1.  

③ Select objects: 

　 Right-click or  

④ Specify base point or [Displacement] :　 

　 Click P1.

⑤ Specify second point or :　 

　 Click P2.

Line S1 moves from point P1 to point P2.

The original line is not retained.

S1

P1 P2

[Move] [Copy]2 3

CopyMove

Move an object1 Copy an object1

S1

P1 P2

When ⑤ , you can also specify point P2 by entering the distance from the keyboard.

You can also move using the [Grip] function.

You can also copy using the [Grip] function.

When ⑤ , you can also specify point P2 by entering the distance from the keyboard.
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Select [Modify] Panel -> [Lengthen]. 

 

① Select an object to measure or [DElta/Percent/Total/DYnamic] 

　 <Total>:  DY  

② Select an object to change or [Undo]:　

　 Select line S1. 　

③ Specify new end point: 

　 Click P2. 

The length of line S1 will expand and contract. 

The end of the line (P1) closest to the point indicated  

by the mouse will expand and contract.

P2

Select [Modify] Panel -> [Stretch]. 

 

① Select objects: 

　 Select the area surrounding the door  

　 from right to left.   (S1-S2)

② Select objects: 

　 Right-click or   

③ Specify base point or [Displacement]  

　 <Displacement>: Click P1.　

④ Specify second point or <use first point as displacement>: 

　 Click P2. 

The length of the left and right walls is changed,  

and the door moves accordingly.

[Stretch] [Lengthen]4 5

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Lengthen
 Pulldown menu  [ Modify ] -> Lengthen
 Command  Lengthen

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Stretch
 Pulldown menu  [ Modify ] -> Stretch
 Command  Stretch

LengthenStretch

Stretch an object1 Change the length of an object1

P2P1

S1

S2

S1

P2

 DElta  Specify the increase or decrease in length  
 using a numerical value.

 Percent  Specify the increase or decrease in length  
 as a percentage.

 Total  Specify the overall length.

 DYnamic  You can freely expand and contract it  
 with the mouse.

P1

When ④ , you can also specify point P2 by entering the distance from the keyboard.

You can also stretch using the [Grip] function.

Point!Point!Point!
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① Select [Modify] Panel -> [Fillet]. 

 

② Current settings: Mode = TRIM, Radius = 0.0000

　 Select first object or [Undo/Polyline/Radius/Trim/ 

　 Multiple]:　Enter from the keyboard  R  

③ Specify fillet radius <0.0000>: 10  

④ Select first object or [Undo/Polyline/Radius/Trim/ 

　 Multiple]:　Select line S1. 

　

⑤ Select second object or shift-select to apply corner  

　 or [Radius]:　Select line S2.

S1

S2

When ② , you can either type <T> from the keyboard, 
or select <Trim> from the shortcut menu, 
and then select <No-trim> to leave as it is,  
as shown in the image below.

[Fillet]6

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Fillet
 Pulldown menu  [ Modify ] -> Fillet
 Command  Fillet

ChamferFillet

① Select [Modify] Panel -> [Chamfer]. 

 

② Current chamfer Dist1 = 0.0000, Dist2 = 0.0000

　 Select first line or [Undo/Polyline/Distance/Angle/Trim/

　 mEthod/Multiple]: D  

③ Specify first chamfer distance <0.0000>: 10 

 

④ Specify second chamfer distance <10>:   

⑤ SSelect second line or shift-select to apply corner or 　

　 [Distance/Angle/Method]: 

　Select line S1.

⑥ Select second line or shift-select to apply corner or 　

　 [Distance/Angle/Method]:

　 Select line S2.

[Chamfer]7

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Chamfer
 Pulldown menu  [ Modify ] -> Chamfer
 Command  Chamfer

S1

S2

Fillet two objects1 Chamfer two objects1

When ② , you can either type <T> from the keyboard, 
or select <Trim> from the shortcut menu, 
and then select <No-trim> to leave as it is,  
as shown in the image below.
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Up to ④ is the same as above.

⑤ Specify rotation angle or [Copy/Reference]:

　< -90 >    

 If the rotation is clockwise, add a “-” before  

the numerical value. 

The rotation will rotate by a numerical value from  

the center of rotation.

Rotate with the [Mouse] (Fig.1)

Rotate by a numerical value(Fig.2)

[Rotate]8

1

2

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Rotate
 Pulldown menu  [ Modify ] -> Rotate
 Command  Rotate

MirrorRotate

① Select [Modify] Panel -> [Rotate]. 

 

② Select objects:  Select pentagon S1.

③ Select objects:  Right-click or  

　　

④ Specify base point: 

　 Click P1. (Center of a pentagon)

⑤ Specify rotation angle or [Copy/Reference] <0>: R  

 

⑥ Specify the reference angle <0>:  Click P1.  

　 Specify second point: 

　 Click P2.  

 

⑦ Specify the new angle or [Points] <0>: 

　 Click P2.

S1

P2

P1

P3

① Select [Modify] -> [Mirror]. 

 

② Select objects:

　 Select chairs S1, S2 and S3.

③ Select objects:

　 Right-click or  

　　

④ Specify first point of mirror line:

　 Indicates the mid point (P1).（Fig.1）

⑤ Specify second point of mirror line:

     Indicates the mid point (P2).（Fig.2）

⑥ Erase source objects? [Yes/No] <No>: Ｎ  

⑦ The chairs (S1, S2, S3) are mirrored about the axis P1-P2

　 （Fig.3）　

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Mirror
 Pulldown menu  [ Modify ] -> Mirror
 Command  Mirror

Mirroring an object1

[Mirror]

P1

P2

9

P2
P3

S1

S2

S3

P1

（Fig.1）

（Fig.2）

（Fig.3）

To delete the original shape, 

type <Y>   at ⑥ .

S1 P2

(Fig.1)

(Fig.2)



220 221

Chapter 6 【Modify Functions】 Chapter 6 【Mody Functions】

M
od

ifi
ca

tio
n 

Fu
nc

tio
ns

M
od

ifi
ca

tio
n 

Fu
nc

tio
ns

OffsetScale

① Select [Modify] Panel -> [Scale]. 

 

② Select objects:

　 Select pentagon S1.

③ Select pentagon S1.

　 Right-click or  

④ Specify base point:

　 Click P1. (Center of a circle)

⑤ Specify scale factor or [Copy/Reference]:　  

　 Type<R> from the keyboard.

⑥ Specify reference length <1.0000>:

     Indicate the center of the circle (P1)  

　 and the vertex of the pentagon (P2).  

⑦ Specify new length or [Points] <1.0000>:

     Click P3.

　 (12 o’ clock on the circle）

The pentagon S1 is reduced so that it is inscribed  

in a circle with point P1 as the center.

S1

Change the scale with [mouse](Fig.1)

Change the scale with [number](Fig.2)

1

2

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Scale
 Pulldown menu  [ Modify ] -> Scale
 Command  Scale

[Scale]

There are two ways to specify a distance: by pointing to  

two points with the mouse, or by entering a numerical value.

① Specify offset distance or [Through/Erase/Layer] <Through>:  

　 Either click on two points with the mouse or enter the values. 

　 <10>  

② Select object to offset or [Exit/Undo] <Exit>:

　 Select line S1.

③ Specify point on side to offset or [Exit/Multiple/Undo] <Exit>:

　This indicates the offset side. (Point P1)

     It is offset by the specified distance.

Specify [passing point]

Specify [distance]

1

2

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Offset
 Pulldown menu  [ Modify ] -> Offset
 Command  Offset

[Offset]

Up to step ④ , the same as above.

⑤ Specify scale factor or [Copy/Reference]:

　 Enter the scale you want to change in numerical form. 

　 The scale will be changed using the numerical value  

　 you entered from the base point.

① Select [Modify] Panel -> [Offset].

② Specify offset distance or [Through/Erase/Layer]  

 　<Through>: 

　 Right-click or  

③ Select object to offset or [Exit/Undo] <Exit>: 

　 Select line S1.

④ Specify through point or [Exit/Multiple/Undo]  

     <Exit>: 

　 Click P1.

A line parallel to S1 and of the same length as S1  

is drawn through point P1.

1110

P1

S1

S1

P1

10

P1

P2

P3

P3

(Fig.1)

(Fig.2) Magnified by 1.5



222 223

Chapter 6 【Modify Functions】 Chapter 6 【Mody Functions】

M
od

ifi
ca

tio
n 

Fu
nc

tio
ns

M
od

ifi
ca

tio
n 

Fu
nc

tio
ns

① Select [Modify] Panel -> [Trim]. 

② Select object to trim: 

　 Type <T> on the keyboard. 

③ Select cutting edges ...

　 Select objects or <select all>:  Select line S2.

④ Select objects:  Right-click or  　

⑤ Select object to trim or shift-select to extend or

　 [cuTting edges/Crossing/mOde/Project/eRase]:

　 Select the right side of line S2 to intersect with P3-P4.　

⑥ Select object to trim or shift-select to extend or

　 [cuTting edges/Crossing/mOde/Project/eRase/Undo]: 

　 Right-click or  　 

 

The part where the line S2 intersects with P3-P4 on the right side 

will be trimmed.

Select the object to trim1

If you don’ t select [cutting edges] when you do ③ , and press the right mouse button,  

all of the displayed objects will become [cutting edges].

[Trim] [Extend]

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Extend
 Pulldown menu  [ Modify ] -> Extend
 Command  Extend

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Trim
 Pulldown menu  [ Modify ] -> Trim
 Command  Trim

1312

First, indicate the trim boundary2

S1

P1P2
① Select [Modify] Panel -> [Trim]. 

② Select object to trim: 

　 The area to be trimmed is crossed with P1-P2. 

　 The area crossed with P1-P2 is trimmed. 

③ Select object to trim: 

　 When you indicate the part to trim (S1), 

　 only that part will be trimmed.

S2

P3

P4

① Select [Modify] panel -> [Extend]. 

② Select object to extend: 

　Type <B> on the keyboard. 

③ Select boundary edges ...

　 Select objects or <select all>:  Select line S2.

④ Select objects:  Right-click or  　

⑤ Select object to extend or shift-select to trim or

　 [Boundary edges/Crossing/mOde/Project]:

　 Select line S3.　

⑥ Select object to extend or shift-select to trim or

　 [Boundary edges/Crossing/mOde/Project/Undo]: 

　 Right-click or  　 

Line S3 is extended to the leftmost line.

Select the object to extend1

First, indicate the extend boundary2

S1

P1P2
① Select [Modify] panel -> [Extend]. 

② Select object to extend: 

　 The area to be extended is crossed with P1-P2. The line crossed 　

　 with P1-P2 is extended to the upper boundary line. 

③ Select object to extend: 

　 When you indicate the part to be extended (S1), only the line  

　 you indicate will be extended to the left boundary line.

S2

S3

ExtendTrim

Point!

If you don’ t select [boundary edges] when you do ③ , and press the right mouse button, 

all of the displayed objects will become [boundary edges].

Point!
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① Select [Modify] Panel -> [Join]. 

 

② Select source object or multiple objects to join at once:

　 Select arc S1.

③ Select objects to join:

　 Select arc S2.

④ It is joined in a counterclockwise direction from S1 to S2.

① Select [Modify] Panel -> [Delete]. 

② Select object:：

　 Select circle S1.

③ Specify second break point or [First point]:

　 Press the right mouse button and select [First point].

④ Specify first break point:

　 Click P1.

⑤ Specify second break point:

　 Click P2.

S1

P1

P2 When P1 and P2 are reversed

P1
P2

[Break][BreakAtPoint] [Join]

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Join
 Pulldown menu  [ Modify ] -> Join
 Command  Join

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Break
 Pulldown menu  [ Modify ] -> Break
 Command  Break , BreakAtPoint

JoinBreak

① Select source object or multiple objects  

　 to join at once:

　 Select line S3.

② Select objects to join:

　 Select line S4.

③ Select objects to join:

　 Right-click or  

The endpoints A of line S3 and B of line S4 are joined.

Join two lines

Join two arcs1

2

Partially delete an object (Break)1

The circle is cut between P1 and P2. 

It is cut counterclockwise from the first point to 

the second point.

1514

Ａ Ｂ

S1

S2

S3

ＢＡ

S4

If you select the [cLose] option,  

the two arcs will be converted into a circle.

Split an object at a single point (BreakAtPoint)2
① Select [Modify] Panel -> [Delete]. 

② Select object:

　 Select line S2.

③ Specify break point: 

　 Indicate the midpoint (P3) of the line. 

The selected line has been divided at the midpoint P3.

S2

P3

P3

Point!Point!Point!

Point!Point!Point!
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① Type <Change> on the keyboard. 

 

② Select objects: 

　 Select circle S1.

③ Select objects:  Right-click or  

④ Specify change point or [Properties]: 

　 Select [Properties] from the shortcut menu. 

　 Or  P

⑤ Enter property to change [Color/Elev/LAyer/LType/ltScale/ 

　 LWeight/Thickness/TRansparency/Material/Annotative]: 

　 C  

⑥ New color [Truecolor/COlorbook] <BYLAYER>: red  

⑦ Enter property to change [Color/Elev/LAyer/LType/ltScale/ 

　 LWeight/Thickness/TRansparency/Material/Annotative]: 

　 Right-click or  　

The color of the circle will change from black to red.

① Select [Modify Panel] -> [Explode]. 

 

② Select object:

　 Select rectangle S1.

③ Select object:

　 Right-click or   

 

④ The rectangle has been exploded into four lines. (See the diagram below.)

[Explode] [Change]

 Ribbon Menu  None
 Pulldown menu  None
 Command  Change

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Explode
 Pulldown menu  [ Modify ] -> Explode
 Command  Explode

ChangeExplode

Change an object’ s attributes1

Explode a compound object1

1716

S1

S1

S1

S1

The image below shows a closed polyline (composite object) created using the [Rectangle] command. 

If you select part of it with the mouse, the entire rectangle will be selected.  

If you check the properties, you will see that it is a [Polyline]. 

To turn polylines and block shapes into individual objects (lines and arcs), use the [Explode] command.

The [Explode] command breaks down a [Complex Object] into  

its [Component Objects].

When the [Dynamic Input] mode is ON, 

the shortcut will be displayed.
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① Select [Properties] panel -> [Properties] 

② The [Properties] panel will be displayed.

     You can change the layer, color, line type, etc.  

　 of the selected shape.

③ Select circle S1.

④ Change the color of the circle to <red> and the radius to half. 

⑤ Press the X mark in the upper left of the panel to close  

　 the panel. 

⑥ The color and radius (diameter) of the circle have been changed.

　 At the same time, the size of the circle is also automatically 　 

　 changed.

Double-clicking [Grip] will display [Quick Properties].

① Select [Properties] panel -> [Match Properties] 

② Select source object:

     Select the red circle (S1) on the left.

③ Current active settings:  Color Layer Ltype Ltscale 

　 Lineweight Transparency Thickness PlotStyle Dim 

　 Text Hatch Polyline Viewport Table Material  

　 Multilder Center object

　 Select destination object(s) or [Settings]:

     Select <S> from the shortcut menu.

④ The [Property Settings] panel will appear as shown 

　  in the figure on the right.。 

⑤ The selected S1 shape information will be isplayed, 

　 so press the [OK] button and select the circle  

　 on the right (S2). 

　 The shape information will be changed to  

　 the same as the S1 circle.

⑥ If you do not select to change the color in the [Property Settings] panel, the color will not change.

[Properties] [MatchProp]

 Ribbon Menu  [ Home ] tab -> [ Properties ] panel -> Match Properties
 Pulldown menu  [ Modify ] -> Match Properties
 Command  MatchProp

MatchPropProperties

 Ribbon Menu  [ Home ] tab -> [ Properties ] panel -> Properties
 Pulldown menu  [ Tools ] -> [ Palettes ] -> Properties
 Command  Properties

Copy the attributes of an object to another 
object

1Modify object attributes1

1918

S1

Black dashed lineRed solid line

Original shape

S1 S2

S1 S2

Red solid line Red solid line

Red solid line Black dashed line

Red solid line Black solid line
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Rectangular Array

S1

Select [Rectangular Array] from the [Modify] panel. 

① Select objects: Select chair (S1). 

② Select grip to edit array or [ASsociative/Base point/COUnt/Spacing/ 

　 COLumns/Rows/Levels/eXit]<eXit>: 

　 Set [columns] to <3>, [Between] to <600>, [rows] to <3>,  

　 and [Between] to <600> for the ribbon tab, and then press Enter. 

③ The chairs will be placed as shown in the diagram below.

[ArrayRect] 1

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Array(Rectangular Array)
 Pulldown menu  [ Modify ] -> [ Array ] -> Rextangular Array
 Command  ArrayRect

ArrayRectArrayRect

20

[Array Creation (Rectangular Array)]
1  Type  Select the type of array. [Rectangular]
2  Columns  Specify the number of columns, between, and total distance.
3  Rows  Specify the number of rows, between, and total distance.
4  Levels  Specify the number of levels and the interval for 3D array.

5  Properties  Specifies whether the object to be arrayed is an automatically adjusted    
 object or an independent object.

6  Close  Close the [Array Creation] ribbon tab.

If you type [ARRAYCLASSIC] on the keyboard, the old-style [Array] dialog will be displayed. 

The array objects created with this command will each be separate objects.

④ Until it is finalized, you can change the values on the ribbon tabs and grips.

　 (Fig. 1) The [columns] and [rows] are being changed at the same time by moving grip 6 . 

　 (Fig. 2) The horizontal distance is changed by moving grip 4  to the right.

(Fig.1) (Fig.2)

1  [Base (Move)] Grip

2  [Distance between rows] Grip

3  [Rows] Grip

4  [Distance between columns] Grip

5  [Columns] Grip

6  [Column/Row] Corner Grip
S1

Rows

Columns

4 5

6

1

2

33 4 5 61 2

3

6

3

1

2

2
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ArrayPolarArrayPolar

P1

④ If you set [Rotate Items] in [Properties] to <ON>, the object will be copied while rotating (Fig.4)

     If you set [Rotate Items] to<OFF>, the object will be copied without rotating. (Fig.5)

[ArrayPolar]

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Array(Polar Array)
 Pulldown menu  [ Modify ] -> [ Array ] -> Polar Array
 Command  ArrayPolar

21 Polar Array1

[Array Creation (Polar Array)]
1  Type  Select the type of array. [Polar]
2  Items  Specify the number of items, between, and fill.
3  Rows  Specify the number of rows, between, and total distance.
4  Levels   Specify the number of levels and the interval for 3D array.

5  Properties  Specifies whether the object to be arrayed is an automatically adjusted    
 object or an independent object.

6  Close  Close the [Array Creation] ribbon tab.

If you type [ARRAYCLASSIC] on the keyboard, the old-style [Array] dialog will be displayed. 

The array objects created with this command will each be separate objects.

S1

Select [Polar Array] from the [Modify] panel. 

① Select objects: Select chair (S1).(Fig.1) 

② Specify center point of array or [Base point/Axis of rotation]:  Indicate the center of rotation  

　 (center of table P1), and set the [Items] of the ribbon tab to <6> and the [Between] to <60>. (Fig.2) 

　 ([Fill] will automatically become <360>.)　 

③ Six chairs were rotated and copied around the center point of the table. (Fig.3)

(Fig.1) (Fig.2) (Fig.3)

1  [Base (Move)] Grip

2  [Distance from center] Grip

3  [Angle between items] Grip

(Fig.4) (Fig.5)

S1 S1

The objects created with the [Array Creation] tab are all one combined object. 

If you use the [Explode] command, each object will become its original individual object.

1

2

3

3 4 5 61 2

6

1

2

5
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ArrayPathArrayPath

[ArrayPath]

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Array(Path Array)
 Pulldown menu  [ Modify ] -> [ Array ] -> Path Array
 Command  ArrayPath

22

Prepare the path array

The [Path Array] function arranges the selected objects along the specified path, 

copying them with dividers and measures. 

As a preparation, prepare the objects to be path arrayed and the path curve. 

 

① The right object is a Block with attributes.

② The path curve is created by creating a polyline as shown in the figure below (Fig. 1) 

　 and converting it to spline with [Edit Polyline]. (Fig.2)

1

[Array Creation (Path Array)]
1  Type  Select the type of array. [Polar]
2  Itemns  Specify the number of columns, between, and total distance.
3  Rows  Specify the number of rows, between, and total distance.
4  Levels  Specify the number of levels and the interval for 3D array.

5  Properties  Specifies whether the object to be arrayed is an automatically adjusted    
 object or an independent object.

6  Close  Close the [Array Creation] ribbon tab.

(Fig.6) Devide

(Fig.7)Measure

1  [Base (Move)] Grip

2  [Distance between items] Grip

(Fig.1) (Fig.2)

③ Place the block with attributes at a right angle to the beginning of the spline.

Select [Path Array] from the [Modify] panel. 

① Select objects: Select the block (S1). (Fig.3) 

② Select path curve: Select the spline curve (S2). (Fig.4) 

　 [Between] to <1000> for the ribbon tab, and then press Enter.  (Fig.5) 

　 (The [Total] is automatically set to<6000>.)　※ [Total] is the total distance.

(Fig.4)

(Fig.5)

(Fig.3)
S1

S2

Path Array2

You can place objects on the path curve using [Divide] or [Measure].

③ To place a divide, select [Divide] from [Properties].

　 (Fig.6) The [Items] of the [Divide] is set to <5>. The [Between] is calculated automatically.

④ To place a measure, select [Measure] from [Properties].

　 (Fig.7) The [Between] of the [Measure] is set to <1000>. The [Items] is calculated automatically.

This is an example of changing 
the attribute value of  
an [attributed block].

1

2
3 4 5 61 2
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[ArrayEdit]

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Edit Array
 Pulldown menu  [ Modify ] -> [ Object ] -> Array
 Command  ArrayEdit

23

ArrayEditArrayEdit

The array object holds the total number of items and the interval as properties. 

These properties can be edited using the [Array] ribbon tab or grip. 

 

[Edit with Ribbon Tab]

① Select the array object. (Fig. 1)

② Change [columns] to <4>, [Between] to <700>, and [Between] of [Rows] to <700>.

③ The array object has been changed. (Fig. 2)

Change Array properties1

Modify objects individually2

(Fig.1) (Fig.2)

[Edit with Grip]

① You can change the grip by moving it up and to the right. (Fig.3)

② You can also change it using the shortcut on the right button. (Fig.4)

(Fig.3) (Fig.4)

You can modify array objects individually. 

① Hold down the Ctrl key while selecting the object you want to modify. (Fig.1) 

② Press the right button to display the shortcut. (Fig.2)

(Fig.1) (Fig.2)

③ (Fig.3)The result of selecting [Erase] from the shortcut menu. 

　 (Fig.4)The result of selecting [Rotate] from the shortcut menu.

④ Even after making changes, you can return to the original state. 

　 Select [Reset Array] from [Options].

⑤ The deleted shape will return to its original state.

The object created using the [Array] command is 
a single object. 
If you use the [Explode] command,  
each object will become an individual object.

(Fig.3) (Fig.4)



238 239

Chapter 6 【Modify Functions】 Chapter 6 【Mody Functions】

M
od

ifi
ca

tio
n 

Fu
nc

tio
ns

M
od

ifi
ca

tio
n 

Fu
nc

tio
ns

ArrayEditArrayEdit

Edit [Source]3 Replace [Item]4
The array object holds the total number and spacing as properties.  

If you edit the source object, all objects will be changed. 

 

① Select the array object (Fig. 1).

② Select [Edit Source] from the [Options]  

　 on the [Ribbon] tab.

The array object holds the total number and spacing as properties.  

If you replace the source object with another object, 

only the selected object will be replaced. 

 

① Select the array object (Fig. 1).

② Select [Repalce Item] from the [Options]  

　 on the [Ribbon] tab.

(Fig.1)

(Fig.2)

(Fig.3) (Fig.4)

(Fig.5)

③ Select item in array:  Select one of the arrayed objects. (Fig.2) 

④ The [Array Editing State] dialog box will appear, so click the [OK] button.

⑤ The editing state is now active. (Only the selected object can be edited.) (Fig.3) 

⑥ Edit an object. (Fig.4)

⑦ After making the changes, select [Save Edits to Array] from the right button shortcut.

⑧ All other objects have been modified too. (Fig.5) 

③ Select replacement objects: Select the round chair (Fig. 2). 

④ Select base point of replacement objects:  This indicates the center of the round chair. (Fig.3) 

(Fig.3)(Fig.2)

⑤ Select an item in the array to replace:  Select a square chair(S1). (Fig.4) 

⑥ Continue to select the objects to be replaced. (S2 ～ S4)  (Fig.5) 

⑦ Finally, select [eXit] from the right button shortcut. (Fig.6)

⑧ Confirm by pressing the right mouse button or the [Enter] key. (Fig.7)

(Fig.5)(Fig.4)

(Fig.7)(Fig.6)

S1

S2

S3

S4

S1 S2

S3

S4

(Fig.1)
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[Pedit]

 Ribbon Menu  [ Home ] tab -> [ Modlfy ] panel -> Edit Polyline
 Pulldown menu  [ Modify ] -> [ Object ] -> Polyline
 Command  Pedit

24

① Select [Modify] Panel -> [Edit Polyline]. 

 

② Select polyline or [Multiple]:

　 Select Polyline S1.

③ Enter an option [Close/Join/Width/Edit vertex/Fit/　

　 Spline/Decurve/Ltype gen/Reverse/Undo]: 

     F 

Converting polylines to fit curves1

PeditPedit

S1

① Select [Modify] Panel -> [Edit Polyline]. 

 

② Select polyline or [Multiple]:

　 Select Polyline S1.

③ Enter an option [Close/Join/Width/Edit vertex/Fit/　

　 Spline/Decurve/Ltype gen/Reverse/Undo]: 

　 S 

Converting polylines to spline curves.2

① Enter an option [Close/Join/Width/Edit vertex/Fit/　

　 Spline/Decurve/Ltype gen/Reverse/Undo]:  

 　D 

Delete a curve.3

It returns to the original polyline.

① Select [Modify] Panel -> [Edit Polyline]. 

 

② Select polyline or [Multiple]:

　 Select line S1.

Converting lines and arcs to polyline4

S1

③ Object selected is not a polyline

　 Do you want to turn it into one? <Y>  

 

④ Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/ 

　 Reverse/Undo]:  J  

 

⑤ Select objects:Select the other line and the two arcs with the mouse. (P1 - P2)

⑥ 3 segments added to polyline.

P1

P2

⑦ When selected in [Properties], it is converted to a polyline.  

　 (You can check the Area and Length.)

[Modify] Panel -> [Explode] command 
will return the lines and arcs to their original state.
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BEditBEdit

 Ribbon Menu  [ Insert ] tab -> [ Block Definition ] panel -> Block Editor
 Pulldown menu  [ Tools ] -> Block Editor
 Command   BEdit

[BEdit]25

② Select [Block Definition] panel -> [Block Editor]. 

③ From the [Edit Block Definition] dialog, select <CHAIR_1>.

Edit block1

④ Modefy the left block [CHAIR_1] as shown in the image on the right. 

⑤ Press the right button and select [Close Block Editor] from the shortcut menu. 

　 Alternatively, select [Close] from the [Block Editor] ribbon tab.

① We will edit the chair (CHAIR_1) shown in the figure below.
⑥ Choose [Save the change to CHAIR_1] to exit.

⑦ All of the same blocks <CHAIR_1> have been changed to new blocks.
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EAttEditEAttEdit

 Ribbon Menu  [ Insert ] tab -> [ Block ] panel -> Edit Attribute
 Pulldown menu  [ Modify ] -> [ Object ] -> [ Attribute ] -> Block Attribute Manager
 Command  EAttEdit

[EAttEdit]26

② Select [Insert] tab -> [Block] panel -> [Edit Attribute]. 

　 Select a block: Select [Column A] in the lower left.

Edit the attribute value already entered1

③ The [Enhanced Attribute Editor] dialog box will appear.

　 Change the <20000> in the [Value] field on the [Attribute] tab to <30000>  

　 and click the [OK] button. 

　 The value of the selected [Column A] will change to [30000].

Only the value of the selected [Column A] will be changed.

Edit the attribute values you have already entered in [Properties]2
① Select the [Home] tab -> [Properties] panel -> [Properties]. 

　 Select [Column A] in the lower left.

② Change the [price] attribute of the [property] to <30000>. 

　 You can also change other items,  
　 but you can only change the items with white text.  
　 You cannot change the items with light-colored text.

To change the attribute definitions of  
the same block attributes at once,  
use [Block Definition] -> [Synchronize].

① The following diagram shows the placement of the columns [Column A] and [ColumnB],  

　 have already been defined.

Column A

Column B
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TextEditTextEdit

① Type [Ddedit] on the keyboard. 

 

② Select an annotation object or [Undo/Mode]: 

 　Select a character<1:100>.

③ If the selected text is a single line text, you can edit it directly as shown in the image below.

Double-clicking the text you want to change will have the same effect.

[Ddedit][TextEdit]

 Ribbon Menu  None
 Pulldown menu  [ Modify ] -> [ Object ] -> [ Text ] -> Edit
 Command  Ddedit、TextEdit

To change items other than the text (size, layer, color),  
use the [Properties].

Edit a single line text1

27

There are five items that can be changed.

① Type [Ddedit] on the keyboard. 

 

② Select an annotation object or [Undo/Mode]:

　Select the text<Floor Plan>.

③ If the selected text is multiline-text, the [Text Editor] context tab will be displayed. 

　 Change the text and press [Close Text Editor].

Edit a multiline text2

You can also use [Properties] to change items  
other than the text (size, layer, color).

[Inplace Text Editor]
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HatchEdit

① Select [Modify] Panel -> [Edit Hatch]. 

② Select hatch object:

　 Select a hatch object (S1). 

③ [Hatch Edit] dialog box is displayed. 

④ Check the [Double] box under [Angle and Scale], 　

　 and then click the [OK] button.

[HatchEdit]

 Ribbon Menu  [ Home ] tab -> [ Modify ] panel -> Edit Hatch
 Pulldown menu  [ Modify ] -> [ Object ] -> Hatch
 Command  HatchEdit

Edit a hatch object1

28

S1

⑤ The hatch object is corrected.

HatchEdit

When there are other areas within the hatching, you can decide  

whether to hatch everything or exclude the inner area. 

① Select [Hatch] from the [Draw] panel.

② The [Hatch Creation] ribbon tab will appear. 

③ Select a hatch pattern from [Pattern]. (Example: USER) 

④ From [Properties], specify the [Angle], [Scale], and other settings. 

⑤ (Fig.1)Select [Normal Island Detection] or [Outer Island Detection] from [Options].

　 (Fig.2)Select [Ignore Island Detection] from the [Options]. 

⑥ Click inside the hatching area with the mouse. 

⑦ Clicking the right button will create the hatch.

Hatching: island within an area2

(Fig.1) (Fig.2)

(Fig.1)

(Fig.2)

Hatching If there is text in the area,  
select [Normal Island Detection] or [Outer Island Detection].

[Ignore Island Detection][Normal Island Detection] or [Outer Island Detection]

First, when you select a hatch object, 

the [Hatch Editor] ribbon tab will be 

displayed.
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HatchEdit

Hatching will fail if the area is not completely closed. 

However, if you set the tolerance, you can hatch even if it is slightly off,  

as long as it is within the tolerance range. 

① If you apply hatch to  (Fig.1), an error message will be displayed as shown in (Fig.2).

Set the tolerance for hatching3

(Fig.1) (Fig.2)

② If you enlarge (Fig.1), you can see that the top right is slightly open, 

　 as in (Fig.3). 

　 This is why the [Boundary Definition Error] was displayed.

③ Select [Gap Tolerance] from the [Options] tab of the [Hatch Creation] ribbon.

　 The initial value for the tolerance is <0>, so change it to <2>.

(Fig.3)

④ If you apply hatching again, [Open Boundary Warning] (Fig. 4) will be displayed.

⑤ Select [ → Continue hatching this area] to create the hatch as shown in (Fig.5).

(Fig.4) (Fig.5)

[Gap Tolerance] can be specified in units of <1 to 5000>.

It is important to add dimensions to the figures you draw.
What types of dimensions can we add in AutoCAD?

In this chapter,
we will introduce the dimension command.

Chapter 7  Dimension Functions

Section 1 Input dimensions

Section 2 Multileader

Section 3 Edit dimensions
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 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Dimension
 Pulldown menu  None
 Command  Dim

Select [Dimensions] -> [Dimension] -> [Ordinate].

① Specify feature location:  

     Indicate the center of the circle (P1). 

② Specify leader endpoint:

　 Indicate the position (P2) where you want to place it. 

③ Dimension text = 146.2  

[Dimension] -> [Ordinate]

[Dim]2

2

DimTypes of dimensions

Types of dimensions
1  Continue  Continuous dimensions ending from the immediately preceding dimension.

2  Baseline  Continuous dimensions starting from the immediately preceding dimension.

3  Angle  Measure the angle between two selected objects or between three points.

4  Radius  Measure the radius of the selected circle or arc.

5  Diameter  Measure the diameter of the selected circle or arc.

6  Ordinate  Measure the horizontal or vertical distance from the starting point.

7  Leader  Consists of arrows, lines, text and blocks.

Types of dimensions1

The dimensions include [Linear dimension], [Aligned dimension], [Angular dimension],  

[Arc Length dimension], [Radius dimension], [Diameter dimension], [Jogged dimension],  

and [Ordinate dimension] etc.

 The [Dimension] command allows you to select multiple dimension commands.

Select [Dimensions] -> [Dimension] -> [Angular].

① Select arc, circle, line or [Vertex]:  

     Select line S1. 

② Select line to specify second side of angle:

　 Select line S2. 

③ Specify angular dimension location: 

　 Left-click at the appropriate position to confirm.

[Dimension] -> [Angular]1

S1

S2

P1

×

P2

Types of dimensions

4

5

6

7
1

2

3

6
Enter the angle of three points or 

the angle of two line.

Enter the Ordinate dimensions.

Section 1 Create dimensions
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DimDim

Select [Dimensions] -> [Dimension] -> [Continue].

① Specify first extension line origin to continue:  

     Select the extension line S1. 

② Specify second extension line origin:

　This indicates the end point (P1). 

③ Dimension text = 25  

[Dimension] -> [Continue]3

[Dimension] -> [Baseline]4

Select [Dimensions] -> [Dimension] -> [aliGn].

① Select base dimension: 

     Select dimension line S1. 

② Select dimensions to align:

　 Select dimension line S2.

[Dimension] -> [aliGn]5

[Dimension] -> [Distribute]6

S1

P1

Select [Dimensions] -> [Dimension] -> [Baseline].

① Specify first extension line origin as baseline or [Offset]:  

     Select the extension line S1. 

② Select objects or specify first extension line origin 

 　This indicates the end point (P1). 

③ Dimension text = 65  

S1

P1

S1

Select [Dimensions] -> [Dimension] -> [Distribute].

① Specify method to distribute dimensions [Equal/Offset] <Equal>:  

     Select dimension line S1. 

② Select dimensions to distribute:

　 Select dimension line S2 and S3.

S2

S1
S2

S3

[Equal] will reposition three or more 
dimension lines at equal intervals.

The dimension line is aligned with 

the selected dimension line.

Enter the dimension from  

the second dimension extension line 

of the selected dimension.

Enter the dimension from  

the first dimension extension line  

of the selected dimension.
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P1
×

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Quick
 Pulldown menu  [ Dimension ] -> [ Quick Dimension ]
 Command  Qdim

Select [Dimensions] -> [Quick].

① Select geometry to dimension:

     Select line S1. 

② Select geometry to dimension: 

　 Select line S2. 

③ Select geometry to dimension:  

④ Specify dimension line position: 

　 Use the mouse to specify the position (P1) 　

　 where you want to place the dimension.

P1
×

[Continue Dimension (select one at a time)]

[Qdim] Quick3

1

Qdim Qdim

Select [Dimensions] -> [Quick].

① Select geometry to dimension:

      Select line S1. 

② Select geometry to dimension:

      Select line S2. 

③ Select geometry to dimension:  

④ Press the right button and select 

　 [Baseline] from the shortcut. 

⑤ Specify dimension line position: 

　 Use the mouse to specify the position (P1) 　

　 where you want to place the dimension.

[Baseline Dimension (select one at a time)]3

Select [Dimensions] -> [Quick].

① Select geometry to dimension:

     Use the mouse to select the shapes  

　 from right to left (P1 - P2) 

② Select geometry to dimension:  

③ Specify dimension line position: 

　 Use the mouse to specify the position (P3) 　

　 where you want to place the dimension.

[Continue Dimension (select all at once)]2

[Baseline Dimension (select all at once)]4

[Radius / Diameter]5

S1

S2S2

P3
×

P1

P2

S1

S2

Select [Dimensions] -> [Quick]. 
① Select geometry to dimension:

     Use the mouse to select the shapes  

　 from right to left (P1 - P2) 

② Select geometry to dimension:   

③ Press the right button and select 

　 [Baseline] from the shortcut. 

④ Specify dimension line position: 

　 Use the mouse to specify the position (P3) 　

　 where you want to place the dimension.

P3
×

P1

P2

P1

P2

[Select [Dimensions] -> [Quick].

① Select geometry to dimension: 

     Use the mouse to select the shapes  

　 from right to left (P1 - P2) 

② Select geometry to dimension:   

③ Press the right button and select 

　 [Radius] or [Diameter] from the shortcut. 

④ Specify dimension line position: 

　 Use the mouse to specify the position  

　 where you want to place the dimension.

Radius Diameter
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Chapter 7 【Dimension Functions】

P1 P2
× ×

① Specify first extension line origin or <select object>:   

② Select object to dimension:

　 Select line S1.

③ Specify dimension line location or [Mtext/Text/Angle/Horizontal/Vertical/Rotated]:  　

     Move the mouse to the position where you want to enter  

　 the dimension, and click the left mouse button to confirm.

Select [Dimensions] -> [Linear].

① Specify first extension line origin or <select object>:　

　 Indicate point P1.

② Specify second extension line origin: 

　 Indicate point P2.

③ Specify dimension line location or

　 [Mtext/Text/Angle/Horizontal/Vertical/Rotated]:　

     Move the mouse to the position where you want to enter  

　 the dimension, and click the left mouse button to confirm.

Indicate two points and enter the Linear dimension

Select a shape and enter the Linear dimension

S1

2

1

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Linear
 Pulldown menu  [ Dimension ] -> Linear
 Command  DimLinear

[DimLinear]4

DimLinear

Select [Dimensions] -> [Aligned].

① Specify first extension line origin or <select object>:　

　 Indicate point P1.

② Specify second extension line origin:

　 Indicate point P2.

③ Specify dimension line location or [Mtext/Text/Angle]:

　 Dimension text = 30

　 Move the mouse to the position where you want to 　

　 enter the dimension, and click the left mouse button  

　 to confirm.

Indicate two points and enter the Aligned dimension

① Specify first extension line origin or <select object>: 

② Select object to dimension:

　 Select line S1.

③ Specify dimension line location or [Mtext/Text/Angle]:

　 Dimension text = 20　

     Move the mouse to the position where you want to 　

　 enter the dimension, and click the left mouse button  

　 to confirm.

Select a shape and enter the Aligned dimension

×
P1

×P2

S1

1

2

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Aligned
 Pulldown menu  [ Dimension ] -> Aligned
 Command  DimAligned

[DimAligned]5

DimAligned
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Chapter 7 【Dimension Functions】

Select [Dimensions] -> [Radius].

① Select arc or circle: 

     Select circle S1. 

② Dimension text = 20

　Specify dimension line location or [Mtext/Text/Angle]: 

　Move the mouse to the position where you want to 

　enter the dimension, and click the left mouse button  

　to confirm.

Enter the [radius dimension] of the circle

① Select arc or circle: 

     Select arc S1.

② Dimension text = 10 

　 specify dimension line location or [Mtext/Text/Angle]: 

　 Move the mouse to the position where you want to 　  

　 enter the dimension, and click the left mouse button  

　 to confirm.

S1

Enter the [radius dimension] of the arc

S1

According to the position of the dimension value, 

the shape of the dimension line will also change.

1

2

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Radius
 Pulldown menu  [ Dimension ] -> Radius
 Command  DimRadius

[DimRadius]6

DimDiameterDimRadius

Select [Dimensions] -> [Diameter].

① Select arc or circle: 

     Select circle S1.

② Dimension text = 40

　 Specify dimension line location or [Mtext/Text/Angle]: 

　 Move the mouse to the position where you want to 　

　 enter the dimension, and click the left mouse button  

　 to confirm.

Enter the [diameter dimension] of the circle

① Select arc or circle: 

      Select arc S1.

② Dimension text = 20

　 specify dimension line location or [Mtext/Text/Angle]: 

　 Move the mouse to the position where you want to 　  

　 enter the dimension, and click the left mouse button  

　 to confirm.

Enter the [diameter dimension] of the arc

1

2

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Diameter
 Pulldown menu  [ Dimension ] -> Diameter
 Command  DimDiameter

[DimDiameter]7

S1

S1

According to the position of the dimension value, 

the shape of the dimension line will also change.
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Chapter 7 【Dimension Functions】

① Select arc, circle, line, or <specify vertex>:   

 　Select arc S1.

② Specify dimension arc line location or  

　 [Mtext/Text/Angle/Quadrant]: Dimension text = 60 

　 Left-click at the position where you want to display  

　 the dimension.

① Select arc, circle, line, or <specify vertex>:  

② Specify angle vertex: Indicate point P0.

③ Specify first angle endpoint: Indicate the endpoint P1. 

④ Specify second angle endpoint: Indicate the endpoint P2.

⑤ Specify dimension arc line location: 

　 Left-click at the position where you want to display  

　 the dimension.

Specify the vertex of a corner

Select an arc

Select [Dimensions] -> [Angular ].

① Select arc, circle, line, or <specify vertex>:   

 　Select line S1.

② Select second line: 

　 Select line S2.

③ Specify dimension arc line location or [Mtext/Text/Angle/

　 Quadrant]: Dimension text =30

　 Move the mouse to the position where you want to 　  

　 enter the dimension, and click the left mouse button  

　 to confirm.

Select two lines

S1

S1

S2

P0

P1

P2
×

×

×

1

2

3

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Angular
 Pulldown menu  [ Dimension ] -> Angular
 Command  DimAngular

[DimAngular]8

DimAngular

Select [Dimensions] -> [Arc Length ].

① Select arc or polyline arc segment:

　 Select arc S1.

Select an arc

② Specify arc length dimension location, or [Mtext/Text/Angle/Partial/Leader]:

　 Dimension text =61.63　 

　 Left-click at the position where you want to display the dimension.

③ This is what the diagram below looks like.

S1

1

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Arc Length
 Pulldown menu  [ Dimension ] -> Angular
 Command  DimArc

[DimArc]9

DimArc

The position of the [Arc length 

symbol] is set in the [Symbols 

and Arrows] of the [Dimension 

Style Manager].
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DimOrdinate

Select [Dimensions] -> [Ordinate ].

① Specify feature location:　

      Indicate point P1. 

② Moving the mouse horizontally will fill in the Y coordinate, 

　 and moving it vertically will fill in the X coordinate.

③ Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/

　 Angle]: Dimension text = 100

　 Move the mouse in the direction of the coordinate you 　

　 want to enter, and click the left mouse button to confirm.

① Specify feature location:　

     Indicate the center point P1 of the circle.

② Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/

　 Angle]:  Y  

③ Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/

　 Angle]:

④ Dimension text = 50

     Move the mouse in the direction of the coordinate  

　 you want to enter (P2),  

　 and click the left mouse button to confirm.

Fill in using the option

Fill in the [Ordinate]
Vertical direction (X-coordinate)

P1
(X = 100 , Y = 50)

P1

P2

1

2

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Ordinate
 Pulldown menu  [ Dimension ] -> Ordinate
 Command  DimOrdinate

[DimOrdinate]

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Jogged
 Pulldown menu  [ Dimension ] -> Jogged
 Command  DimJogged

[DimJogged]

DimJogged

11

Fill in [Jogged] for the arc

Select [Dimensions] -> [Jogged ]. 
① Select arc or circle: 

　 Select arc S1.

1

P1

S1

② Specify center location override:  
　 This indicates the center position P1  
　 of the dimension line.

③ Dimension text = 50
　 Specify dimension line location or [Mtext/Text/　
　 Angle]: 
　 Indicate the position P2  
　 where the dimension line will be placed.

P2

④ Specify jog location: 
　 This indicates the position P3  
　 where the dimension line should be folded.

P3

⑤ As shown in the figure below, [Jogged] is created.

10

When specifying the endpoint of a leader,  

the leader will have a step depending on  

the position of the mouse cursor. 

If you set it to [Ortho Mode], the leader will be straight.

Horizontal direction (Y-coordinate)

P1
(X = 100 , Y = 50)

(Ortho Mode)
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Chapter 7 【Dimension Functions】

[Select [Dimensions] -> [Baseline]. 

① The dimension is already drawn.

Fill in the [Baseline Dimensions]

To fill in the [Continue dimension], first enter the basic dimension in the [Linear dimension] ,  

and then use the [Continue] command to specify the following points.

P1

1

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Baseline
 Pulldown menu  [ Dimension ] -> Baseline
 Command  DimBaseline

[DimBaseline]

DimBaselineDimContinue

Fill in the [Continue Dimensions]

To fill in the [Baseline dimension], first enter the basic dimension in the [Linear dimension] ,  

and then use the [Baseline] command to specify the following points.

[Select [Dimensions] -> [Continue]. 

① The dimension is already drawn.

1

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Continue
 Pulldown menu  [ Dimension ] -> Continue
 Command  DimContinue

[DimContinue] 13

P2

② Specify second extension line origin or [Select/Undo] 

　 <Select>:　

     The last dimension auxiliary line S1 is automatically 　

　 selected. Indicate P1. 

　 The dimension value is automatically displayed.

③ Then, indicate P2. 

　 The dimensions will be displayed automatically.

④ Specify second extension line origin or [Select/Undo] 

　 <Select>:

　 Press the Enter key to finish.

P1

② Specify second extension line origin or [Select/Undo] 

　 <Select>:　

      The last dimension auxiliary line S1 is automatically 

　  selected. Indicate P1. 

　  The dimension value is automatically displayed.

③ Then, indicate P2. 

　 The dimensions will be displayed automatically.

④ Specify second extension line origin or [Select/Undo] 

　 <Select>:

　 Press the Enter key to finish.

12

S1

S1

P2
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Point!

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Tolerance
 Pulldown menu  [ Dimension ] -> Tolerance
 Command  Tolerance

[Tolerance]14

Sym Tolerance1 Datum1 Datum2 Datum3

Datum  
Identifier

Height

Fill in the [Geometric Tolerance]1

① Type [leader] on the keyboard. 

② Specify leader start point: 

　 Indicate the starting point of the leader P1. 

③ Specify next point: 

　 Indicate the second point P2.

Add geometric tolerance to the leader2

ToleranceTolerance

[Select [Dimensions] -> [Tolerance]. 

① Enter symbols and values in the [Geometric Tolerance] dialog box that appears.

② Indicate the [Sym] column and select a symbol from the [Symbol Table]. 

③ Insert a diameter symbol in the [Tolerance] field and enter the tolerance value. (e.g. <0.125>) 

④ Insert the character (e.g. <ABC>) that indicate the datum in the [Datum1][Datum2][Datum3] fields. 

⑤ Insert the symbol from [Material Condition] into the box on the right. 

⑥ Enter a number in the [Height] box and a sign in the [Datum Identifier] box. 

⑦ Press the [OK] button and specify the insertion position on the drawing.

(Fig.1)

P1

P2

P1

P2

④ Specify next point or [Annotation/Format/Undo] <Annotation>: A  

⑤ Enter first line of annotation text or <options>:  

⑥ Enter an annotation option [Tolerance/Copy/Block/None/Mtext] <Mtext>: T  

⑦ Enter symbols and values in the [Geometric Tolerance] dialog box. (Fig.1)

⑧ Click the [OK] button to close the dialog box. 

⑨ Geometric tolerances are connected to the leader.

Point!

Tolerance Symbol Material Condition
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[CenterLine]

 Ribbon Menu  [ Annotate ] tab -> [ Centerlines ] panel -> 
 Pulldown menu  None
 Command  CenterLine

CenterMark

[CenterMark]

 Ribbon Menu  [ Annotate ] tab -> [ Centerlines ] panel -> Center Mark
 Pulldown menu  None
 Command  CenterMark

1615

Draw the [Center Mark]

Select [Centerlines ] -> [Center Mark]. 

① Select circle or arc to add center mark: 

　 Select circle S1. 

② The center line is automatically drawn. (Fig.2)

1

The Center Mark is an auto-adjustment object. 

If you modify the associated object, the Center Mark will also be adjusted automatically.

The  is an auto-adjustment object. 

If you modify the associated object, the  will also be adjusted automatically.

S1

(Fig.1) (Fig.2)

Stretching and shrinking the length of the [Center Mark]

① Grip the arrow on the Center Mark to change  

　 the length. (Fig.1) 

② You can change the values in the properties. (Fig.2) 

③ As you change the size of the circle (Fig. 3),  

　 the length of the Center Mark will automatically 　

　 expand and contract to match the circle. (Fig.4)

2
(Fig.1)

(Fig.2)

(Fig.3) (Fig.4)

Draw the [CenterLine]

Select [Centerlines ] -> [CenterLine]. 

① Select first line: Select a vertical line S1. 

② Select second line:  Select a vertical line S2. (Fig.1) 

③ As shown in (Fig. 2), a center line is automatically drawn between S1 and S2.

1

S1

(Fig.1) (Fig.2)

Stretching and shrinking the length of the [CenterLine]

① Grip the arrow on the CenterLine to change  

　 the length. (Fig.1) 

② You can change the values in the properties. (Fig.2) 

③ If you move the right edge to the left (Fig. 3),  

　 the position of the centerline will also  

　 automatically move to the left. (Fig.4)

2
(Fig.1)

(Fig.2)

(Fig.3) (Fig.4)

S2

CenterLine

X is the diameter of a circle

Gap

Size
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1

[MleaderStyle]1

MleaderStyle

Multileader Style settings

 Ribbon Menu  [ Annotate ] tab -> [ Leaders ] panel -> Multileader Style Manager
 Pulldown menu  [ Format ] -> Multileader Style
 Command  MleaderStyle

MleaderStyle

Dialog Box Launcher

① The [Multileader Style Manager] dialog box will appear. 

　 Press the [Modify] button to edit the Multileader Style.

The styles are displayed in a list. 
The current style is highlighted. 
 
There are two types:  
[Standard] and [Annotative].

② [Leader Format] tab 

　 1 Select Type of Leader (Straight, Spline, None) 

　　You can also set the line Color, Linetype and Lineweight.

　 2 Specify the Symbol and Size of the Arrowhead.

②

1

2

③ [Leader Structure] tab 

　 1 [Constraints] specifies the number of times the line is bent.

　 2 In [Landing Sttings], you can specify whether or not to use a Landing and its length.

　 3 In [Scale], specify the scale for the Multileader. 

　　 Normally, you specify the reciprocal of the scale you want to print.

Landing included

No Landing
3

1

2

④ [Content] tab 

　 1 The [Multileader type] specifies the type of text to be connected to the leader line. 

　 2 The [Text Options] specifies the text style, color and size.

　 3 The [Connecting dashes] specifies how to connect the text and landing.

[Middle of top line] [Underline top line]

Multitext

Block

3

1

2

Section 2 Multileader
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Mleader

Create a multileader

Select [Leaders] -> [Multileader]. 
① Specify leader arrowhead location or [pre enter Text/leader Landing first/Content first/Options] 

　 <Options>:   

　 Select arc S1. 

　 (The arc in the lower right corner of the hatch)

② Specify leader landing location: 

　 Move the mouse to the top right and click around point P1, and 

③ Enter the text of the leader. (R3)

S1

P1

④ Press [Close Text Editor] on the [Text Editor] ribbon tab to exit.

1

[Mleader]2

 Ribbon Menu  [ Annotate ] tab -> [ Leaders ] panel -> Multileader 
 Pulldown menu  [ Dimension ] -> Multileader
 Command  Mleader

Mleader

List of [Leaders] commands2

① Use [Multileader] to create the leaders for balloons ① ② ③ ④ ⑤ .

[Content] <Block> for multileader type 
　　　      <Circle> for Source block

The [Leaders] panel has five commands.

② Use [Align] to align the positions of the balloons ① ② ③ ④ ⑤ horizontally.（Left diagram） 

③ Use [Collect] to group balloons ③④⑤ together.（Right diagram）

[Leader Structure] Landing<OFF>

④ To create a balloon, set [Multileader Style] as follows.

Command Roles

  Multileader  Create a multileader.

  Add Leader  Adds a new leader to an existing multileader.

  Remove Leader  Remove existing multileaders.

  Align  Align the multileaders horizontally or vertically.

  Collect  Group multiple multileaders and combine them into  
 a single multileader



276 277

Chapter 7 【Dimension Functions】

D
im

en
sio

n 
Fu

nc
tio

ns

D
im

en
sio

n 
Fu

nc
tio

ns
Chapter 7 【Dimension Functions】

[Datum triangle filled] (Multileader Style Maneger)3

 Ribbon Menu  [ Annotate ] tab -> [ Leaders ] panel -> Multileader Style Manager
 Pulldown menu  [ Format ] -> Multileader Style
 Command  MleaderStyle

① Select [Multileader Style Manager]. 

② Select <Datum triangle filled> from the [Symbol] field on the [Leader Format] tab. (Fig.1)

③ Uncheck the [Automatically include landing] box on the [Leader Structure] tab. (Fig.2)

[Multileader Style Manager]1

To change the already created leader to a <Datum triangle filled>, 

use the [Properties] command. (Fig.1) 

① In the [Properties], set the [Landing distance] to <0>  

　 and select the [Datum triangle filled] using the [arrow]. 

② It will be changed as shown in (Fig. 2).

Changing the leader in the properties2

Datum triangle filledDatum triangle filled

(Fig.1) (Fig.2)

④ Select [Leaders] -> [Multileader]. 

⑤ Specify leader arrowhead location or [pre enter Text/leader Landing first/Content first/Options] 　 　

　 <Options>:  This indicates the starting point (P1) of the arrow.

⑥ Specify leader landing location: This indicates the end point (P2) of the arrow.

⑦ <Datum triangle filled> will be drawn.

P1

P2

⑧ Select [Dimensions] -> [Tolerances]. 

⑨ In the [Geometric Tolerance] dialog, enter a symbol (e.g. A) in the [Datum Identifer] box.

⑩ Place the created [Geometric Tolerance] near the [Datum triangle filled]. 

⑪ Use the [Move] command to align the positions of <Geometric Tolerance>  

　 and <Datum triangle filled>.

(Fig.1) (Fig.2)
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Chapter 7 【Dimension Functions】

[Grip Edit]1

Grip Edit

Edit the dimensions using the grip. 

① Use the mouse to point to the arrow R10. (Fig.1) 

② Right-click the mouse and select [Flip Arrow]  

　 from the shortcut. (Fig.2)

③ The arrow will flip as shown in Fig.3.

[Flip arrow]1

[Create a Continue Dimension]4

[Create a Baseline Dimension]5

[Move the dimension text]2

(Fig.1)

(Fig.3)
(Fig.2)

Edit the dimensions using the grip.

① Use the mouse to indicate the radius dimension (R10). 

② Right-click the mouse and select [Move Text Only] from the shortcut. (Fig.1)

③ Move the text to the appropriate position as shown in (Fig.2).

(Fig.1) (Fig.2)

Edit the dimensions using the grip. 

① Use the mouse to indicate the radius dimension (R10). 

② Right-click the mouse and select [Reset Text Position] 

　 from the shortcut.

③ The text will return to its original position (Fig. 1).

[Restore the dimension text to its original position]3

Edit the dimensions using the grip.

① Use the mouse to indicate the Extension line (red circle) that will create the Continue Dimension. 

② Right-click the mouse and select [Continue Dimension] from the shortcut. (Fig.1)

③ Specify the position of the second point (P1) of the Continue Dimension. (Fig.2) 

④ The Continue Dimension have been created.

(Fig.1) (Fig.2)

P1

Edit the dimensions using the grip.

① Use the mouse to indicate the Extension line (red circle) that will create the Baseline Dimension. 

② Right-click the mouse and select [Baseline Dimension] from the shortcut. (Fig.1)

③ Specify the position of the second point (P1) of the Baseline Dimension. (Fig.2) 

④ The Baseline Dimension have been created.

P1

[Flip Arrow]6
You can flip the arrow using the grip in the same way as 1 .

Grip Edit

(Fig.1) (Fig.2)

Section 3 Edit dimensions
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DimBreak

[DimSpace]3

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Adjust Space
 Pulldown menu  [ Dimension ] -> Dimension Space
 Command  DimSpace

[DimBreak]2

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Break
 Pulldown menu  [ Dimension ] -> Dimension Break
 Command  DimBreak

Add [Break] for extension lines1

Remove [Break] for extension lines2

Select [Dimensions] -> [Break]. 

① The two extension lines intersect at the red circle,  

　 so cut one of the lines (the left one).

② Select dimension to add/remove break or [Multiple]:　 

　 Select the extension line (S1) on the left. (Fig.1)

③ Select object to break dimension or [Auto/Manual/Remove] 　

　 <Auto>:  Select the extension line (S2) on the right. (Fig.2)

④ As shown in (Fig.3), part of the extension line of S1 was breaked.

(Fig.1) (Fig.3)(Fig.2)

S1 S2

Select [Dimensions] -> [Break]. 

① Select the extension line (S1) whose extension line is breaked. (Fig.1)

② Press the right mouse button and select [Remove]. (Fig.2)

③ As shown in Figure 3, the break for the extension line (S1) has been removed.

(Fig.1) (Fig.3)(Fig.2)

S1

Select [Dimensions] -> [Adjust Space].

① Select base dimension:  

     Select linear dimension S1 (<5>). (Fig.1) 

② Select dimensions to space:

　 Select linear dimensions S2 and S3. (Fig.2) 

③ Enter value or [Auto] <Auto>:  0  

　 The linear dimensions are aligned. (Fig.3)

Adjusts the spacing between Continue dimension1

Adjusts the spacing between Baseline dimension2

S1

(Fig.1)

(Fig.3)(Fig.2)

Select [Dimensions] -> [Adjust Space].

① Select base dimension:  

     Select linear dimension S1 (<20>). (Fig.1) 

② Select dimensions to space:

　 Select linear dimensions S2 (Fig.2) 

③ Enter value or [Auto] <Auto>:    

　 The spacing is automatically calculated based on  

　 the text height of the dimension style. (Fig.3)

(Fig.1)

(Fig.2)

(Fig.3)

S1

S2

S2 S3

The [Auto] interval is twice the text 

height of the dimension value.

DimSpace
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Chapter 7 【Dimension Functions】

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Right Justify
 Pulldown menu  [ Dimension ] -> [ Align Text ] -> Right
 Command  DimTedit -> R

Right Justify

Only the dimension value will move.

Dimension value alignment: right

Select [Dimensions] -> [Right Justify]. 

① Select dimension:　

     Select the dimension S1.

② Specify new location for dimension text or [Left/Right/ 

　 Center/Home/Angle]:_r

③ As shown in the diagram on the right,  

　 the dimension value will move to the right.

You can also change the dimensions and other items from the [Properties] panel -> [Properties].

1

[DimTedit](Right Justify)5

Auxiliary line slanted by 60 degrees

Oblique(Enter numerical values)

S1

×

×
P2

P1

Select [Dimensions] -> [Oblique]. 

① Dimension have already been drawn.

　

② Enter type of dimension editing [Home/New/Rotate/　

　 Oblique] <Home>: _o 

 

③ Select objects: 

　 Select the dimension S1.

④ Enter obliquing angle:  From the keyboard, <60>  

① Dimension have already been drawn.

　

② Enter type of dimension editing [Home/New/Rotate/　

　 Oblique] <Home>: _o 

 

③ Select objects: 

　 Select the dimension S1.

④ Enter obliquing angle:　

     Use the mouse to indicate from point P1 to point P2.

1

2

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Oblique
 Pulldown menu  [ Dimension ] -> Oblique
 Command  DimEdit -> O

[DimEdit] (Oblique)4

Oblique(Specify with the mouse)

Oblique

S1

S1

Point!Point!Point!
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Only the dimension value will move.

Dimension value alignment: center

Select [Dimensions] -> [Center Justify]. 

The dimension value that have shifted to the right are returned 

to the center. 

① Select dimension:　

     Select the dimension S1.  

② Specify new location for dimension text or [Left/Right/ 

　 Center/Home/Angle]:_c

　 The dimension value will move to the center.

1

 Ribbon Menu  [ Annotate ] tab -> [ Dimensions ] panel -> Center Justify
 Pulldown menu  [ Dimension ] -> [ Align Text ] -> Center
 Command  DimTedit -> C

[DimTedit](Center Justify)6

Center Justify

You can also change the dimensions and other items from the [Properties] panel -> [Properties].

S1

What types of external files are there?
How do we use them?

In this chapter,
we will learn how to use external files 
and how to handle image files.

Chapter 8  External Files

Section 1 Insert Block

Section 2 Insert Image

Section 3 PDF

Section 4 DXF・DWF
Point!Point!Point!
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 Ribbon Menu  [ Insert ] tab -> [ Block ] panel -> Insert ; [ View ] tab - > [ Palettes ] panel -> Blocks
 Pulldown menu  [ Insert ] -> Blocks Palette
 Command  Insert

Insert using [Block] → [Insert]

[Insert]1

1

Insert

② Select [Block] panel > [Insert]. 

③ Select the block you want to insert, and drag it into place in the drawing.

1 When [Specify insertion point] is displayed during insertion, you can use the right mouse button  

 　shortcut to specify the [Basepoint], [Scale], and [Rotate] options.

 How to insert external drawings as block.

3 Use [Blocks from Libraries...] by [Block] panel-> 

　 [Insert].

3

 How do I specify the [XY scale] and [rotation angle]?

2 If you select [Recent] or [Favorites] or [Libraries] from  

　 the [BLOCKS] panel, the [Insert options] will be displayed.

Right button shortcut1

2 Insert [Options]

Insert

Insert using [Palettes] → [Blocks]2

① Insert a block into the drawing.

① Select the block you want to insert, and drag it into place in the drawing.

4 Select another drawing and use ​ 

　 the blocks from that drawing.

4

Section 1 Insert Block
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Insert blocks with attributes

This drawing contains a block with attributes (A-001).

⑤ After the position and size of the block have 　

　 been finalized (P1), enter the attribute values.

⑥ This block has one attribute value,  

　 and that value is <A-001>.

　 Type <A-002> on the keyboard to confirm.

⑦ The attribute value is changed.

Edit attribute values

① Double-clicking on a block will display  

　 the [Enhanced Attribute Editor]. (Fig.1)

② Change the attribute value to <A-003> and 　　

　 press the [OK] button to confirm. 

③ The attribute values are changed in this way, and 

　 this is reflected in the blocks inserted after this.

④ In the [Enhanced Attribute Editor], you can 　　 

　 change <Text Style>, <Justification>, <Height>  

 　and <Rotation> of the [Text Options] tab. (Fig.2)

⑤ From the [Properties] tab, you can change  　　

　 <Layer>, <Line Type>, <Color>, etc. (Fig.3)

1

2

 Ribbon Menu  [ Insert ] tab -> [ Block ] panel -> Insert ; [ View ] tab - > [ Palettes ] panel -> Blocks
 Pulldown menu  [ Insert ] -> Blocks Palette
 Command  Insert

[Attributed Block Insert]2

① Select [Block] panel -> [Insert] or  [Palettes] panel -> [Blocks].  

② Select <LAMP> from the [Insert] panel. (Fig.1)

③ Click on the block with your mouse to select it and insert it into the drawing. 

④ When [Specify insertion point] is displayed during insertion, you can use the right mouse button  

 　shortcut to specify the [Basepoint], [Scale], and [Rotate] options.

Attributed Block InsertAttributed Block Insert

⑥ To apply the edited attribute definitions to  
　 the same block in the drawing,  
　 use [Block Definition] -> [Synchronize]  
　 to update them.

(Fig.1)

(Fig.2)

(Fig.3)

(Fig.1) [Insert] panel

P1

For an attribute block, both [attribute value<A-001>] and [block name<LAMP>] are displayed.
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Adcenter

Insert a block from the Design Center1

 Ribbon Menu  [ View ] tab -> [ Palettes ] panel  -> DesignCenter
 Pulldown menu  [ Tools ] -> [ Palettes ] -> DesignCenter
 Command  Adcenter

[Adcenter]3

① You can insert blocks from other drawings into the current drawing. 
② In the figure below, we have inserted it into the drawing using [DesignCenter].

Double-click the Design Center block2
① Double-clicking on the [Design Center] block will display the [Insert] dialog box. 
② In the [Insert] dialog, you can use options such as scale and rotation.

The X and Y scales can be changed individually. 
The figure on the right shows the result of inserting X<2> and Y<1>.

Adcenter

Specify the [folder] for the Design Center

① If you select the [Folders] tab in [DesignCenter], the drawings in that folder will be displayed. 

　 When you select the drawing you want to use, a list of available content will be displayed. 

　 If you select [blocks] in this list, a list of blocks in this drawing will be displayed. 

　 When you open the [Open Drawings] tab, a list of the contents of the current drawing will be displayed.

3

Switch display method4

41 2 3

① 1 Tree View 2 Preview 3 Description. These icons can be switched on and off to show or hide them. 

② 4 You can change the display method from [Views] to Large icons, Small icons, List, and Details.

1

2

3
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Insert external drawing as a reference file

The current drawing (left) will be inserted into another drawing<buhin.dwg> (right).

（External reference diagrams appear faintly.）

① Type <Xattach> on the keyboard. 

② The [Select Reference File] dialog box will appear. 

③ Select the drawing you want to insert and click the [Open] button. (Fig.1) 

④ The [Attach External Reference] dialog box will appear. (Fig.2)

⑤ This is similar to block insertion, but only the location of the referenced file is saved. 

　 Select either [Relative path] or [Full path] as the [Path Type].

⑥ Press the [OK] button to insert it into this drawing.

Bind external drawings to the current drawing

① Select [Palettes] panel -> [External References Palette]. 

　 The drawing that is referenced in the current drawing will be displayed in a lighter color. 

　 The diagram circled in red in the drawing is being referred to. (It will be displayed in gray.)

1

1

 Ribbon Menu  [ Insert ] tab -> [ Reference ] panel -> Attach
 Pulldown menu  [ Insert ] -> DWG Reference
 Command  Xattach、Attach

[Xattach][Attach]4

 Ribbon Menu  [  View ] tab -> [ Palettes ] panel  -> External References Palette
 Pulldown menu  [ Insert ] -> External References
 Command  ExternalReferences

[ExternalReferences]5

ExternalReferencesXattach

[External References] can be made part of the inserted drawing (this is called bind). 

Bind is a function that imports the drawing file of the referenced source linked to shapes, blocks, etc.  

into the current drawing. 

When an external reference file is bound to the current drawing, it is incorporated as part of the current 

drawing, and you can choose whether or not to remove the link to the original file.

② Select the shape you want to import from the [File References], and right-click. 

　 Select [Bind] from the shortcut menu, and then select [Insert]. 

　 The selected external reference shape will be imported as part of the current drawing.

Fig.1

Fig.2

⑤ If you select [No path], it will search  
in the folder specified in [Options] > [Files] >  
[ Support File Search Pass].

[buhin.dwg] disappeared.
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Edit a referenced file without opening it

Edit the reference drawing <buhin.dwg> (red circle) shown in the drawing below.

① Select the reference drawing <buhin.dwg> with the mouse. 

② Select [Edit Xref In-place] from the right-button shortcut. 

　 Or, select the [External Reference] tab -> [Edit] panel -> [Edit Reference In-Place ]. 

③ The [Reference Edit] dialog box will appear, so click the [OK] button.

④ Since all drawings other than the reference drawing <buhin.dwg> are displayed in a light color,  

　 you can see that only the reference drawing is the editing target.

⑤ Change the properties of the reference drawing <buhin.dwg>. 

　 In this case, we will change the color of the drawing to <red>. 

　 In addition to <color>, you can also change <position> and <layer>.

⑥ Press the right button and select [Save Reference Edits]. 

⑦ You can see that the reference drawing has been changed.

⑧ When you open the [buhin.dwg] file, the drawing is automatically changed.

[ Edit Reference In-Place] is a function that allows you to make changes to  
inserted drawings without having to open the referenced file.

1

 Ribbon Menu  [ External Reference] Ribbon tab -> [ Edit ] panel -> [ Edit Reference In-Place]
 Pulldown menu  [ Tools ] -> [ Xref and Block In-place Editing ] -> Edit Reference In-Place
 Command  RefEdit

[RefEdit]6

RefEditRefEdit
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 Ribbon Menu  [ Insert ] tab -> [ Reference ] panel -> Clip
 Pulldown menu  [ Modify ] -> [ Clip ] -> Image
 Command  ImageClip , Clip

 Ribbon Menu  [ Insert ] tab -> [ Reference ] panel -> Attach
 Pulldown menu  [ Insert ] -> Raster Image Reference
 Command  ImageAttach , Attach

Insert image files within drawings

① Select [Reference] Panel -> [Attach].

      Insertable raster (image) files will be displayed. 

② Select the raster (image) file and click the [OK] button. (Fig.1) 

③ Select either [Relative path] or [Full path], and then click the [OK] button. (Fig.2)

④ Place the box so that the lower left (P1) is the first point and the upper right (P2) is the second point.

P1

P2

1

[ImageAttach][Attach]1

ImageAttach

Clip the image file

① Select [Reference] Panel -> [Clip]. 

② Select Object to clip: 

      Indicate the edge of the image to select it. (Fig.1) 

③ Enter image clipping option [ON/OFF/Delete/ 

　 New boundary] <New>: 

④ Outside mode - Objects outside boundary will be 　　

　 hidden.

　 Specify clipping boundary or select invert option:

　 [Select polyline/Polygonal/Rectangular/Invert clip] 　

　 <Rectangular>: 

⑤ Specify first corner point:

　 The first point is indicated (top right P1).  

 

⑥ Specify opposite corner point:  

　 The second point is indicated (lower left P2). (Fig.2)

1

[ImageClip][Clip]2

P1

P2

⑦ The image has been clipped. (Fig.3)

(Fig.1) (Fig.2)

If you select [Clipping] -> [Remove Clipping], 

the clipped image will be restored.

P1

P2

P1

P2

ImageClip

I got the image of <Airport1> using the [Location] panel -> [Set Location] . 

©2026 Microsoft Corporation  ©DigitalBlobe

©CNES(2026) Distribution Airbus

(Fig.1)

(Fig.2)

(Fig.3)

Section 2 Insert Image



298 299

Chapter 8 【External File】 Chapter 8 【External File】

Ex
te

rn
al

 F
ile

Ex
te

rn
al

 F
ile

 Ribbon Menu  [ Insert ] tab -> [ Reference ] panel -> Adjust
 Pulldown menu  [ Modify ] -> [ Object ] -> [ Image ] -> Adjust
 Command  ImageAdjust , Ajust

Adjusts the image quality (Brightness, Contrast) of raster (image) files.

Adjust image quality (Adjust)

① Select [Reference] Panel -> [Adjust].

② Select image or underlay:

　 Indicate the edge of the image to select it. 

③ [Enter image option]will appear. 

　 Select from [Contrast/Fade/Brightness].

3 [ImageAdjust][Adjust]

ImageAdjust

1

Adjust image quality (ImageAdjust)2
① Select the pull-down menu [Modify] -> [Object] -> [Image] -> [Adjust]. 

② Select image(s):

　 Indicate the edge of the image to select it. 

③ The [Image Adjust] dialog is displayed.

Adjust image quality
 Brightness  This controls the brightness of the image. The higher the value, the clearer the image.

 Contrast  The larger the value, the greater the proportion of pixels that are either primary or secondary colors.

 Fade  The higher the value, the more the image will blend with the current background color.

 Ribbon Menu  [ Image ] Ribon tab -> [ Adjust ] pane -> Fade
 Pulldown menu  None
 Command  Ajust

Adjust the [Fade] value

① [Fade] adjusts the degree to which it mixes with the background color. 

　 The larger the [Fade] value, the more it will blend with the background color, giving a blurred effect.

1

[Adjust]4

[Fade<0>] [Fade<50>]

[Brightness<90>] [Contrast<80>]

Adjust

 I got the image of <Airport2> using  

the [Location] panel -> [Set Location].  
©2026 Microsoft Corporation  ©DigitalBlobe

©CNES(2026) Distribution Airbus

② The higher the [Brightness] value, the clearer the image. 

　  If you set the [Brightness] to the maximum, the image will become whiter. 

③ The higher the [Contrast] value, the larger the proportion of the basic color of each pixel.
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 Ribbon Menu  [ Output ] tab -> [ Export to DWF/PDF] panel -> [ Export ] -> PDF
 Pulldown menu  None
 Command  ExportPDF

[ExportPDF]1

PDFImportExportPDF

Import PDF as a drawing file (convert PDF to DWG)1

 Ribbon Menu  [ Insert ] tab -> [ Import ] panel -> PDF Import
 Pulldown menu  [ Insert ] -> PDF Underlay
 Command  PDFImport

[PDFImport]2

① Select [Import] panel -> [PDF Import].

② Select the PDF file to import from the [Select PDF File] dialog box. (Figure on the left) 

③ In the [Import PDF] dialog, specify the [Location], [PDF data to import], [Layers], and [Import Options], 

　 and then press the [OK] button. (Figure on the right)

④ The selected PDF will be inserted into the drawing. 

　 [Mech.pdf] has been inserted into [Drawing1.dwg].

Save drawing as PDF1

② Select [Export to DWF/PDF] panel -> [Export] -> [PDF].

③ The [Save As PDF] dialog box will appear. 

④ Enter a name in the [File name] box and click the [OK] button. 

⑤ You can specify PDF details by pressing the [Options] button.

① Save the drawing on the right as a PDF. 

　 Layer and link information can also be saved.

[Data] in the [Export to PDF  Options]
 Include layer information  You can show or hide the layer when displaying or printing a PDF file.

 Include hyperlinks  Convert the hyperlinks in drawing files to PDF hyperlinks.

 Create bookmarks  Create a bookmark as a PDF “bookmark” with a link to the view.

 Font Handling  TrueType fonts can be embedded in PDF files.

⑤ If you check the [Layer Properties], you will see that 

　 the layer name is prefixed with [PDF_] as in [PDF_0].

(Note)

If you import using [Create object layers],  
it will be separated by geometry type.

If you import using [Use PDF layers], the layer 
names of the drawing will be carried over.

(Note)(Note)

Section 3 PDF
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Clip

[ULayers]

 Ribbon Menu  [ Insert ] tab -> [ Refernce ] panel -> Underlay Layers
 Pulldown menu  None
 Command  ULayers

Controlling the layers of a PDF1
① Select [Reference] Panel -> [Underlay Layers].

② The layers of the PDF file you have loaded will be displayed in the [Underlay Layers] panel. (Right)

③ Uncheck the layers <Furniture><Car><Planting> in the [Underlay Layers] panel. 

④ The layers for the PDF of <Furniture><Car><Planting> are now hidden.

⑤ If you select [Snap to Underlay ON], snapping will be enabled in the same way as for drawings.

4

ULayers

[Clip]

 Ribbon Menu  [ Insert ] tab -> [ Refernce ] panel -> Attch,Clip
 Pulldown menu  None
 Command  Attch,Clip

P2

P1

Insert a PDF as a reference file (attach)1
① Select [Reference] Panel -> [Attach].

② From the [Select Reference File] dialog,  

　 select the PDF you want to attach.(Archi.pdf) 

③ In the [Attch PDF Underlay] dialog, 

　 specify the [Insertion point], [Scale], and [Rotation],  

　 and then click the [OK] button.

① Select [Reference] panel -> [Clip].

　 Select Object to clip: Select the outer frame of the imported PDF.

② Enter PDF clipping option [ON/OFF/Delete/New boundary] <New boundary>:  N  

　 Outside mode - Objects outside boundary will be hidden. 

③ Specify clipping boundary or select invert option:

　 [Select polyline/Polygonal/Rectangular/Invert clip] <Rectangular>: 

　 Click on the area to be cut out (P1 - P2) with the mouse. 

④ Only the area surrounded by P1 and P2 will be clipped.

Clip the necessary range (clip)2

3

P2

P1
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Save as an intermediate file (DXF)
① Select [Quick Access] toolbar -> [Save As].

      From [Files of type], select the extension <dxf>.

      In the figure below, the file format is set to <AutoCAD 2018 .DXF>.

Open an intermediate file (DXF)

① Select [Quick Access] toolbar -> [Open].

      From [File Types], select a file with the extension <dxf>. 

　  In the figure below, <Archi. DXF> is selected.

② You can select the DXF file version from the DXF file format as shown in the figure below. 

　 Save the file in a version that matches the version of the recipient who will receive the DXF file.

③ DXF files are text files, as shown in the image on  

　 the right.  

　 You can open and check them using a text editor  

　 such as Notepad.

② As shown in the drawing below, the file extension is <dxf>.

1

1

 Ribbon Menu  [ Quick Access ] Toolbar -> Open
 Pulldown menu  [ File ] -> Open
 Command  Open

[Open DXF]2

[Saveas DXF]1

Open DXFSave as DXF

 Ribbon Menu  [ Quick Access ] Toolbar -> Save As
 Pulldown menu  [ File ] -> Save As
 Command  Saveas

Section 4 DXF・DWF
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DWF (Design Web Format) is a vector data format suitable for displaying drawings on the web. 

In addition, these drawings are in DWF format, which is not dependent on CAD.

This DWF can be imported as an external reference in the same way as image data,  

and used as an underlay in the drawing.

 Ribbon Menu  [ Insert ] tab -> [ Reference ] panel -> Attach
 Pulldown menu  [ Insert ] -> DWF Underlay
 Command  DwfAttach

[DwfAttach]3

DwfAttach

Import DWF

① Select [Reference] panel -> [Attach].

     The [Select Reference File] dialog box will appear.

1

② When you select DWF, the [Attach DWF Underlay] dialog box will appear.

     You can specify the [Insertion point] and [Scale]. 

③ Press the [OK] button to insert it into the drawing.

　 This is just a underlay, so you cannot make the same kind of modification as you can with a DWG file.

Chapter 9  Dynamic Blocks

By giving normal blocks parametric information,
we can freely change their size and angle.
These blocks are called dynamic blocks.

In this chapter,
we will learn how to create dynamic blocks.

Section 1 What are Dynamic Blocks?

Section 2 Creation Process

Section 3 Parameters and Actions

Section 4 Create Dynamic Block
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Dynamic Blocks are blocks with additional commands such as move, copy, rotate, and stretch  

added to normal blocks. 

You can also combine multiple blocks into one block and give each block a different action  

(stretch or scale change). 

Let’ s have a look at the example below.

What is a “dynamic block” ?

The difference between blocks and dynamic blocks1

1

Difference between block and dynamic block

Normal Block

Dynamic Block

A

B

① The above diagram shows Normal Block A and Dynamic Block B.

　 Copy and paste the block in A three times to the right. 

② Use the [Array (ArayClassic)] in the [Modify] panel.

③ In the [Array] dialog, specify [Rectangular Array], <1> for [Rows], and <4> for [Columns].

　 Also, select block A with a row spacing of <700>.

④ Click [OK] to close the dialog box.

⑤ As shown below, it was copied three times to the right.

⑥ Next, select block B. 

　 When you select a block, a light blue triangle will appear to the right of the block. 

　 If you select a triangle and move it to the right, the block will also be copied at the specified interval.

⑦ As you can see, Dynamic Blocks are blocks with operations (Scale, Rotation, Array, etc.)  

　 added to Normal Blocks。 

 

⑧ As shown in the diagram below, you can display a list called a “lookup” and change the interval of 　

　 array copying freely by selecting the values with the mouse.

A

B

A

B

Difference between block and dynamic block

Section 1 What is Dynamic Block?
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① The image on the right shows an M30 nut for bearings.

　 This nut is converted into a dynamic block that can be 

　 scaled at 10 mm intervals.。 

　 The block name of this nut is<Nut>.

Prepare block

Preparation1

1

② You can create and edit blocks in the [Block Editor] of  

　 the [Block Definition] panel.

③ From the [Edit Block Definition] dialog, select [Nut], 　

　 and then press the OK button.

① Select a block from the [Edit Block Definition] dialog.

　 Switches to the [Block Editor] tab.

　 You can create not only dynamic blocks, but also normal blocks and attribute definitions. 

　 Also, the base point of the block has been moved to the origin.

Convert to [Dynamic Block]2

② Conversion from Normai Block to Dynamic Block is done in two steps.

　 The first gives parameters to the block.

　 This specifies the behavior of the block, such as moving or rotating, stretching it, etc.

　 Select from the [Parameters] panel. (Fig.1) 

 

③ Next, give the block an action.

　 For example, a block given [Linear Parameters] would correspond to the commands [move], [copy],  

　 [scale], etc. Specify which of these commands to use.

　 Select from the [Actions] panel. (Fig.2)

④ Complex actions can also be added to [Parameters] and [Actions]. 

　 For example, the left figure shows the [Linear Parameter] property.

　 The [Dist type] is set to increase or decrease between 30 mm and 100 mm in 10 mm intervals. 

 

⑤ Also shown on the right are the properties of [XY Parameter]. 

　 In the [Geometry] section, <2000> is specified for [Ver distance] and <1000> for [Hor distance].

　 This indicates that this dynamic block will be array copied at intervals of <2000> millimeters vertically 

　 and <1000> millimeters horizontally.

PreparationPreparation

(Fig.1) (Fig.2)

Section 2 Creation Process
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① Select [Block Editor] from the [Block Definition] panel.

② From the [Edit Block Definition] dialog, select [Nut].

Add a scale change function to the block [Nut]

Converting block to dynamic block2

1

③ Select [Linear] from the [Action Parameters] panel. This specifies a linear motion for the Nut.

P1 P2

⑤ Specify label location: Place the [Parameter] label <Distance1>.

　 To modify the value, select this label.

④ Specify start point: Specify the center of the circle (P1).

　 Specify endpoint: Specify the right end (P2) of Nut.

⑦ Select parameter:  Select the [Parameter] label < Distance 1>. 

　 Specify selection set for action Select objects:   

　 Select the hexagon (S1) and circle (S2) of Nut.

⑥ Select [Scale] from the [Action Parameters] panel. Give the Nut the same function as [Scale].

S1
S2

⑧ This has converted a normal Nut block into a dynamic block with [Scale] functionality.

　 If the [parameter] and [action] are specified correctly, it will look like the image below.

　 Close the [Block Editor] and return to the drawing screen.

⑨ When you select the dynamic block<Nut>, a light blue arrow (red circle) will appear on the right side. 

　 The light blue square in the center will be the base point for movement.

　 Select the light blue arrow and move the mouse to the right to change the scale of the block.

Converting block to dynamic blockConverting block to dynamic block

mark disappears and 

 mark appears.
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 リボンメニュ－  [ Insert ] tab -> [ Block Definition ] panel -> Block Editor
 プルダウンメニュー  [ Tools ] -> Block Editor
 コマンド  Bedit

[Block Editor] Ribbon Tab
1   Open / Save  Open blocks in drawings and save changes.

2   Manage  Open the Authoring Palettes.

3   Action Parameters  Add parameters and actions to the block.

4   Visibility  Adds a visible parameter to the dynamic block. 
 Controls the visible state of the block.

5   Close  Exit the [Block Editor] and return to the drawing.

6   Parameters  Adds parameters to the block.

7   Actions  Adds actions to the blocks.

8   Parameter Sets  Add parameters and actions to the block at the same time.

[Bedit]1

BeditBedit

① Select [Block Definition] panel -> [Block Editor].

② The [Blocks Editor] ribbon will be displayed.

③ The following figure (bolt) is a dynamic block given the [linear] parameter and [stretch] action. 

 

④ 1 This parameter indicates that it moves in a [linear] direction to the right. It cannot rotate.

　 2 This action indicates [Stretch] is performed. 
 

⑤ As you can see, a dynamic block consists of two parts: [parameters] and [actions]. 

　 First, set the [parameter], and then associate an [action] with that parameter.

Panel Explanation

　 
 Control points such as location, distance, and angle    

 are specified for the block. 

 This is also used to set information for the block.

　 
 Assigns a specific action to the selected parameter.

　  This defines the combination of parameters and   

 actions. (You can set both at once.)

　 
 Specify whether to display multiple blocks.

Authoring Palettes

6

7

8

3 4 51 2

1

2

Section 3 Parameters and Actions
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[Parameters]2

ParametersParameters

① There are multiple types of parameters, and each parameter has its own properties.

　 The [Linear] parameter has a <length> item, and the [Rotation] parameter has a <angle> item.

② You can change the length and angle of the dynamic block by changing the values of each parameter.

 Point parameter  This gives a point parameter to the dynamic block.
 Related actions  Move, Stretch

 Linear parameter  This gives a linear parameter to the dynamic block.
 Related actions  Move, Stretch, Scale, Array

 XY parameter  This gives the XY parameter to the dynamic block.
 Related actions  Move, Stretch, Scale, Array

 Alignment Grip  This gives a alignment grip to the dynamic block .
 Related actions  None.（The action is defined automatically.）

 Flip Grip  This gives a flip grip to the dynamic block .
 Related actions  Flip

 Visibility parameter  This gives a visibility parameter to the dynamic block.
 Related actions  None.（The action is defined automatically.）

Point!

Parameter notes 
① To be able to change the parameter values at regular intervals or in a list of specified values, 

　 specify them in the [Value Set] of the properties. 

② You can assign multiple actions to a single parameter. 

　 This allows you to execute multiple actions simultaneously by operating a single grip. 
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Point!

[Actions]3

ActionsActions

① Actions add actions such as stretch and rotation to parameters. 

　 The [Linear] parameter can add <Scale><Stretch><Move><Array>.

　 The [Rotation] parameter can be appended with <Rotation>.

② Multiple actions can be assigned to a single parameter.

Action notes 
① The action is assigned to a parameter.

② When a parameter has  mark, no action has been assigned yet.

③ There are no actions for the [Alignment], [Visibility], and [Basepoint] parameters.

 Polar Stretch  Stretch the dynamic block in a polar pattern.
 Required Parameter  Polar

 Scale  Change the scale of the dynamic block.
 Required Parameter  Linear, Rotate, XY

 Stretch  Stretch the dynamic blocks linearly.
 Required Parameter  Linear, XY

 Rotate  Rotate the dynamic block.
 Required Parameter  Rotate

 Flip  Flip the dynamic block.
 Required Parameter  Flip

 Array  Array the dynamic block.
 Required Parameter  Linear, Polar, XY
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Point!

ArrayArray

① Select [Block Definition] panel -> [Block Editor], and select the block <Chair>. 

 

② The center of the back of the <Chair> is the insertion point for the block. 

　 In the [Block Editor], the insertion point is the origin.

Loading [Block (Chair)]

[Array]1

1

 Parameter  [ Linear ]
 Action  [ Array ]
 Grip  [ 1 ～ 2 ]

① The [linear] parameter specifies two points: the starting point (P1) and the ending point (P2). 

 

② Specify start point： Indicate P1 (the center of the backrest). 

 

③ Specify endpoint: Indicate P2 (right end of the backrest).

Specify [Linear] Parameter2

④ Specify label location: Indicates the lower backrest area. 

 
⑤ Enter number of grips [0/1/2] <2>: 1  
　 Alternatively, change the number of grips from <2> to <1> in the [Properties]. 

　 When arranging block, the grip you specify with the mouse will be displayed. 

　 There are two directions possible for arranging block, but if you set the number of grips to one,  

　 the block will be copied in only one direction (right direction) (P1 → P2 direction).

⑥ The [linear] parameter is arranged as shown in the figure below.

　  mark, no action has been assigned yet.

　 When you specify an action, this mark will disappear.

P1 P2

P1 P2

How do you change the number of grips? 
① Select the parameter [Distance 1] to display  

　 the [Properties].

② Change the number in the [Number of grips] section  

　 at the bottom of the [Properties].

③ The number of grips displayed in this section shows  

　 the possible numbers in the [array]. 

　 The maximum number of grips is 2.

Section 4 Create Dynamic Block
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① The [Array] Action specifies two points: the starting point (P1) and the ending point (P2). 

 

② Select parameter: Select the [Distance1] parameter. 

 

③ Specify selection set for action

　 Select objects: Surround the Chair from P3 to P4.

Specify [Array] Action3

P1 P2

④ Enter the distance between columns (|||):  Type <700>. 

⑤ The [Array] label will be automatically placed, but you can move it to a suitable position. 
　 The label is necessary for selecting it with the mouse when changing the [Array Interval] etc. later. 

　  will disappear when you place the label.

① When you select a [Chair] block, the base point of the block (light blue box)  
　 and the direction of the copy (light blue arrow) will be displayed.

Check the operation on the drawing screen4

⑥ Select [Close Block Editor] from the [Close] panel.
　 Indicate “Save” in the [Changes Not Saved] dialog box and return to the drawing screen.

① Changes to the spacing of the  [Array] are made in the [Block Editor]. 

 

② Select the [Array Action] label of [Chair] to display the [Properties]. 

 

③ Change the value of [Column offset] in [Properties].

Change the array interval5

② Select the arrow with the mouse and move it to the right to copy the blocks at intervals of 700 mm.

ArrayArray

P3

P4

700 mm
P1 P2
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Point!

XY [Array]2

XY ArrayXY Array

 Parameter  [ XY ]
 Action  [ Array ]
 Grip  [ 1 ～ 4 ]

① Select [Block Definition] panel -> [Block Editor], and select the block <Window>. 

 

② The lower left of the <Window> block is the insertion point for the block.

　 In the [Block Editor], the insertion point is the origin.

Loading [Block (Window)]1

① The [XY] parameter specifies two points, the starting point (P1) and the ending point (P2). 

 

② Specify base point: Indicate P1 (bottom left of the window). 

 

③ Specify endpoint: Indicate P2 (top right of the window). 

　 Both the horizontal (X) and vertical (Y) copy distances have been specified at the same time.

Specify [XY] Parameter2

P1

P2

④ The label is placed automatically. 

 
⑤ Change the number of grips from <4> to <2> in [Properties]. (P1 and P2) 
　 When copying an array of block, the grips you specify with the mouse are displayed. 

　 With XY array copying, there are four possible directions (up, down, left and right),  

　 but if you set the number of grips to two, copying will only be possible in two directions. 

 

⑥ The [XY] parameter is arranged as shown in the figure below.

　  mark, no action has been assigned yet.

　 When you specify an action, this mark will disappear.

P2

P1

How do you change the number of grips? 
① Select the parameter [X distance 1] or [Y distance 1]  

　 to display [Properties].

② Change the number in the [Number of grips] section  

　 at the bottom of the [Properties].

③ The number of grips displayed in this section shows  

　 the possible numbers in the [XY]. 

　 The maximum number of grips is 4. 

 

④ If [Number of Grips] is set to <4>,  

　 you can copy up, down, left, and right.
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① The [Array] Action copies the array in the X and Y directions simultaneously. 

 

② Select parameter: Select the [X Distance 1] or [Y Distance 1] parameter. 

 

③ Specify selection set for actionSelect objects: Surround the Window from P1 to P2.

Specify [Array] Action3

④ Enter the distance between rows (---):   Type <2000>.
　 Enter the distance between columns (|||):  Type <1000>. 

⑤ The [XY] label will be automatically placed, but you can move it to a suitable position. 
　 The label is necessary for selecting it with the mouse when changing the [Array Interval] etc. later. 

　  will disappear when you place the label.

① When you select a [Window] block, two light blue boxes will appear. 

　 If you select 1 , it will be copied to the [left and lower left] direction,  

　 and if you select 2 , it will be copied to the [right and upper right] direction.

Check the operation on the drawing screen4

① Changes to the spacing of the  [Array] are made in the [Block Editor]. 

 

② Select the [Array Action] label of [Chair] to display the [Properties]. 

 

③ Change the values of [Row Offset] and [Column Offset] under [Rows and Columns] in [Properties].

Change the array interval5

P1

P2S1

S2

XY ArrayXY Array

⑥ Select [Close Block Editor] from the [Close] panel.
　 Indicate “Save” in the [Changes Not Saved] dialog box and return to the drawing screen.

When copying in four directions (up, down, 

left and right), 

set the [Number of grips] to<4>.

1

2

② Select 2  with the mouse and move it upwards to the right to copy the window at intervals of  

　 1000mm horizontally and 2000mm vertically.
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Point!

FlipFlip

[Flip]3

 Parameter  [ Flip ]
 Action  [ Flip ]
 Grip  None

① Select [Block Definition] panel -> [Block Editor], and select the block <Door>. 

 

② The lower left corner of [Door] is the insertion point for the block.

　 In the [Block Editor], the insertion point is the origin.

Loading [Block (Door)]1

① The [flip] parameter specifies two points (P1, P2) on the symmetry axis. 

② Specify base point: This indicates the midpoint (P1) between the lower left  

　 and lower right corners of the door. 

③ Specify endpoint: Move the mouse to the upper position in the ortho mode  

　 and indicate the appropriate position (P2).

Specify [Flip] Parameter2

④ Specify label location:  Place it above the Door. 

 
⑤ There is no grip for the [Flip] parameter.  
　 The block will flip each time you point to the arrow.

P1

P2

⑥ The [Flip] parameter is arranged as shown in the figure below.

　  mark, no action has been assigned yet.

　 When you specify an action, this mark will disappear.

P1First point Second point

End Point End PointMid Point

How do you get the midpoint of two points?
① Before indicating the first point, display [O Snap] from 　

　 the right button shortcut. (Shift + right button)

② The third one from the top is the [Mid between 2 Points].

③ After selecting this, you can get the midpoint P1  

　 by indicating two points.

P2
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① The [Flip] Action flips the block based on the symmetry axis. 

 

② Select parameter: Select [Flip state1](S1). 

 

③ Specify selection set for action Select objects:  

　 Surround the Door from P1 to P2.

Specify [Flip] Action3
① When you select the [Door] block, the base point of the block (light blue box) 　  

　 and the direction of the inversion are indicated by a light blue arrow.。 

　 Selecting 1  will [move], and selecting 2  will [Flip]. 
② By default, the [Flip State 1] property is set to <No Flipped>.

Check the operation on the drawing screen4

① You can change the [flip] angle in the [Block Editor]. 

 

② Select the [Angle] section in the [Flip Parameter] of the [Properties]. 

 

③ Change the value of the [Angle] in [Geometry] of the [Properties].

Change the angle of flip5

③ When you point to 2  with the mouse, [Door] will be flipped. 

④ The property [Flipped state 1] changes to <Flipped>.S1

P1

P2

FlipFlip

④ The [Flip] label will be automatically placed, but you can move it to a suitable position. 

　  will disappear when you place the label.

⑤ Select [Close Block Editor] from the [Close] panel.
　 Indicate “Save” in the [Changes Not Saved] dialog box and return to the drawing screen.

1 2
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Point!

StretchStretch

 [Stretch]4

 Parameter  [ Linear ]
 Action  [ Stretch ]
 Grip  [ 1 ～ 2 ]

① Select [Block Definition] panel -> [Block Editor], and select the block <Bolt>. 
 

② The P point of [Bolt] is the insertion base point of the block.

　 In the [Block Editor], the insertion point is the origin.

Loading [Block (Bolt)]1

① The [linear] parameter specifies two points: the starting point (P1) and the ending point (P2). 

 

② Specify start point: Indicates P1. 

 

③ Specify endpoint: This indicates P2 (the midpoint of the right end of Bolt).

Specify [Linear] Parameter2

P1 P2

P

④ Specify label location: Indicates the lower portion of [Bolt]. 

 
⑤ Change the number of grips from <2> to <1> in [Properties].

⑥ The [linear] parameter is arranged as shown in the figure below. 

　  mark, no action has been assigned yet.

　 When you specify an action, this mark will disappear.

If you add more grips? 
① If you set the [Number of Grips] to<2>, an arrow pointing to the left will be added (red circle).

② In this case, if you point to the left arrow, it will also stretch to the left.
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① The [Stretch] Action stretches the block in the direction of the arrow on the grip. 

 

② Select parameter: Select [Distance 1](S1). 

 

③ Specify parameter point to associate with action: Indicate the arrow (P) on the grip. 

　 Can stretch to the right direction.

Specify [Stretch] Action3 ⑥ The [Stretch] label will be automatically placed, but you can move it to a suitable position. 

　 The label is necessary for selecting it with the mouse when changing the [Stretch] later. 

　  will disappear when you place the label.

① When you select the [Bolt] block, the base point of the block (light blue box)  
　 and a light blue arrow indicating the direction of the stretch will be displayed. 
　 Select 1  to [Move] and 2  to [Stretch].

Check the operation on the drawing screen4

② Select 2  with the mouse to stretch [Bolt]. 

　 Since there is only one grip, it can only stretch in the right direction.

S1

P1

P2

④ Specify first corner of stretch frame:  

　 Use the mouse to enclose the parameter selection from P1 to P2.（Fig.1） 

　(also gets the parameter <distance1> associated with the stretch) 

 

⑤ Specify objects to stretchSelect objects: 

　 Use the mouse to enclose the area to be stretched from P3 to P4 (4 lines) so that they intersect.（Fig.2）

P

P4

P3

<P1 - P2> and <P3 - P4> are both enclosed by crossing four horizontal lines 

from right to left and <Distance 1>.

StretchStretch

⑦ Select [Close Block Editor] from the [Close] panel.
　  Indicate “Save” in the [Changes Not Saved] dialog box and return to the drawing screen.

Select the parameter first (Fig.1), then the lines to be stretched (Fig.2).

（Fig.1） （Fig.2）

1 2
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① In the [Block Editor], select the [Bolt] block’ s [Distance 1] parameter and display the [Properties]. 

 

② Select [Increment] for the [Dist Type] in the [Value Set].

Stretch by specifying [Increment]5

③ [Dist increment]<10>... The distance will be increased or decreased in increments of <10>mm. 
　 [Dist Minimum]<50>... The minimum distance for the stretchable part will be set to <50> mm. 
　 [Dist Maximum]<100>... The maximum distance for the stretchable part will be set to <100>mm.

④ If you select the red grip, vertical lines will be displayed at intervals of <10> mm to the right.

　 The mouse is locked at this interval and moves between a minimum of <50> mm and a maximum of 

　 <100> mm. The [increment] will only expand or contract by the specified increment.

① In the [Block Editor], select the [Bolt] block’ s [Distance 1] parameter and display the [Properties]. 

 

② Select [List] for the [Dist Type] in the [Value Set].

Stretch by specifying [List]6

③ Press the [Add] button in the [Add Distance Value] panel of the [Value Set]  
　 and enter the values in order.

④ If you select the red grip, vertical lines will be displayed in the right direction  

　 according to the values in the list. 

　 The mouse is locked at this interval and move between the values in the list. 

　 The [list] can be freely set to expand and contract at intervals.

StretchStretch
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[Lookup]5

 Parameter  [ Lookup ]
 Action  [ Lookup ]
 Grip  [ 1 ]

Stretch by using [Lookup]1
① Place the [Lookup] in the [Parameters] panel.

 
② Specify parameter location: Specify the placement position (P1). 

　 The [Lookup] parameter is placed near the Bolt.

③ The number of grips is <1>, so there are no changes. 

 

④ As shown in the figure below, the [Lookup1] parameter has been placed near Bolt. 

　 The list will be displayed in this position.

⑤ Next, give the [Lookup] parameter a [Lookup] action. 

　 Select [Lookup] from the [Action] panel.

On the previous page, we changed the length of the bolt using [Increment (left diagram)]  
and [List (right diagram)]. 
Another way to change the length is by using the [Lookup].
The [Lookup] displays a list, and you can change the length of the bolt by selecting a value from the list.

P1

⑥ Select parameter:  Select the parameter [Lookup 1].

⑦ The [Property Lookup Table] will be displayed.  

　 Enter values in this table.

LookupLookup
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Point!

⑧ Select [Add Properties] in the upper right of the [Property Lookup Table]. 

　 Specify which [parameter] to link to the [Lookup Table].

⑨ Select [Linear] from the [Add Parameter Properties] panel.

　 Since only the [Linear] parameter is specified for this bolt, only one is displayed.

⑩ The items in the [Lookup Properties] section on the right are the characters  
　 that will be displayed in the [Lookup]. 
　 The items in the [Distance 1] section on the left are the actual numbers  
　 that will be expanded or contracted.

Check the operation on the drawing screen2
① When you select the [Bolt] block, the base point of the block (light blue box)  
　 and a light blue arrow indicating the direction of the stretch will be displayed. 
　 Select 1  to [Move] and 2  to [Stretch]. 

　 And 3  is where the lookup (list) is displayed.

② When you point to triangle 3 , the [Look Up] list will be displayed facing down. 
　 From the [Lookup] list, the figure on the left was selected for <Base*1.2>. 
　 The figure on the right was selected for <Base*2.0>.

How do I change the length and angle values of a dynamic block?

LookupLookup

①  Specify the number to be increased in the [Increment] of the [Dist type] of the property.

②  Specify the number to be increased in the [List] of the [Dist type] of the property.

③  Specify the number that appears in the [Lookup] list.

1 2

3
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[Rotation]6

 Parameter  [ Rotation ]
 Action  [ Rotate ]
 Grip  [ 1 ]

Loading [Block (Bulldozer)]1

① The [Rotation] parameter specifies two points: the base point (P1) and the radius point (P2). 
② Specify base point: Indicates P1. 
③ Specify radius of parameter: Indicates P2.

Specify [Rotation] Parameter2

① To create or edit a dynamic block, double-click the block you want to convert to a dynamic block. 
② Alternatively, select the block you want to edit from [Block Editor] in the [Block Definision]panel.

① ②

P1

P2

⑤ The label will be automatically positioned. 
⑥ There is only one grip. 
⑦ The [Rotation] parameter is arranged as shown in the figure below. 

　  mark, no action has been assigned yet.
　 When you specify an action, this mark will disappear.

④ Specify default rotation angle: Enter<360> as the total angle. 

RotationRotation



344

Chapter 9 【Dynamic Block】 Chapter 9 【Dynamic Block】

D
yn

am
ic

 B
lo

ck

D
yn

am
ic

 B
lo

ck

345

① The [Rotate] Action rotates the block around its base point. 
② Select parameter:  Select [Angle 1](S1). 
③ Select objects: Specify the entire block.

Specify [Rotation] Action3

S1

① Select the block parameter [Angle 1] to display the [Properties]. 

② Select [Increment] for [Ang type] under [Value Set] and set the [Ang increment] to <30>.

Rotates by specifying [Increment]4

① When you select the [Bulldozer] block, the base point of the block (light blue box)  

　 and a light blue dot indicating the direction of the rotation will be displayed. 

　 Select 1  to [Move] and 2  to [Rotation].

Check the operation on the drawing screen5

② Select 2 with the mouse to rotate the block [bulldozer] at intervals of 30 degrees.

1 2

RotationRotation
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[Alignment]7

 Parameter  [ Alignment ]
 Action  None
 Grip  [ 0 ]

Loading [Block (Bolt)]1

① The [Alignment] parameter specifies two points: the base point (P1) and the direction point (P2).  
　 The block is aligned in the direction of P1 and P2. 
② Specify base point: Indicates P1 (block origin). 
③ Specify alignment direction: Indicates P2 (the upper or lower endpoint).

Specify [Alignment] Parameter2

① To create or edit a dynamic block, double-click the block you want to convert to a dynamic block. 
② Alternatively, select the block you want to edit from [Block Editor] in the [Block Definision]panel.

① ②

P1

P2

There are no actions for [Alignment].

④ [Alignment] rotates in the direction of 2  based on 1 . 
　 The direction of rotation is the direction of the line you indicated.

1

2

2

① When you select the [Bolt] block, the base point of the block (light blue box) will be displayed. 

　 Select 1  and move to the center of the diagonal line.

Check the operation on the drawing screen3

1

Center

② It will be placed perpendicular to the specified line. 
　 You can specify two different directions.

AlignmentAlignment
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[Visibility]8

Visibility

 Parameter  [ Visibility ]
 Action  None
 Grip  [ 1 ]

① Create three blocks [sen1], [sen2], and [sen3] as one block. 

② Select [Block Definition] panel -> [Block Editor]. 

　 In the [Block to create or edit] box, type <Senmen> and press the [OK] button.

Create a new Block(Senmen)1

⑤ Select [Open/Save] panel -> [Save Block].　 

⑥ Alternatively, select [Close Block Editor] from the [Close] panel.

　 Indicate “Save” in the [Changes Not Saved] dialog box and return to the drawing screen.

① Select [Block Definition] panel -> [Block Editor], and select the block <Senmen>.

Loading [Block (Senmen)]2

② In the new block <Senmen>, the base point is determined since the insertion base point has not  

　 yet been determined. The base point of the block will be the base point of [Move]. 

 

③ Select [Basepoint] from the [Parameters] panel and indicate the base point (P1) of [sen1].

P1

④ A [Basepoint] has been placed at (P1) of [sen1]. 

　 Block [Senmen] can be moved using this point as a base point. 

　（Grip for movement appear in this position.）

③ Insert the three blocks [sen1], [sen2], and [sen3] in the block editor. 

④ Three blocks [sen1], [sen2], and [sen3] are placed so that the base points of each block overlap.

　 （The base point is the midpoint of the upper side of sen1) Base (Midpoint)

×

1

2 3

1

2

1

2

1

3
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① Select [Visibility] from the [Parameters] panel. 
　 

② Specify parameter location:  Indicate any point (P1) on the upper side of the block. 

　 [Visibility] parameter appear in this position. 

 

③ The number of grips is <1>, so no change.

Specify [Visibility] Parameter3

P1

④ The [Visibility Parameter] has been placed as shown below.

　  mark indicates that [Visibility States] has not yet been specified for the three parts.

　 When specified, this mark disappears.

① Double-click on the Visibility parameter [Visibility 1]. 
　 

② In the [Visibility Status] dialog box, select <Visibility Status 0>.

　 Click [Rename] and type <Plane>.

Edit the [Visibility Parameter] to create three different [Visibility States]4

③ Click [New] and enter <Front> in the [Visibility state name] dialog box.

④ Similarly, click [New] and enter <Side> in the [Visibility state name] dialog box.

⑤ Select <Plane> in the [Visibility States] dialog and press the [Set current] button.

Visibility
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① From the [Visibility] panel, select [Make Invisible]. (Leave the Plane displayed.)

Assign a specific view of the block to each Visibility State5

② Select objects to hide:  Choose the block (Sen2 1 <Front> and Sen3 2 <Side>). 
　 Only the blocks (Sen1<Plane>) are displayed.

③ From the [Visibility] panel, select [Make Invisible]. (Leave the Front displayed.)

④ Select objects to hide:  Choose the block (Sen1 1 <Plane> and Sen3 2 <Side>). 
　 Only the blocks (Sen2<Front>) are displayed.

⑤ From the [Visibility] panel, select [Make Invisible]. (Leave the Side displayed.)

⑥ Select objects to hide:  Choose the block (Sen1 1 <Plane> and Sen2 2 <Front>). 
　 Only the blocks (Sen3<Side>) are displayed.

⑦ When you select <front> or <plane> from the [Visibility] panel,  
　 the other sides will be displayed in a lighter color.　 
　 ( You can switch between display and non-display using the [Visibility Mode] button.)

VisibilityVisibility

12

1

2

1

2



354

Chapter 9 【Dynamic Block】
D

yn
am

ic
 B

lo
ck

Visibility

① When you select a [Senmen] block, the base point of the block (light blue box)  

　 and the light blue arrow of the [Visibility Parameter] will be displayed. 

 

② When you point to the arrow, the words [Plane, Front, Side] will appear. 

　 The selected plane is displayed.

Check the operation on the drawing screen6

Normally, drawings are created in [Model Space],
and the created drawings are placed in  
[Layout Space] and printed.

However, there may be multiple scales for  
the drawings placed in Layout Space.

Here, we will learn how to place drawings.

Chapter 10  Layout

Section 1 What is an annotation object?

Section 2 Non-Annotative Object

Section 3 Annotative Object
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The size of text, arrows, etc. is specified by the overall scale in the [Scale for dimension features] box 
on the [Fit] tab of the [Dimension Style Manager] dialog box.

The left image shows the settings for printing at 1 (actual size), and the right image shows the settings 

for printing at 1/100 (reduced size). 

As you can see, it is necessary to create dimension styles in advance according to the printing scale.

Therefore, a number of [dimension styles] and [text styles] with different print scales are necessary.

Features of [non-Annotative Object]

Features of [Annotative Object]3

2

Object and Annotative ObjectObject and Annotative Object

Drawing scale: actual size [Drawing range<42000 × 29700>]

Object(actual size)

[Object] and [Annotative Object]1
① Drawings are made up of “objects” such as machine drawings and architectural drawings,  
　 and “annotative objects” such as text and dimensions.。 
　 The design is drawn to scale in the model space, and annotations are added in the desired size  
　 in the layout space.

Object (x 100)

No matter what print scale you set in the layout space, the annotative object itself will automatically 
adjust its size to match the print scale. 
If you set [Dimension Style] to 2 mm, it will display at 2 mm size in any print scale. 
Therefore, you only need one [Dimension Style] and [Text Style].

Object and Annotative Object1

Annotative object (actual size)

Object(actual size)

Layout SpaceModel Space

Drawing scale: actual size [Drawing range<420 × 297>](A)

(B)

　(A) is a design for “metal fittings” , but the figure frames placed in the model space  

and the figure frames placed in the layout space are both the same size A3 paper. 

For this reason, the text in the dimensions and title columns in the model space are entered in the same 

size as when printed, 2 mm. 

　On the other hand, (B) is a design for a house. In the model space, the drawing is drawn to scale,  

but in the layout space, it is placed on an A3 sheet of paper, so the drawing frame is also enlarged to 

match the size of the house. 

The scale of the enlargement is the reciprocal of the scale at which the drawing is printed.  

In other words, if you are printing at 1/100 scale, the size of the text and dimensions (annotative objects) 

you enter in the model space should be 100 times larger.

Object(actual size)

Annotative object (actual size)

Object (1/100)

Print scale: 1/1 [A3 size paper<420 × 297>]

Annotative Object that can handle annotations4
The following six Annotative Objects can be used for annotations.

 Dimension  [Dimension Style Manager] dialog box → [Fit] tab → [Scale for dimension features].
 Text  [Text Style] dialog box → [Size] → [Annotative].
 Leader  [Multileader Style Manager] dialog box → [Scale] → [Annotative].
 Hatching  [Hatch and Gradient] dialog → [Options] → [Annotative].
 Block  [Block Definition] dialog box → [Behavior] → [Annotative].
 Block Attribute  [Attribute Definition] dialog → [Text Settings] → [Annotative].

Section 1 What is an annotative object?

Print scale: 1/1 [A3 size paper<420 × 297>]

Model Space Layout Space

Annotative object (actual size)
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Non-Annotative Object1

Place the drawing created in the Model Space in the Layout Space1
① The drawing below was drawn in the model space. 
　 We will now add the dimensions, but the printing will be done on A3 paper at a scale of 1/100.

② The size of the text when printed is 2 mm, so the size of the text in the model space is 200 mm 
　 (i.e. 100 times larger). 
③ From the [Fit] tab of the [Dimension Style] dialog, set the [Scale of dimension features] to <100>.

④ The dimensions are shown in the diagram below. The size of the text is expressed in 200 mm.

⑤ Move to the layout space. 
　 Check that the layout size is A3 paper size. If it is a different size, change it.

⑥ To check the size of the layout paper, right-click on the [Sheet1] tab (left image) 
　 and select [Page Setup Manager]. 
　 Change the paper size in the [Page Setup Manager] dialog (right image).

⑦ In particular, check the [Paper size] and [Plot scale]. Set the [Plot scale] to <1:1>.
　 Also check [Plot area] and [Plot offset].

Section 2 Non-Annotative Object
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Insert a drawing frame2

Place a drawing frame of size A31
① Insert a drawing frame for A3 paper size. 
　 Use the [Insert] in the [Block] panel to select the <Frame> from the Ribbon Gallery.
　 Alternatively, select <Frame> from the [Blocks] of the [Palettes] panel.

② Arrange the items so that they fit well within the layout. 
　 After arranging them, edit the text and content of the title.

The drawing frames that are inserted as blocks are created according to the size 

of the paper (A2, A3, A4) and the content of the title.

Layout Placement3

Place one layout1
① Open the [Layer] panel and change the current layer to <layout>. 
　 The layout frame will be displayed as shown in the image below,  
　 but it will be hidden when printing.

② Select [Rectanglar] from the [Layout Viewports] panel. 
　 Use the mouse to draw a rectangle from P1 to P2 as shown in the image below. 

P1

P2

Layout frame

③ The drawing of the model space will be displayed to fill the layout frame. 
　 At this point, the scale for printing has not been decided.

Layout PlacementInsert a drawing frame

[Block Palette][Ribbon Gallery]
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4

Scale of the drawing set to 1/1001
① When you create the layout, it is displayed in the entire layout frame, so specify the correct scale. 
　 Select [Properties] in the [Properties] panel and select the layout frame. 
　 When selected, a blue box will appear in each of the four corners of the frame.

Specify print scale

② There are two ways to determine a scale. 
　 One way is to select <1:100> from the [Standard scale] in the [Properties].（Fig.1）
　 The other option is to select <1:100> from the [Annotation Scale] in the [Status Bar].（Fig.2）

③ To prevent the layout frame from being printed, change the current layer to another layer  
　 and turn off the display of the <layout> layer. 
　 Open [Layer Properties Manager] and change to another layer (e.g. <0>),  
　 then switch the <layout> layer to <Off> (or turn off [Plot]).

④ As shown in the figure below, use the PAN command to move the drawing to adjust the balance.

⑤ Select [Plot] from the [Plot] panel to plot.（[Plot area] is layout）

If you move the screen after setting the scale, the scale will change if you use the ZOOM 

command.  In this case, use the PAN command.

（Fig.1）

（Fig.2）
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Multiple layoutsMultiple layouts

5

Place layouts for 1/100 and 1/50 on one sheet of paper1
① The layout of two different scales is placed on one sheet of paper. 

② Select [Rectanglur] from the [Layout Viewports] panel. 
　 Use the mouse to surround P1 to P2 with a rectangle in the left half of the screen  
　 as shown in the image below. 
　 Then, continue to surround P3 to P4 with a rectangle in the right half of the screen.

Multiple layouts

P1

P2

P3

P4

③ Select the layout frame on the left, and then select <1:100> from [Status Bar] > [Scale of viewport ]. 
　 The drawing on the left is displayed at a scale of 1/100. 
　 The text is also displayed at 1/100, with 2mm.

④ Then, select the layout frame on the right, and then select <1:50>  
　 from [Status Bar] > [Scale of viewport ]. 
　 The layout drawing on the right is displayed at a scale of 1/50.

⑤ The drawing on the left is 1/100 scale, and the drawing on the right is 1/50 scale, but the left-hand text is 
　 displayed in 2mm, and the right-hand text is displayed in 4mm, so the balance is not right.

The reason why the size of the text differs between the left and right dimensions is 

because when creating the dimensions in the model space the dimensions style is 

set to display at 1/100 in the layout space.  

Therefore, it is necessary to create a separate dimensions style and text style to 

display at 1/50.
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Dimension style and layer settingMultiple dimension styles and layers

6

Create two dimension styles1
① Create dimension styles for 1/100 and 1/50. 
　 Select [Dimension Style Manager].

Multiple dimension styles and layers

② Press the [New] button and give the new style names <S100> and <S50>. 
　 Open the [Fit] tab and enter <100> for S100 and <50> for S50 in the [Use overall scale] box.

<1:100> Dimensions Style

Create two layers2
① Create two layers, one for 1/100 and one for 1/50. 
　 Select [Layer Properties] in the [Layers] panel and create two new layers.

The reason for creating a layer for 1/100 and a layer for 1/50 is that the dimensions 

for 1/100 are created in the S100 layer, and the dimensions for 1/50 are created in 

the S50 layer.

7

Assigning dimension style and layer style to 1/100 drawings1
① If you select the dimensions and check the [Properties], you will see that the [Layer] is <dim>  
　 and the [Dimension Style] is <Archi>. 
　 This layout is for when there is only one <1:100> scale for printing.

Dimension style and layer setting

② Select all the dimensions and change the [Dimension Style] to <S100> and the [Layer] to <S100>.

To select dimensions all at once, use the [Quick Select] in 

the upper right of the [Properties] panel. 

Select “Rotated Dimension” as the [Object type] and 

“Select All” as the [Operator], then press the OK button.

<1:50> Dimensions Style
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8

Turn off the layer for 1/100 in the drawing for 1/501
① Click inside the layout on the right to enter the model space.

Dimensions input

③ The dimension of <1/100> is displayed in the layout on the right, so in [Layer Properties Manager] 
　 set the current layer to <S50> and turn off the <S100> layer.

Select [VP Freeze] of the <S100> layer. Select [Freeze] of the <S100> layer.

Add dimensions to the layout drawing for 1/50 scale2
① Add dimensions to the drawing in the layout on the right. 
　 Make sure that the [dimension style] is <S50> and the [layer] is <S50>.

② The point to note here is that if you zoom in or out,  
　 the scale of the layout will change.
　 It is safer to use PAN rather than ZOOM. 
　 If the scale changes, select <1:50> again in the [Scale of the viewport]  
　 in the [Status bar].

② You can see that the size of the dimension text on the left and right is the same.

DimensionsDimensions
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Turn off the layer for 1/50 in the drawing for 1/100 on the left3
① In the layout on the left, you can also see the 1/50 scale (green).

② Freeze the <S50> layer.

③ In the layout on the left, only the <1/100> dimensions were displayed,  
　 and in the layout on the right, only the <1/50> dimensions were displayed.

Print scale: 1/100

9 Key Points for Drawing a Non-Annotative Scale

If there is only one layout1
① If the layout is only 1/100 or 1/50, you only need one [Dimension style], [Text style], and [Layer].

If there are two or more layouts2
① When there are two or more layouts, the number of [Dimension style], [Text style] and [Layer] is 　　
　  necessary. 
 
② When creating a layout with scales of <1/100> and <1/50>, as shown in the diagram below,  
　  you will need to prepare [Dimension style], [Text style] and [Layer] individually.

[Dimension Style] for 1/100 
[Text Style] for 1/100 
[Layer] for 1/100

Layer/text and dimension styles for 1/100

（  mark is not available.）　 （  mark is not available.）　

Print scale: 1/50

[Dimension Style] for 1/50 
[Text Style] for 1/50 
[Layer] for 1/50

Layer/text and dimension styles for 1/50
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Annotative Object1

［Annotative Object]1
① When placing drawings of different scales in a layout space, dimensions, text, leader, etc.  
　 that automatically change size according to the scale are called [Annotative Objects].
　 Annotative Objects are annotations that are automatically adjusted to the size of the scale. 
 
② The following six annotation objects are automatically adjusted.

Setting the [Annotative Object] style2

Annotative [Dimension style]

When creating a new dimension style in the [Dimension 
Style Manager] dialog, check [Annotative]. 
 
Dimension style that support annotative scales are 
indicated by a triangular mark like   
at the beginning of the style name.

The <Scale of dimension 
features> item on the [Fit] tab of 
the [Dimension Style Manager] 
dialog is dimmed and cannot be 
selected. 
 
This is because it is not necessary 
for the dimensions to which the 
annotative scale is applied.

① Dimension style ([Annotate] tab -> [Dimensions] panel -> [Dimension Style Manager])

② Text style ([Annotate] tab -> [Text] panel -> [Text Style])

When creating a new text style in the [Text Style ] dialog, check [Annotative]. 
Even if you have already created a text style, checking [Annotative] will change it  
to an [Annotative] text style. 
 
Text style that support annotative scales are indicated by a triangular mark like    
at the beginning of the style name.

Annotative [Text style]

③ Leader style ([Annotation] tab -> [Leaders] panel -> [Multileader style manager])

Annotative [Multileader style]

When creating a new leader style in the [Multileader 
Style Manager] dialog, check [Annotative]. 
 
Multileader style that support annotative scales are 
indicated by a triangular mark like    
at the beginning of the style name.

The [Scale] item on the [Leader 
Structure] tab of the [Multileader 
Style Manager] dialog is 
automatically checked.

 Dimension  Set in [Dimension Style Manager].
 Text  Set in [Text Style].
 Leader  Set in [Multileader Style Manager].
 Hatching  Set in [Hatch and Gradient].
 Block  Set in [Block Definition].
 Bock Attribute  Set in [Attribute Definition].

Section 3 Annotative Object
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④ Hatch ([Hatch Creation] tab -> [Options] panel -> [Hatch and Gradient])

Annotative [Hatch]

Check the <Annotative> in the [Options] section of the [Hatch and Gradient] dialog box.

⑤ Block ([Insert] tab -> [Block Definition] panel -> [Create Block])

Annotative [Block]

Check the <Annotative> in the [Behavior] section of the [Block Definition] dialog box.

Annotative [Attribute Definition]

Check the <Annotative> in the [Text style] section of the [Attribute Definition] dialog box.

⑥ Block attributes ([Insert] tab -> [Block Definition] panel -> [Define Attributes])

[Use Anotative objects in the Model Space]3
① When using Annotative objects (text and dimensions), check that the current style in the [Text] panel, 
　 [Dimensions] panel, and [Leaders] panel is set to [Annotative].　

Icon ON / OFF Status Indicator

1
ON  The annotation objects for all scales is displayed.

OFF  Only scale that match the current annotation scale are displayed.

2
ON  When the annotation scale is changed, a new scale is automatically created.

OFF  Even if the annotation scale is changed, a new scale will not be created.

② After creating the drawing as shown in the image below, check the [Annotation scale]  
　 in the Status bar when adding dimensions.
　 In this drawing, we have selected <1:100>,  
　 so it will be displayed on the screen at a size of <2 x 100 = 200 mm>.

③ The other thing to check is the two icons to the left of [Annotation scale] on the status bar.
　 1  is an icon that indicates whether or not to display all of the annotation objects. 
　 2 is an icon that indicates whether or not to automatically create the scale when the Annotation    
　　 scale is changed.

Annotative ObjectAnnotative Object

(Current Annotation scale)1 2

[Annotation scale]List[Status Indicator]
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Dimensions for Annotative Object2

Fill in the Annotative dimension in the [Model space]1
① Confirm that the current dimension style of the [Dimensions] panel is Annotative<Archi> and  
　 the Annotative scale is<1:100>.

Layout multiple scales in [Layout Space]2
① The diagram below shows two layouts placed in the layout space. 
　 Both are displayed to the full extent of the layout frame, so we will set the scale individually.

② Choose <1:100> for the [Viewport scale] on the left, and <1:50> for the [Viewport scale] on the right.

② Use the [Dim] command to add dimensions.

③ I added the dimensions as shown below.

③ At this point, the dimensions and text for the <1:100> viewport on the left are displayed,  
　 but the dimensions and text for the <1:50> viewport on the right are not displayed.

Dimensions for Annotative Object
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Changed to Annotative Objects3

Converting [non-Annotative Dimension] to [Annotative Dimension]2
① The following figure shows an attempt to change the dimensions created using the [non-Annotative 
　 Dimension style] to the [Annotative Dimension style]. 
 
② Check that the Annotation Scale in the Status bar is set to <1:100>.
　　　　　 

 
③ Use [Properties] to select all the dimensions. 
　 From the [Dim style] section, select the Annotative Dimension <Archi>.

To select dimensions at once, use [Quick Selection] in the upper right corner of the [Properties] panel.

Select [Rotated Dimension] as the [Object Type] and [Equals] as the [Operator].

④ When you return to the layout space, you will see the dimensions of the <1:100> scale on the left side, 
　 as shown in the image below. 

　 When you move your mouse over the dimensions, a mark will appear to indicate  

　 that they are [Annotative].

⑤ The reason you can’ t see the dimensions in the layout diagram on the right is  
　 because the scale specified in the model space is <1:100>. 
　 In the model space, dimension objects created at <1:100> will only be displayed in the layout space 
　 within the <1:100> viewport scale.

⑥ Double-click inside the layout on the right to enter the viewport and enter the dimensions. 
　 In the figure below, the dimensions are shown in purple for easy distinction.

⑦ The dimensions in the layout diagram on the right are drawn at a scale of <1:50>,  
　 so the dimensions are not visible in the layout diagram on the left.  
　 In other words, there is no need to switch between layers or switch the display on and off.

Convert existing drawings to [Annotative Object]1

Existing object Conversion Method

 Dimension
 ① Make the properties of the dimension object Annotative.
 ② Change the dimension style to Annotative.

 Text
 ① Make the properties of the text object Annotative. 
 ② Change the text style to Annotative.

 Leader  The text and the leader are a single object, so we will recreate them.

 Hatch  Turn on [Annotative] for the Hatch pattern.

 Block
 ① Update the Block Definition to [Annotative].
 ② Turn on [Annotative] on the Properties.

 Block attribute
 ① Update the Attribute Definition to [Annotative]. 
 ② Edit [Attribute Definition] in the Block Editor.

Changed to Annotative ObjectsChanged to Annotative Objects
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Point!

Adding multiple Annotative Dimensions to a single dimension1
① It is possible to add multiple Annotative scales to a dimension object. 
　 If there is currently a dimension with an Annotative scale of <1:100>,  
　 it is possible to add a scale of <1:50> in addition to <1:100>. 
 
② All of the dimensions in the diagram are drawn to a scale of 1:100,  
　 but a scale of 1:50 is added to the dimensions on the right-hand side. 
 
③ Select the dimension on the right side and display the [Properties]. 
　 You can see that the [Annotative scale] in the Properties is set to <1:100>.

Multiple different scale added4

To add multiple scales to a single dimension object, simply add a [Scale list]. 

A dimension object with scales of <1:100> and <1:50> will display 

only the <1:100> dimensions in a <1:100> viewport,  

and only the <1:50> dimensions in a <1:50> viewport.

④ Select   to the right of [Annotative scale] in [Properties]. 

　 The [Annotative Object Scale] panel will appear. 
　 Since it is currently only <1:100>, press the [Add] button.

⑤ In the [Add Scales to Object] panel that appears, select <1:50> and click the [OK] button.

⑥ If you return to the layout space and look at the layout diagram on the right,  
　 you will see that the dimensions of the right side, where you added <1:50>, are displayed. 
　 In addition, the size of the dimension text on the left and right layouts is the same.

One different scale added

In addition to dimension styles, you will also need to prepare text styles, 

leader styles, blocks, attributes, hatch, etc. using [Annotative Scale].

One different scale added
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Add multiple different scales to all dimension objects1
① All of the dimensions in the diagram below are <1:100> Annotative Dimensions.  
　 Add a scale of <1:50> to all of these dimensions.

Multiple different scales added5

③ Select <1:50> from the [Annotation scale] in the [Status bar].　 
　 This alone adds a <1:50> scale. 
　 The dimension text is displayed at half size.

② In the Model Space, turn on [Add scales to annotative objects].

④ In the [Status bar], select [Annotation scale] as <1:100>. 
　 The text will be displayed at a size of <2mm x 100 = 200mm>.

⑤ In the [Status bar], select [Annotation scale]<1:50>. 
　 The text will be displayed at a size of<2mm x 50 = 100mm>.

⑥ Switch to the Layout Space to check the two layouts. 
　 The text in the left and right layouts is the same size.

Multiple different scales added Multiple different scales added

Current Annotation Scale

Current Annotation Scale
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Add and Delete Scale List6

① Select [Custom] from the [Annotation scale] to display the [Edit Drawing Scales] panel. 
 
② Select the scale (200:1) you want to delete from the [Scale List] and click the [Delete] button.（Fig.5） 
 
③ The (200:1) scale has been removed from [Edit Drawing Scales].（Fig.6）

You can also add and delete from  

the [Annotation Scaling] panel.

Add a scale to the [Scale List]1
① Choose Custom from the [Annotation scale].（Fig.1） 
 
② Add a scale to the [Edit Drawing Scales] that is displayed.（Fig.2） 
 
③ Enter (200:1) in the [Scale name] box and click the [OK] button.（Fig.3） 
 
④ A scale of (200:1) has been added to the[Edit Drawing Scales].（Fig.4）

Delete a scale from the [Scale List]2

（Fig.1）

（Fig.2） （Fig.3） （Fig.4）

（Fig.5） （Fig.6）

Add and Delete Scale List

①
 The dimension, text, leader, hatch, block, and attribute created in the [Model space] 
 are created with the size of the printout in the [Layout space] in mind. 

（Specify using the [Annotation scale].） 

②
 If the [Plot scale] in the [Layout space] is <1:100>,  
 then the [Annotation scale] in the Model space  should also be <1:100>.

③
 If there is only one layout, this is the end, but if there are two or more,  
 add [Annotation scale] for the number of different scales in the [Model space].

④
 In the model space, turn on [Add scales to annotative objects]  
 and specify the dimension scale to add.

⑤
 When you add a[Annotative scale] in the [Model space],  
 it will be created automatically at that size. 
 Then, only the dimension that match the scale will be displayed in each viewport in the [Layout].

Key Points for Drawing a Annotative Scale7

Key Points for Drawing a Annotative Scale
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